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Functions Newly Supported in Version 2.00

The functions newly supported in the MVS-8000/8000SF system version 2.00 
are as follows.

Functions relating to switcher processor
Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

DME wipe Additional patterns:
• Frame in-out (No. 1201 to 1204)
• Picture-in-picture (No. 1251, 2651, 2652)

1161/1162 62 304
306

Size and crop adjustment 1165 286 –

Individual modifier adjustment for two-channel 
mode patterns

1164, 1165 283 –

User programmable DME transition mode 
setting

6114 290 124

Frame memory Frame memory feed using key processed keyer 
signals

1115 240
255

–

Changes in Frame Memory menu 2111 to 2144 296 –

Copy and swap Color data copy and swap relating to DME 3116 73 –

Misc menu Enabling/disabling control from external devices 3211 326 –

Setup User region setting 7331.4 141 221

Logical assignment of PGM/PST to M/E 7331.5 141 221

Through mode for program output/clean output 7333.3 141 225

Preset color mix operation mode 7334.1 34, 
142

229

Selection of mask and border process priority 7335 142 232

9-pin port device interface setting 7337.1 143 237

KF Reverse Run (GPI input operation) 7337.2 – 239

Enabling/disabling AUX bus control 7337.5 143 242
3
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Functions relating to DME

Functions relating to external devices

Functions relating to keyframe effects

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Three-dimensional 
transform

Three-dimensional parameter display 4100 and 
each DME 
menu

88 15

Special effects Beveled edge 4112 90 27

Defocusing of video signal only 4121 89 30

Stardust trails 4152 101 72

Motion decay 4153 101 73

Keyframe strobe 4154 101 74

Key density 4162 103 78

Key source selection 4162 103 79

Setup KF Reverse Run (GPI input operation) 7344.1/4 – 245

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

External device 
control

GPI device control 5311 111 97

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Keyframe creation 
and execution

Keyframe loop – 117 120

Attributes (effect dissolve) 6221 116 142

Master timeline Master timeline creation and saving 6211 to 6217 127 137

Menu operations Simultaneous operations in multiple regions 6221 to 6227 – 155



Functions relating to snapshots

Functions relating to utility/shotbox

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Master snapshot Master snapshot creation and saving 6311 to 6317 128 159

Menu operations Simultaneous operations in multiple regions 6321 to 6357 – 155

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Utility Utility function execution – 131 162

Shotbox Shotbox register creation from the numeric 
keypad control block

– – 165

Menu operations Simultaneous shotbox register creation in 
multiple regions

6411.1 – 167
5
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Functions relating to setup

a) FM1/2 Frame Freeze, FM1/2 Field Freeze, FM1/2 Freeze Off

Functions relating to files

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

System Master panel for tally control 7312.1 – 179

Control panels
Config

Link settings relating internal switcher buses to 
routing switcher destinations

7321.3 138 190

Reference module selection for the device 
control block

7321 138 193

Region selection button assignment for the 
numeric keypad control block

7321.7 138 193

Xpt Assign Source name and destination name export 7322.5 139 199

Prefs/Utility Button assignment setting 7324 139 201

Device Interface Additional actions for GPI input a) 7325.1 – 207

Operation Setup relating to effects
• Automatic turning off of [EDIT ENBL] 
• Automatic insertion of the first keyframe
• Keyframe duration default value
• Setting whether to replay the first keyframe 

after rewinding (GPI/P-BUS/DDR/VTR)

7326.2/5/6 139 212

Button operation mode setting
• for during auto transition
• for during keyframe execution

7326.4 140 214

Trackball, joystick and double-click sensitivity 
adjustment

7326.5 140 215

Maintenance Touch panel calibration 7327 140 217

DCU Additional actions for GPI input a) 7352 – 249

Serial port setting 7355 144 255

Router interface and 
tally

Serial tally setting 7367 145 270

Classification Functions supported Menu No. See page

Vol. 1 Vol. 2

Menu operations Changes in File menu operations
• operations between files
• Individual frame memory file operations

7111 to 7171 146 276

File import and 
export

Image data import and export for frame memory 7161 146 286

Directories Directory operations 7171 – 288
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Introduction

This manual is the User’s Guide for the MVS-8000/8000SF Multi Format 
Switcher system. The MVS-8000 and MVS-8000SF have different numbers of 
M/E banks and input/output signals, but are otherwise functionally identical.
This manual refers to these generically as the “MVS-8000 system,” and 
describes principally the operation of the system using the CCP-9000 series of 
center control panels.

The User’s Guide for the MVS-8000 system comprises two volumes.

Contents of Volume 1
Overview of functions of the MVS-8000 system, and basic switcher operations 
including transitions, keys, and wipes.

Contents of Volume 2
DME effects, snapshots, keyframes, and various operations such as setup 
which affect the overall system.

Devices and system nomenclature
In this manual, when discussing the principal components of the MVS-8000 
system, in place of the formal product names, abbreviated names 
characterizing the functions and features are sometimes used. When 
distinctions between system configurations must be drawn, the terms in the 
second table on this page are used.

Principal components and naming
The formal product names of the principal components of the MVS-8000 
system, and the terms used in this manual are as follows.

System nomenclature
The following terms are used for systems, depending on the combination of 
installed options, and the signal format.

Formal product name Term used in this manual

MVS-8400/8300/8200/8000SF Multi Format 
Switcher Processor

Switcher or switcher processor

MVE-8000 Multi Format DME Processor DME or DME processor

CCP-9000-series Center Control Panel Control panel or center control panel

DCU-8000 Device Control Unit DCU
Introduction
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Related manuals
The following manuals are supplied with the individual products of the MVS-
8000 Multi Format Switcher system.

MVS-8400/8300/8200 Switcher Processor Pack
• MVS-8400/8300/8200 Operation Manual
• MVS-8400/8300/8200 Installation Manual

MVS-8200SF-C Switcher Processor Pack
• MVS-8200SF-C Operation Manual
• MVS-8200SF-C Installation Manual

MVE-8000 DME Processor Pack
• MVE-8000 Operation Manual
• MVE-8000 Installation Manual

CCP-9000 Center Control Panel Pack
• CCP-9000-C Operation Manual
• CCP-9000-C Installation Manual

DCU-8000 Device Control Unit Pack
• DCU-8000 Operation Manual
• DCU-8000 Installation Manual

System configuration and features Term for system

System with installed option boards and 
settings to support HDTV format

HD system

System with installed option boards and 
settings to support SDTV format

SD system

A system in which the center control panel has 
two M/E banks

2M/E system

A system in which the center control panel has 
one M/E bank

1M/E system
17Introduction
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Features of the MVS-8000 Multi Format 
Switcher System

The MVS-8000 Multi Format Switcher system boasts extensible high 
performance and multifunctionality. The following are some of the principal 
features of this system.

System configuration flexibility

Multiformat support
This system supports both HDTV and SDTV signal formats. The format 
selection can be switched by a simple control panel operation. The switcher 
supports either HDTV or SDTV signal format depending on the installed 
option boards.

Extensible system configuration
By suitable combination of options, the switcher can be configured with 
various inputs and outputs, and different numbers of M/E banks. The system 
offers the flexibility to change and expand as required.
The DME system provides one DME channel per DME processor, and these 
can be added up to a maximum of four channels.

Powerful external device interfaces
By connecting to a Sony routing switcher or similar, a large system can be 
built.

Powerful tally system
The complete system including routing switcher provides an all-inclusive tally 
system. The system can be adapted to different applications and settings, using 
multiple tally outputs, including both on-air and recording tallies.

Comprehensive video manipulation

M/E banks
Each mix/effects bank (M/E bank) is equipped with four keyers, and each 
keyer is capable not only of chroma keying, but also independent key 
transitions separate from the background transitions. The four keys can be 
freely combined, to carry out four different program outputs.
Features of the MVS-8000 Multi Format Switcher System
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Powerful frame memory functions
The frame memory can store 58 frames in an HDTV system, or 222 frames in 
an SDTV system, and up to eight of these can be recalled simultaneously.

Link operation with DME
By means of the dedicated DME interface, a range of DME functions including 
DME wipes and processed keys can be handled as switcher functions.
The system can interface with up to four DME units.

Designed for use in a live broadcasting environment

High-performance user interface
The menu control block provides a large color LCD panel, with rapid touch-
panel menu selection.
The source name displays have color backlit LCD displays. The signal names, 
and graphical representations of the patterns associated with buttons provide 
intuitive feedback, and allow the immediate decisions that are required in a live 
operating environment.
19Features of the MVS-8000 Multi Format Switcher System
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Video Processing Flow

The following illustration shows the flow of operations for carrying out a 
transition on an M/E bank or the PGM/PST bank.
]

Select next transition (page 26)

Make key settings (page 39)

Keys 1 to 4

Select new background video (page 21)

Select transition type (page 33)

Select current background video 
(page 21)

Background

Cut Mix Super 
mix

Preset color 
mix

Wipe DME wipe

Make wipe 
settings (page 49)

Make DME wipe settings
(page 61)

Preview the effect of transition (page 37)

Execute the transition (page 36)

NAM
Video Processing Flow
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Signal Selection

You carry out signal selection with the cross-point buttons in the cross-point 
control block of the M/E bank or PGM/PST bank, and the buttons in the 
auxiliary bus control block.

Cross-point control block

Basics of Signal Selection

Each of the M/E bank and auxiliary bus control block has cross-point buttons 
which are identified by numbers common to the bank and block, and a signal 
is assigned to each number.
The basis of signal selection is to select, in a cross-point button row, the cross-
point button to which is assigned the desired signal.

SHIFTUTIL2UTIL1DME4DME3DME2DME1DSK4DSK3DSK2DSK1
XPT

HOLD

Source name displays

Key row

XPT HOLD button

Key delegation buttons

Background A row

Background B row

SHIFT button

Cross-point buttons
21Signal Selection
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Bus Selection

The key row is shared by multiple buses.
To assign a bus to the cross-point buttons in the auxiliary bus control block, 
press one of the AUX delegation buttons to select the bus. 

The following table illustrates the correspondence between buses and cross-
point button rows, and the delegation operations.

Bank Bus name Cross-point 
button row

Delegation operation

M/E-1 Background A bus Background A 
row

−

Background B bus Background B 
row

−

Key 1 bus Key row Turn on the [KEY1] button

Key 2 bus Key row Turn on the [KEY2] button

Key 3 bus Key row Turn on the [KEY3] button

Key 4 bus Key row Turn on the [KEY4] button

PGM/PST Program bus Program row −

Preset bus Preset row −

DSK 1 bus DSK row Turn on the [DSK1] button

DSK 2 bus DSK row Turn on the [DSK2] button

DSK 3 bus DSK row Turn on the [DSK3] button

DSK 4 bus DSK row Turn on the [DSK4] button

M/E-1 PGM/
PST

Utility 1 bus Key row Turn on the [UTIL1] button

Utility 2 bus Turn on the [UTIL2] button

DME 1 video bus Turn on the [DME1] button a)

DME 2 video bus Turn on the [DME2] button a)

DME 3 video bus Turn on the [DME3] button a)

DME 4 video bus Turn on the [DME4] button a)
Signal Selection
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a) To turn on the [DME1] to [DME4] butons requires one of the [KEY1] to [KEY4] and [DSK1] 
to [DKS4] buttons to be on.

Signal Assignment and Selection

Assigning signals to buttons
Each cross-point button has a button number, to which you assign a signal.
In addition to the signals input to the PRIMARY INPUTS 1 to 80 connectors 
on the rear panel of the switcher, you can also select signals generated within 
the switcher.
Each button has assigned to it a video signal and a key signal, forming a pair. 
You can set these video and key combinations in a Setup menu. 

For details of Setup menu operations, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 16 (Volume 2).

Auxiliary 
bus control 
block

AUX1 to AUX48 buses The key row of 
the bank selected 
with the bank 
selection buttons 
in the auxiliary 
bus control block

Turn on the appropriate 
buttons in accordance with 
the signal assignment made 
in the Setup menu.

MONITOR 1 to 
MONITOR 8 buses

Frame memory source 
1 and frame memory 
source 2 buses

DME 1 to DME 4 
video buses

DME 1 to DME 4 key 
buses

Edit preview bus

M/E-1 UTILITY 1 and 
M/E-1 UTILITY 2 
buses

P/P UTILITY 1 and P/
P UTILITY 2 buses

DSK 1 fill to DSK 4 fill 
buses

DSK 1 source to DSK 
4 source buses

M/E-1 external DME 
bus

P/P external DME bus

DME UTILITY 1 and 
DME UTILITY 2 buses

Bank Bus name Cross-point 
button row

Delegation operation
23Signal Selection
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Cross-point button control block button numbers
On the M/E and PGM/PST banks, each cross-point button has two button 
numbers, and you use the shift button to switch between these numbers.
The button numbers are as follows.

SHIFTUTIL2UTIL1DME4DME3DME2DME1KEY4KEY3KEY2KEY1
XPT

HOLD

1 2 3 4 5 6 7 8 9 10 11 12

13 14 15 16 17 18 19 20 21 22 23 24

SHIFTUTIL2UTIL1DME4DME3DME2DME1KEY4KEY3KEY2KEY1
XPT

HOLD

1 2 3 4 5 6 7 8 9 10 11

12 13 14 15 16 17 18 19 20 21 22

Button numbers when all 12 buttons are used as cross-point buttons.

When the SHIFT button is off:
When the SHIFT button is on:

SHIFT button

When the SHIFT button is off:
When the SHIFT button is on:

Button numbers when the rightmost buttons (12th buttons) are used as SHIFT buttons.

SHIFT button

SHIFT button
Signal Selection
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Signal Name Display

You can attach a name (source name) to each signal assigned to a cross-point 
button, with a maximum of 16 characters.
• The source name displays in the cross-point control block and auxiliary bus 

control block show the source names of the video signals assigned to 
numbers 1 to 12 (or 11).

• To display the source names for shifted numbers (13 to 24 or 12 to 22), press 
the [SHIFT] button to the right of the key row delegation buttons.

• To display the source names of the key signals assigned to button numbers, 
hold down one of the key delegation buttons [KEY1] to [KEY4] and [DSK1] 
to [DSK4] buttons or, for the auxiliary bus control block, hold down the 
[KEY] button.

Colors of lit cross-point buttons
In a particular row of cross-point buttons, only the last pressed button is 
effective, and lights amber or red. The amber indicates the “low tally” state, 
and the red indicates the “high tally” state, to indicate whether or not the 
selected signal appears in the final output video.

Significance of colors of lit cross-point buttons

Color State Significance

Amber Low tally Does not appear in final output video

Red High tally Appears in final output video
25Signal Selection
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Transitions

In the M/E banks and PGM/PST bank, the switch from the current video stream 
(appearing on the corresponding program monitor) to a new video stream is 
referred to as a transition.

Selecting the Next Transition

To execute a transition, it is first necessary to decide how the image will be 
changed as a result of the transition. This selection is carried out using the next 
transition selection buttons (see page 151) in the transition control block of the 
M/E or PGM/PST bank.

For details of operations, “Basic Operating Procedure” (page 190).

In the M/E banks and PGM/PST bank, you can change one of the images, the 
background, and keys 1 to 4 (downstream keys 1 to 4 in the PGM/PST bank), 
and also vary combinations of these simultaneously.
The following are examples of transition.

Changing the background
A background transition switches from the video currently selected on the 
background A bus (the current video) to the video selected on the background 
B bus (the new video).

In the default selection of flip-flop mode (see page 37), the background always 
switches in the direction from the A bus to the B bus. When the transition 
completes, the cross-point selections on the A and B buses are interchanged.

Background BBackground A

Transition
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Inserting and deleting a key

You can insert one or more of the four keys (downstream keys on the PGM/
PST bank).
If you select a key which is already inserted, the transition will delete the key.
A simultaneous combination of deleting and inserting keys is also possible.

Inserting or deleting key 1 and key 2

Deleting key 1 and inserting key 2

Delete

Insert

Key 1

Key 2

Key 1

Key 2

Transition
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Simultaneously changing the background and keys
You can change any of the four keys (downstream keys on the PGM/PST bank) 
and the background at the same time.

Changing the background and key 2 simultaneously

Changing the background and keys 1 to 4 simultaneously

Selecting the key priority
If a number of keys are already inserted in the current video, you can check or 
change the key priority, that is to say, the order in which the keys are overlaid.
When a key priority ([KEY PRIOR]) is selected as the next transition, you can 
also change the key priority in the new video.

For details of this operation, see “Key Priority Setting” (page 193).

Key 1

Key 2

Transition

Key 1

Key 2 Key 3 Key 4

Transition
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The key priority values go from 1 to 4, with a higher priority key being “in 
front” as seen on the screen.

Priority sequence on the screen

Independent Key Transitions

What is an independent key transition?
In addition to common transitions, it is possible to carry out independent 
transitions on the keyers of the M/E banks and PGM/PST bank. These are 
called “independent key transitions.”
By carrying out an independent key transition in combination with a common 
transition, different transition types can be used for the background and keys. 
It is also possible to use different transition types for key insertion and key 
deletion by means of a Setup menu setting.

For details of this operation, see “Basic Independent Key Transition 
Operations” (page 213).

The following description compares the independent key transition with a 
common transition, taking a simultaneous change of the background and key 
as an example.

Video used in the transition

4
3

2
1

Background A Background B Key to insert
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Effect of a common transition
In the case shown in the above illustration, carrying out a common transition 
produces the following change in the image.

Effect of a common transition

Effect of use with an independent key transition
The key is inserted with an independent key transition as the background 
changes with a common transition, providing the following result.

Effect of a background transition and independent key transition

Combining other transitions with independent key transitions
When you set a common transition and a key independent transition for the 
same key, you can apply two different effects such as a wipe and mix (dissolve) 
(see page 33) to the key simultaneously.
When carrying out such a combination of transitions simultaneously on a key 
as auto transitions (see page 36), the result depends on the timing of pressing 
the respective [AUTO TRANS] buttons.

Same wipe is applied to 
background and key.

Transition type: wipe

Different wipe patterns are applied to 
the background and key transitions.

Transition type: 
wipe

Independent key 
transition type: 
wipe
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Simultaneous execution
If the [AUTO TRANS] buttons for the two transitions are pressed 
simultaneously, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).
Deleting a key with simultaneous transitions: With the key inserted, it is 

deleted simultaneously with the two transitions.
When the common transition completes, even if the independent key 
transition is still not completed, the two end simultaneously.

Deleting a key with simultaneous transitions

Inserting a key with simultaneous transitions: With the key not inserted, it 
is inserted simultaneously with the two transitions. If the common 
transition or independent key transition ends first, the other continues to 
completion.

Inserting a key with simultaneous transitions

Time offset execution
If the [AUTO TRANS] buttons for the two transitions are pressed with a time 
offset, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).

Wipe and mix 
(dissolve) are 
carried out 
simultaneously

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Wipe and mix 
(dissolve) are 
carried out 
simultaneously

The transitions 
continue until both 
are completed.
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Time offset execution with the key inserted: With the key inserted, it is 
deleted with the two transitions acting with a time offset.
Whichever button is pressed first, when the common transition completes, 
even if the independent key transition is still not completed, the two end 
simultaneously.
Example: When the independent key transition [AUTO TRANS] button 
is pressed later

Time offset execution with the key inserted

Time offset execution with the key not inserted: With the key not inserted, 
it is inserted with the transition whose [AUTO TRANS] button is pressed 
first.
Since the key is then in the inserted state, with the transition whose [AUTO 
TRANS] button is pressed later, the key is deleted. When the key is 
completely deleted, both transitions complete.

Common transition 
(wipe) start

Independent key 
transition (mix) start

The key is deleted, 
even if the 
independent key 
transition has not 
completed.
Transitions



  C
hapter 1 

M
V

S
-8000 F

unctions
Time offset execution with the key not inserted

Transition Types

Selecting the transition type determines the way in which the transition occurs.
Carry out the type selection with the transition type selection buttons in the 
transition control block of the M/E or PGM/PST bank.

For details of this operation, see “Basic Operating Procedure” (page 190).

The following are the transition types.

Mix
This is a dissolve, in which the new video progressively fades in over the 
current video, with the sum of the two video outputs maintained constant. At 
the mid-point of the transition (when the fader lever is in the center position), 
the output of each is 50%.
This transition type can also be selected for an independent key transition. In 
this case, the key either dissolves in or dissolves out similarly, with the 
progress of the transition.

Common transition 
(wipe) start

Independent key 
transition (mix) 
start

The transition 
completes with the 
key deleted.

Example 1: When the independent key transition [AUTO TRANS] 
button is pressed later

Common 
transition (wipe) 
start

Independent 
key transition 
(mix) start

The transition 
completes with the 
key deleted.

Example 2: When the common transition [AUTO TRANS] button is 
pressed later
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NAM (non-additive mix)
In this dissolve, the current video and new video signals are compared, and the 
signal with the higher luminance level is given priority in the output. The 
current video is maintained at 100% output for the first half of the transition as 
the new video increases progressively to 100%, then the current video is 
progressively reduced from 100% to zero in the second half with the new video 
maintained at 100% output.

Note 
This transition type is not available for an independent key transition.

Super mix
In this dissolve, the current video is maintained at 100% output for the first half 
of the transition as the new video is mixed while increasing progressively to 
100%, then the current video is progressively reduced from 100% to zero in the 
second half with the new video maintained at 100% output.
Note that you can set the output levels of the current and new video signals at 
the mid-point of the transition, in the range 0 to 100%. (See “Super Mix 
Settings” (page 199).)

Note 
This transition type is not available for an independent key transition.

Preset color mix
This is a two-stage dissolve, comprising two transitions, the first a dissolve to 
a color matte, and the second from the color matte to the new video.
In the first transition, the current video is replaced by the color matte in a mix 
(dissolve), then in the second transition the color matte is replaced by the new 
video also in a mix (dissolve). You can specify the color matte by luminance, 
saturation, and hue values. (See “Color Matte Settings” (page 200).)

Notes
• This transition type is not available for an independent key transition.
• In the bus fixed mode, a preset color mix cannot be used.

One-stroke mode and one-time mode
• You can make a setting such that a preset color mix is carried out in a single 

transition. This is called “one-stroke mode.”
• You can also make a setting such that when a preset color mix is completed, 

the next transition switches to the previous transition type automatically. 
This is called “one-time mode.”
Transitions



  C
hapter 1 

M
V

S
-8000 F

unctions

When only the background is changed

Preset color mix (changing background only)

When a key is inserted

Preset color mix (transition including key)

By means of a Setup menu setting, it is possible to preserve the key state while 
carrying out the color matte mix.

When, with a key inserted, a key is selected in the next transition

Preset color mix (when set to preserve key state)

Wipe
A wipe replaces the current video by the new video according to a 
predetermined pattern. This transition type can also be selected for an 
independent key transition.

For details, see “Wipes” (page 49) and Chapter 5 “Wipes” (page 259).

Current video Color matte New video

Key fades out

Key

When a key is 
selected as the next 
transition

When no key is selected

Key fades in

Key

Key state preserved
Key gradually 
removed
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DME wipe
Using a DME effect, it is possible to obtain a transition to a new image from 
the current image, as in a wipe. You can also use this transition type as an 
independent key transition.

For details, see “DME Wipes” (page 61) and Chapter 6 “DME Wipes” (page 
281).

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.

Executing a Transition

There are two modes of executing a transition: an auto transition by button 
operation or a manual transition using the fader lever.
It is also possible to combine both methods, taking control with the fader lever 
of an auto transition which has partly completed, or complete a transition 
started with the fader lever as an auto transition.
By combining common transitions with independent key transitions, different 
transition types can be applied to the background and keys, for example 
allowing a key wipe combined with a background dissolve. (See “Executing a 
Transition” (page 201).)

Auto transitions

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.

Auto transition
The transition from the current video to the new video is carried out 
automatically at a constant rate, using the transition effect selected as the 
transition type.
You can set the transition rate in advance. (See “Setting the Transition Rate” 
(page 202).)

Manual transitions
Using the fader lever, you can manually control the progress of the transition. 
Moving the fader lever from one end of its travel to the other completes the 
transition.
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Flip-flop mode and bus fixed mode

The following describes the difference between flip-flop mode and bus fixed 
mode, taking an M/E bank as an example; the functionality is the same, 
however, on the PGM/PST bank.
Normally, when a background transition is carried out on an M/E bank, the 
signals selected on the A and B rows of cross-point buttons are interchanged at 
the end of the transition. That is to say, except during a transition, the 
background output is always from the background A bus. This is called “flip-
flop mode.”
The alternative is known as “bus fixed mode,” in which there is no bus 
interchange. In this mode, when the fader lever is at the top of its travel the 
output from the A bus is always 100%, and when the fader lever is at the bottom 
of its travel the output from the B bus is 100%.

Flip-flop mode and bus fixed mode

For details of fader lever operation in bus fixed mode, see page 210.

Transition preview
With the preview output of the M/E banks and PGM/PST bank, you can check 
the effect of a transition in advance. To carry out a transition preview, press the 
[TRANS PVW] button in the transition control block. (See “Transition 
Preview” (page 212).)

A

B

BLACK

BLACK

A

B

BLACK

BLACK

A

B

BLACK

BLACK

Buttons lit

Fader 
lever

Flip-flop mode

Bus fixed mode
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Note 
In multi-program mode, DSK mode (page 141) or bus fixed mode (page 37), 
it is not possible to carry out a transition preview.

Pattern limit
When a wipe or DME wipe pattern is selected for the transition, you can 
specify the range of movement of the wipe pattern through the course of the 
transition, for each bank independently.
When the pattern limit function is enabled, carrying out a transition results in 
the following effect for example settings.
• When the limit value is set to 50%, the effect at the end of the transition is 

the same as when the fader lever is at the center position in the normal case 
(with the pattern limit function disabled); the wipe pattern does not complete.

• When the limit value is set to 0%, the wipe effect is completely disabled, and 
carrying out the transition produces no change in the image.

• When the limit value is set to the maximum 100%, the image changes in 
exactly the same way as when the pattern limit function is off, but when the 
transition is completed, the cross-point selections on the background A and 
B buses do not interchange.

You can specify the limit value either by entering a numeric value in the menu, 
or by operating the fader lever to set the fader lever position. (See “Pattern 
Limit” (page 204).)

Note 
The pattern limit function is not available in an independent key transition.
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A key is an effect in which a part of the background image is replaced by an 
image or superimposed text. The signal determining how the background is cut 
out is termed “key source,” and the signal that replaces the cut-out part is 
termed “key fill.” The system component responsible for processing a key is 
referred to as a keyer.
Each of the M/E and PGM/PST banks has four keyers, and all of these keyers 
provide the same functions.

Key Types

The key type indicates the manner in which the key source signal is used to cut 
out the background. In each bank, you can use the following key types. You 
can select the key type using the key type selection buttons in the key control 
block, or by a setting in the Type menu for the keyer. (See “Key Type Setting” 
(page 219).)
• Luminance key
• Linear key
• Color vector key
• Chroma key
• Wipe pattern key
• Key wipe pattern key

Luminance key
The background is cut out according to the luminance (Y) of the key source 
signal, and at the same time the key fill signal is cut out and then added to the 
background signal.

Linear key
This is a type of luminance key, but there is a reduced variability in gain, 
allowing more precise adjustment.

Color vector key
The key signal is created from a combination of the luminance and 
chrominance components of the key source signal. When perfect keying is not 
possible with a luminance key, this allows a key signal to be created even if the 
luminance level is low, provided that the colors have high saturation.
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Clean mode
In a luminance key, linear key or color vector key, you can enable the clean 
mode. When the clean mode is on, the key source does not affect the key fill, 
which is added unchanged to the background. This improves the keyed image 
quality, but means that the part of the key fill signal which is not to be inserted 
must be completely black, or it will color the background. You set the clean 
mode with the Type menu of the respective keyer. (See “Setting the key type in 
a menu” (page 219).)
Note that in the following situations, the clean mode goes off, and cannot be 
turned on.
• When the key type is a pattern key
• When key inversion is on
• When the key fill is a matte
• When the key edge is an outline
• When the key edge is normal with soft edge being on
• When fine key is on
• When the key positioner is on

Chroma key
A key signal based on a particular color is used to cut out the background, and 
the key fill is then inserted. The inserted signal is also referred to as the 
foreground, and the composite image is called a chroma key image.

Normal mix and additive mix
In creating a chroma key image, either a normal mix or an additive mix can be 
used. To select which, use the Type>Chroma Adjust menu for the keyer. (See 
“Chroma Key Composition” (page 221).)

Foreground Background

Chroma key image
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Normal mix: The foreground is cut out with the key signal, and then combined 

with the background, which has also been cut out with the key signal.
Additive mix: The background, which has been cut out with the key signal, is 

combined with the unshaped foreground. This is effective for a natural-
looking composite when the scene includes glass or other translucent 
objects.

Plane function
In an additive mix, the foreground is not shaped by the key signal, and 
variations in the (blue) background appear in the composite image. To prevent 
this, it is possible to set a particular luminance level for the background, and 
any parts below this level are cut forcibly.

Methods of adjusting the composite obtained from chroma keying include 
automatic adjustment with the auto chroma key function, and manual 
adjustment carrying out the necessary processing separately. The optimum 
results will be obtained by first carrying out adjustments with the auto chroma 
key function, then making any fine adjustments as required.
The following manual adjustments are possible.

Key active
When this function is off, only the foreground is output and you can make 
adjustments of color cancel (see the next paragraph).

Color cancel
If the foreground image includes shades of the background color, set this 
function to ON to remove the color from the foreground image.

Chroma key window
You can adjust the range over which the key signal is determined as matching 
the specified hue. When this adjustment is off the default ranges are used.

Chroma keying generates a key signal based on a particular color (reference 
color) in the foreground (typically a plain blue background), and the “window” 
refers to the range of colors which are regarded as matching this specified 
reference color to create the key signal.
As seen on a vectorscope (that is, in the hue-saturation color space), the range 
for this matching corresponds to a truncated sector. This range is specified by 
two parameters: the “Angle” parameter, which determines the range of the hue 
parameter, and the “Crop” parameter, which determines the degree of 
truncation (see the following figure).
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Window adjustment

Y balance
In normal chroma keying, the key signal is based on the chrominance 
component only, and all elements of the foreground with the same hue are 
replaced by the background. Using the Y balance function, you can specify a 
luminance level range within which the key is active, and replace the specified 
part by the background.
You can use the Y balance function independently on the key signal for the 
composition and the key signal for the color cancel function. When applied to 
the key signal for the composition, this produces the foreground with the color 
cancel effect applied. This can therefore be used to provide an impression of 
smoke, for example.
When the Y balance function is applied to the color cancel key, the relevant 
part is output in its original color without canceling, and therefore it is possible 
to combine colors which are the same color as the background (i.e. typically 
blue) in the foreground.

Chroma key shadow
This function provides a more realistic treatment when the shadow of an object 
in the field of view falls on the blue background. Since parts of the blue 
background darker than a specified intensity are treated as shadows, there is no 
effect on cutting out of the foreground.

Video signal adjustment
You can vary the foreground signal gain, or change the hue. There are separate 
adjustments for the gain of the overall video signal, and Y and C components.

Reference color 
specified by Hue 
setting

Range of colors creating the key signal 
(to be replaced by background signal)

Range of colors remaining 
as foreground

b) The Crop and Angle values do not change even if 
you use the auto chroma key function.

Angle a)

Crop a)
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For details of video adjustment operations and the adjustment items, see 
“Chroma Key Adjustments” (page 222).

Wipe pattern key
This uses the wipe pattern selected for a transition as the key source.

Key wipe pattern key
This uses the wipe pattern selected for an independent key transition as the key 
source.

Note on wipe pattern modifiers
In a wipe pattern key or key wipe pattern key, you can apply various 
modifications, depending on the pattern used, and the modifiers in common 
with a wipe.
However, modifiers which relate to the wipe direction and edge are not 
reflected.

Key Modifiers

Edge modifiers
You can apply borders and other effects to the edge of the key. (See “Key Edge 
Modifications” (pages 229 and 249).)

Normal
This is the state with no key edge modifiers applied.
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Border
This applies a uniform width border to the edge of the key. You can adjust the 
border width and density. You can also enable the separate edge function, and 
adjust the top, bottom, left, and right border widths separately.

Drop border 
This applies a border below and to the right for example, of the key. You can 
adjust the border width, position, and density.

Shadow
This applies a shadow below and to the right for example, of the key. You can 
adjust the shadow width, position, and density.
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Outline
This uses the outline of the original key as the key. You can adjust the width 
and density of the outline. You can also enable the separate edge function, and 
adjust the top, bottom, left, and right outline widths separately.

Emboss
This applies an embossing effect to the outline of the key. You can adjust the 
width and position of the embossing, and the density. You can adjust the 
density separately for key fill and key edge. When embossing is on, the Fine 
Key and zabton functions go off.

Soft edge
This softens the edge of the key.

Zabton
This inserts a translucent pattern behind a key. You can adjust the pattern size, 
softness, density and color.

Edge type and key fill/key source position
The key edge modification function has two modes: a mode (“key drop ON 
mode”) in which the key fill/key source position moves downward, and a mode 
(“key drop OFF mode”) in which it does not move downward.
Key drop ON mode: The key fill/key source position moves downward by 

eight scan lines or four scan lines. When a drop border or shadow is 
selected, it is possible to apply a border to the top edge of the key.

Key drop OFF mode: The key fill/key source position does not move. When 
a drop border or shadow is selected, it is not possible to apply a border to 
the top edge of the key.

In the key drop ON mode, a menu setting selects between the mode (“4H 
mode”) in which the key fill/key source position is lowered by four scan lines, 
and the mode (“8H mode”) in which the key fill/key source position is lowered 
by eight scan lines.
When [Fine Key] is on, the edge width is forced to the range 0.00 to 4.00.

Note that in the following situations, the key drop mode is forcibly set to ON.
• When the edge type is border, outline, or emboss
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• When the edge type is normal with soft edge being on
• When [Fine Key] is on

Edge fill
When a border, drop border, or shadow modifier is selected, you can select a 
signal to fill these edge effects.
The edge fill may be either the signal from the dedicated color matte generator, 
or the signal currently selected on the utility 1 bus.
In the case of an outline, there is no edge fill signal selection, because the key 
fill signal fills the outline, and the rest of the image remains as the background.
For the emboss effect, in place of the edge fill signal, the emboss fill matte 1 
and emboss fill matte 2 signals are used.

Masks
A mask is used to inhibit the effect of a key over a part of the image. This 
allows parts of the background which would otherwise be keyed to be 
protected, or to correct the key if it is not of the desired shape.

For details of masking operations, see “Masks” (pages 235 and 253).

Key mask and background mask
There are two types of mask: a key mask and a background mask.
Key mask: This masks out a part of the key, which will result in the 

background appearing.
Background mask: This masks out a part of the background, which will result 

in the key fill appearing.

Main mask and subsidiary (“sub”) mask
Each keyer allows two masks to be used simultaneously, and these are referred 
to as the main mask and the sub mask. The signal that determines the mask 
shape and size is termed the mask source, and different sources are used for the 
main mask and sub mask.
Main mask: This uses the signal from the dedicated box generator provided 

on each keyer, or the signal from the dedicated pattern generator as the 

Key mask

Masked area (box)

Background mask
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mask source.
When the box generator is selected, a rectangular mask is formed. You can 
adjust the positions of the four sides of the box separately.
When the pattern generator is selected, you can select the pattern and apply 
modifiers.

Sub mask: This uses the wipe generator signal or the signal selected on the 
utility 1 bus on the M/E or PGM/PST bank, as the mask source.
When the wipe generator is selected, the patterns and the pattern modifiers 
are the same as in a wipe transition.

Key Memory

The key memory function allows the keyer settings on each cross-point button 
to be automatically stored, so that the next time the same cross-point button is 
selected these settings are recalled automatically.
There are two modes for key memory: simple mode and full mode. 
The parameters stored in each mode are as follows.
Simple mode: key type, clean mode (including the plane setting for chroma 

keying), key position, key inversion, and adjustment values for the 
particular key type (Clip, Gain, Density, Filter, etc. This includes color 
vector key, wipe pattern key, key wipe pattern key, and chroma key. 
However, in the case of a chroma key, it excludes color cancel, Y balance, 
foreground CCR, window, and shadow.)

Full mode: All settings except transition (the same parameters as simple mode, 
[Fine Key], key modifiers, main and sub mask settings, chroma key 
detailed settings, and so on)

Key Snapshots

Key settings other than the key on/off status and the key priority can all be 
instantaneously saved in a dedicated register, for recall when required. A key 
snapshot comprises three values: a cross-point button number, key memory full 
mode, and independent key transition, and can be called in any combination.
There are four key snapshot registers for each keyer.

For details of key snapshot operations, see “Key Snapshots” (page 257).

Blink

The blink function provides the following effects.
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Key blink: The key is inserted and deleted at the specified frequency.
You can also set the frequency and the proportion of the cycle for which 
the key is inserted.

Edge blink: Key fill and key edge fill are interchanged at the specified 
frequency. You can specify both the frequency and the proportion of the 
cycle for which the interchange occurs.

The blink settings are in the Transition menu for each key. (See “Blink 
Function” (page 240).)

Key Default

With a simple operation you can return the key adjustment values to their 
defaults.
The adjustment values which can be returned to their default values are as 
follows.
• Adjustment values for the particular key type (Clip, Gain, Density, Filter, 

etc.)
In the case of chroma keying, all adjustment values return to their default 
values.

• Key position
• Key inversion
• Clean mode

For details, see “Returning the key adjustment values to their defaults” (page 
256).

Key Modify Clear

A simple button operation returns the key settings to the initial status settings.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 16 (Volume 2).
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Wipes

A wipe is a transition from the current video stream to a new video stream, 
using a wipe pattern.
Changing the background by means of a wipe is referred to as a “background 
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition, 
and those that can be selected in an independent key transition.

For details of independent key transitions, see page 29.

Types of Wipe Pattern

The patterns that can be used for a wipe are divided into a number of groups, 
as follows. Note that only the standard wipe patterns can be used for an 
independent key transition.

For wipe patterns, see the appendix “Wipe Pattern List” (Volume 2).

Standard wipe patterns
Patterns consisting of straight lines vertically, horizontally, or diagonally, and 
circular patterns.

Enhanced wipes
More complex shapes such as hearts, stars, and round corners.

Rotary wipes
These patterns involve rotation of the image about a point.

Mosaic wipe pattern
This divides the image into small tiles.

Random and diamond dust wipe patterns
These patterns consist of small random tiles, or fine particles.
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Pattern Mix

You can create a new pattern by combining two selected patterns (main and 
“sub”).

Note
It is not possible to apply a pattern mix to an independent key transition.

For details, see “Pattern Mix” (page 262).

Types of pattern mix
There are four ways in which patterns can be combined in a pattern mix, as 
follows.
Mix: The effect of the sub pattern is applied to the main pattern, modifying the 

outline or nature of the main pattern.
Positive NAM (+Nam): Creates a pattern with an outline which contains all 

points within the outlines of either of the main pattern and the sub pattern.
Negative NAM (–Nam): Creates a pattern with an outline which contains all 

points within the outlines of both of the main pattern and the sub pattern. 

Morphing: As the transition progresses, the pattern morphs from the main 
pattern, through the “mix” combination, to the sub pattern.

Mix Positive NAM Negative NAM
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• A value of 0.00 corresponds to the beginning of the transition, and a value of 
100.00 to the end of the transition.

• A negative Start value signifies that the main and sub patterns are already 
combined when the transition starts.

• An End value of 100.00 or more signifies that the main and sub patterns are 
still combined when the transition complete.

• If the Start and End values are the same, the main and sub patterns are 
interchanged instantaneously at the corresponding point in the transition.

• If End is less than Start, as the transition proceeds, it changes from the sub 
pattern to the main pattern.

Dust mix
You can apply the effect of a diamond dust wipe to a selected pattern. You can 
also apply the diamond dust wipe effect to the pattern resulting from a pattern 
mix. (See “Pattern Mix” (page 262).)
When the pattern mix function is off, turning dust mix on results in the main 
pattern and the diamond dust pattern being mixed. This state is the same as a 
pattern mix when the diamond dust pattern is selected for the sub pattern.

10.00

0.00

–10.00

110.00

100.00

0.00 100.00

90.00

Mix ends during 
transition, which 
ends with sub 
pattern at 100%

Main pattern at 100%

Sub pattern at 100%

Parameter settings
Start: Point in the course of the 

transition at which the main pattern 
is at 100%

End: Point in the course of the transition 
at which the sub pattern is at 100%

Transition (0.00 - 100.00)

Start 
value

End 
value

Mix combination of 
main and sub 
patterns already 
begun

Ends with sub 
pattern at 100%

Begins with main 
pattern at 100%

Transition ends 
with main and 
sub patterns 
still in mix 
combination

Mix begins after 
transition starts
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Main and sub modifier link function
When carrying out a pattern mix, it is possible to link the modifier settings for 
the main pattern and sub pattern. There are two modes for this function.

FULL LINK (fully linked) mode
In this mode, all modifier settings are the same for the main pattern and sub 
pattern.
Changing the modifier settings for one pattern automatically changes the 
settings for the other.

SEMI LINK (semi-linked) mode
Only the parameter settings of the modifiers are linked. The modifier on/off 
settings are not linked. When the parameter values for the modifiers of the main 
pattern and sub pattern are different, then after this link mode is selected, 
changing the value of a parameter for one pattern changes the value of the 
parameter for the other pattern to maintain the same difference between the 
two.

Note 
When carrying out a wipe transition using a pattern mix, it is recommended that 
you set the modifier link function to “FULL LINK” mode.
If the link function is off, or SEMI LINK mode is selected, the desired effect 
may not be obtained at the start or end of the transition.

Wipe Pattern Variation and Modifiers

You can carry out a wipe with the following variations and modifications to the 
selected pattern. (For details, see “Setting Wipe Modifiers” (page 264).)

Direction
You can specify the direction of the wipe: the regular direction is referred to as 
“normal”, and the other direction as “reverse.” You can also select alternating 
directions each time the transition is completed (normal/reverse mode).

Normal Reverse
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Split

This splits the pattern, making the parts of the wipe move in opposite 
directions.

The parameter Split No. specifies the number of splits.
The parameter Spacing specifies the spacing between adjacent patterns.

Edge
You can apply a border to the pattern, soften the edges, or soften the applied 
border.
In an independent key transition, only the “Soft” setting is available.

Border: You can adjust the border width.
Soft: You can adjust the edge softness.
Soft border: You can adjust the border width, and the softness of the inner and 

outer edges of the border.
When a border or soft border is selected, the signal filling the border is called 
edge fill. For the edge fill, you can use a matte generated by the dedicated color 
matte generator, or the signal selected on the utility 2 bus. A matte can include 
color 1 and color 2, and a combination of the two colors (a “color mix”).

Split onSplit off

Border Soft Soft border
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Positioner
You can move the wipe pattern to any position.

• The parameter H Position controls the horizontal position of the pattern.
A negative value moves the pattern to the left, and a positive value moves the 
pattern to the right.

• The parameter V Position controls the vertical position of the pattern. 
A negative value moves the pattern down, and a positive value moves the 
pattern up.

Rotation
You can rotate the pattern. There are three rotation modes, as follows.

Angle
This carries out a wipe with the pattern in a fixed angle.

The parameter Angle determines the angle of pattern rotation. 
A value of −100.00 of the parameter Angle corresponds to one whole turn 
counterclockwise; a value of +100.00 corresponds to one whole turn 
clockwise.
With a value of 0.00 there is no rotation.

Positioner onPositioner off

Angle off Angle on
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Speed
Through the course of the transition the wipe pattern rotates at a fixed specified 
speed.

The parameter Speed determines the speed of pattern rotation. 
A value of −100.00 of the parameter Speed corresponds to one turn per second 
counterclockwise; a value of +100.00 corresponds to one turn per second 
clockwise. With a value of 0.00 the pattern is stationary.

Magnitude
Through the course of the transition the wipe pattern rotates through the 
specified angle. 

The parameter Angle determines an angle of pattern inclination at the 
beginning of the transition.
• A value of −100.00 corresponds to the angle rotated one whole turn 

counterclockwise.
• A value of +100.00 corresponds to the angle rotated one whole turn 

clockwise.
• With a value of 0.00 there is no rotation.

The parameter Magnitude determines an angle of pattern rotation through the 
course of the transition.
• A value of −200.00 corresponds to a rotation of two turns counterclockwise.
• A value of +200.00 corresponds to a rotation of two turns clockwise.
• With a value of 0.00 the pattern is stationary.
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Aspect ratio
You can freely change the aspect ratio of the pattern.

A negative value of the parameter Aspect stretches the pattern vertically; a 
positive value stretches the pattern horizontally.

Pattern replication “Multi”
The same pattern can be repeated horizontally and vertically or both, up to 63 
times. You can also change the orientation of alternate copies, or change the 
position.

• The parameter H Multi determines the number of pattern replications 
horizontally, and the parameter V Multi determines the number of pattern 
replications vertically.

• The parameter Shift determines the manner of replication.
At a value of −100.00, the pattern of the adjacent odd-numbered column on 
the left lines up with the central coordinate horizontally.
At a value of +100.00, the pattern of the adjacent odd-numbered column on 
the right lines up with the central coordinate horizontally.

For an independent key transition wipe, you can use the “Invert Type” 
parameter to select from the following four types of replication pattern.

Aspect off Aspect on (a horizontal stretch)

“Multi” off “Multi” on
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1: All replications in the same orientation
2: Even-numbered columns and rows inverted
3: Even-numbered columns and rows inverted, and even-numbered rows 

staggered
4: Even-numbered rows staggered

Pairing
This slits the pattern into multiple strips, making it like a venetian blind.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.
• The parameter Width determines the width of the slits.
• The parameter H Offset determines the spacing in the horizontal direction.

If a negative value is set, the even-numbered pairs of strip and slit move to 
the left, and the odd-numbered pairs move to the right. The value −100.00 
represents the maximum movement.
If a positive value is set, the even-numbered pairs of strip and slit move to 
the right, and the odd-numbered pairs move to the left. The value +100.00 
represents the maximum movement.

• The parameter V Offset determines the spacing in the vertical direction.
If a negative value is set, the even-numbered pairs of strip and slit move 
upward, and the odd-numbered pairs move downward. The value −100.00 
represents the maximum movement.
If a positive value is set, the even-numbered pairs of strip and slit move 
downward, and the odd-numbered pairs move upward. The value +100.00 
represents the maximum movement.

1 2 3 4

Pairing off Pairing on
57Wipes



   C
hapter 1 

M
V

S
-8000 F

unctions

58
Modulation
The pattern signal can be modulated, giving waves on the horizontal or vertical 
edges, or radially. 
The parameter Shape determines the form of the modulation.
1: sine wave, 2: triangular wave, 3: rectangular wave

Note
When using 1080PsF mode in an HD system, the modulation function is not 
available.

Horizontal modulation
This modulates the pattern, applying waviness in the horizontal direction to 
edges.

The parameter Speed determines the speed of waves.
A value of −100.00 generates the maximum downward speed of waves, and a 
value of +100.00 the maximum upward speed.

Vertical modulation
This modulates the pattern, applying waviness in the vertical direction to 
edges.

The parameter Speed determines the speed of waves.
A value of −100.00 generates the maximum leftward speed of waves, and a 
value of +100.00 the maximum rightward speed.
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Fringe
This modulates the pattern, applying waviness in the radial direction to edges.

The parameter Speed determines the speed of waves. 
A value of −100.00 generates the maximum counterclockwise speed of waves, 
and a value of +100.00 the maximum clockwise speed.

Spring
As the transition progresses, the edge of the pattern is subjected to barrel or 
pincushion distortion.

A negative parameter value produces pincushion distortion, and a positive 
value produces barrel distortion.

Spiral
This deforms the pattern spirally.

Spring off Spring on

Spiral off Spiral on
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• The parameter Magnitude determines the size and direction of the spiral.
A value of −100.00 represents the maximum movement in the 
counterclockwise direction, and a value of +100.00 represents the maximum 
movement in the clockwise direction.

• The parameter Wave Speed determines the speed of the lateral waves.
A value of −100.00 represents the maximum speed to the left, and a value of 
+100.00 represents the maximum speed to the right.
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DME Wipes

A DME wipe is a wipe transition that uses a DME effect to change from one 
video image to the next.
There are two types of DME wipe: those which can be selected for a normal 
transition, and those which can be selected for an independent key transition.

For independent key transitions, see page 29.

Types of DME Wipe Pattern

The patterns used for a DME wipe fall into two broad classes.
Preset patterns: predetermined fixed patterns
User programmable DME patterns: patterns which you can create using 

keyframe effects

DME wipe execution mode and pattern numbers that can be used
There are two DME wipe execution modes, depending on the number of DME 
channels available: one-channel mode and two-channel mode. The pattern 
numbers that can be used in these modes are as follows.

DME wipe pattern groups
The patterns used in DME wipes fall into the following groups.

For each group (excluding user programmable DMEs), for schematic patterns 
and numbers, see the appendix “DME Wipe Pattern List” (Volume 2). The 
black part of the pattern represents the old video, and the white part the new 
video, with the wipe taking place in the direction of the arrow.

Slide: The new video slides in over the old video.
(Pattern numbers: 1001 to 1008 (one-channel mode), 2601 to 2608 (two-
channel mode))

Split: The old video splits, and the new video appears in the gap.
(Pattern numbers: 1011 to 1013 (one-channel mode))

Execution mode Preset pattern numbers 
available

User programmable DME 
pattern numbers 
available

One-channel mode 1xxx 1901 to 1999

Two-channel mode 2xxx 2901 to 2999
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Squeeze: The new video appears squeezed over the old video, and 
progressively expands to cover it.
(Pattern numbers: 1021 to 1031 (one-channel mode), 2621 to 2628 (two-
channel mode))

Door: The new video moves like a door closing, and progressively covers the 
old video.
(Pattern numbers: 1041 to 1044 (one-channel mode))

Flip tumble: The old video rotates about an axis and is replaced by the new 
video. During the transition, the signal from the utility 2 bus of the M/E 
bank appears as the background.
(Pattern numbers: 1101 to 1102 (one-channel mode))

Page turn: The old video moves like a page turning, and the new video appears 
behind it.
(Pattern numbers: 1301 to 1313 (one-channel mode))

Page roll: The new video unrolls like a scroll over the old video. This is a type 
of page turn.
(Pattern numbers: 1321 to 1333 (one-channel mode))

Frame in-out: Completed in two transitions. In the first transition, the new 
video appears, then on the second transition the new video goes out and the 
old video returns.
(Pattern numbers: 1201 to 1204 (one-channel mode))

Picture-in-picture: the one-channel mode and two-channel mode differ as 
follows.
In one-channel mode, this completes in two transitions. In the first 
transition, the old video shrinks, and the new video appears behind it.
In the second transition, the old video expands again until it is its original 
size.
(Pattern number: 1251 (one-channel mode))
In two-channel mode, in the first half of the transition, the old video 
shrinks, and the new video appears. In the second half of the transition, the 
new video expands, and the old video disappears. During the transition, the 
signal from the utility 2 bus of the M/E bank appears as the background.
(Pattern numbers: 2651 and 2652 (two-channel mode))

User programmable DME: Using a DME keyframe effect created with a 
keyframe operation, this executes a DME wipe.
(Pattern numbers: 1901 to 1999 (one-channel mode), 2901 to 2999 (two-
channel mode))

For details of creating keyframe effects, see “Creating User Programmable 
DME Patterns” (page 290).

Notes
• To use the split, page turn, and page roll effects requires the MKS-8830M 

Nonlinear Effect Board to be installed in the MVS-8000 system.
• Note that for an independent key transition, only the slide, split, squeeze, 

door, frame in-out, and user programmable DME patterns are available.
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Signals forming part of the background for a DME wipe

In two-channel mode, or flip tumble and so on, in addition to the signals on the 
A and B buses, a background signal may be visible. This background is 
normally supplied by the UTIL2 bus signal.

DME Wipe Pattern Variation and Modifiers

You can modify the selected DME wipe pattern in the same way as an ordinary 
wipe pattern, as follows.

For the setting operations, see “Setting DME Wipe Modifiers” (page 283).

Direction: You can set the DME wipe direction to normal, reverse, or 
alternating normal/reverse (page 52), except for a key transition, which is 
always in normal/reverse mode.

Border: You can apply a border or soft border (see page 53), except for DME 
wipes in the independent key transition control block with which this 
modifier cannot be used.
In the case of a user programmable DME pattern in which a border has 
already been applied to the effect, the behavior is as follows.
• When the DME wipe border setting is ON, only part of the border 

applied in the effect is enabled, and that portion can be adjusted.
• When the DME wipe border setting is OFF, the border applied in the 

effect is enabled as is.
Positioner: This can only be used when one of the following pattern numbers 

is selected.
1031, 1201 to 1204, 1251, 2651, 2652

With the progress of the transition, the center of the pattern automatically 
moves from its initially set position toward the center of the image (see 
page 54). That is to say, the same effect is obtained as in a normal wipe 
when the positioner is set to “AUTO CENTER.” Again, by using the 
position select function, you can move the pattern instantaneously.

Pattern limit: You can restrict the range of the transition as desired. However, 
this is not available for a DME wipe in the independent key transition 
control block. 

For more details, see “Pattern Limit” (page 204).

Size: This can only be used when one of the following pattern numbers is 
selected.

1201 to 1204, 1251, 2651, 2652
You can set the size of the image.

Crop: You can crop the image. It is also possible in 16:9 mode to crop both 
sides, to convert the image to a 4:3 aspect ratio.
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Relation Between DME Wipes and Other Effects

The relations between DME wipes and other effects are as follows.

Relation to ordinary wipes
• DME wipes do not use the wipe generator built into the switcher. Therefore, 

during the execution of a DME wipe, you can still use a pattern produced by 
the wipe generator as the source for a pattern key or mask.

• A DME wipe pattern cannot be used as the source for a pattern key or mask.

Relation to processed keys
When using the DME for a processed key, if you select a DME wipe, an 
available DME is automatically allocated to the DME wipe. If all of the DME 
channels are in use, then it is not possible to select a DME wipe.

Number of DME wipes that can be used simultaneously on a 
single M/E bank

DME wipes can be used in five places, including the four independent key 
transitions, but a maximum of two can be used simultaneously.
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Frame Memory

Overview

Frame memory is a function whereby a frame of input video can be frozen and 
written to memory, for further use as material for editing.
The memory capacity for freeze images is a maximum of 58 frames in an HD 
system, and a maximum of 222 frames in an SD system.

For details of operations, see “Frame Memory Operations” (page 296).

Use of frame memory
There are eight frame memory channels, FM1 to FM8, and each channel 
independently allows a freeze image to be saved or recalled.
By allocating FM1 to FM8 to cross-point buttons you can use the still image 
output from each channel as input material. The “still image” refers to a freeze 
image written to temporary memory or a file saved (stored) in memory.

Correspondence between input and output
There are two buses for capturing frame memory material: the frame memory 
source 1 bus and the frame memory source 2 bus.
These input buses are used by allocation to one of the pairs of output, FM1&2, 
FM3&4, FM5&6, and FM7&8. You can freeze a frame in each channel 
separately, or freeze in the two channels simultaneously.
The source buses allocated to FM1 to FM8 are as follows.

Pair mode
By enabling the pair mode, you can link FM1 and FM2, FM3 and FM4, FM5 
and FM6, and FM7 and FM8. For example, when a freeze or image processing 
is carried out on FM1, the same operation is carried out on FM2. The same 
applies to the other pairs. When a pair of images are captured in pair mode, the 
image frozen in FM1 (3, 5, or 7) is referred to as the main file and the other 
frozen in FM2 (4, 6, or 8) is referred to as the sub file. 

Input Frame memory source bus 1 Frame memory source bus 2

Output FM1 FM2

FM3 FM4

FM5 FM6

FM7 FM8
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Operation modes
The frame memory has the following operation mode. 
V/K mode: When the pair mode is active, the key signal is automatically 

selected on frame memory source bus 2. This is convenient for handling 
the video and key signals together in frame memory. For example, when 
you select a video signal on frame memory source bus 1, the key signal 
assigned to it is automatically selected on frame memory source bus 2. You 
can also use the signal automatically selected on frame memory source bus 
2 as a key signal when processing keyframe memory 1.

To change the pair mode or operation mode, use the Frame Memory menu.

Frame Memory Functions

The frame memory provides the following functions.
• Capturing an image
• Saving an image
• Recalling an image
• Processing an image
• Image output
• Image data management
• Image data transfer

Capturing an image (freeze)
As the input material for the frame memory, you can use the signal selected on 
the frame memory source bus. For this signal you can use video processing 
(video levels or hue value adjustment) or masking.

Allocating a frame memory source bus signal to one of FM1 to FM8, then 
carrying out a freeze captures a still image in the corresponding frame memory 
output image, and saves it in temporary memory.
For a freeze, an image can be captured either as video frame (a “frame freeze”) 
or a video field (“field freeze”).

Note
When the system is powered off, any freeze images written to temporary 
memory are lost.
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Saving an image (store)

You can save an image in temporary memory which has been placed with the 
freeze function as a file in memory. You can save a single image in a single file 
and apply a name of up to eight characters to the file.
When the system is powered off, the file saved in memory is erased, but you 
can restore it in the Frame Memory menu. (See “Restoring Files” (page 312).)

Recalling an image
You can recall an image file saved in memory, and allocate to any of the FM1 
to FM8 outputs.

Processing an image
You can combine the background image (a still image file allocated to any of 
FM1 to FM8, a freeze image written to temporary memory, or a black signal) 
and the input signal.
The following types of processing are available.
Pattern key: Using the signal from a dedicated pattern generator, you can cut 

out the background image and insert the signal selected on the frame 
memory source bus or a color matte signal. You can adjust the size and 
position of the pattern, and add modifiers.

External key: When processing an image in FM1 (3, 5, 7), you can use the 
signal selected on the frame memory source bus 2 to cut out the 
background image, and fill with the signal selected on the frame memory 
source bus 1, or a color matte signal.
When processing an image in FM2 (4, 6, 8), you can use the signal selected 
on the frame memory source bus 2 to cut out the background image, and 
fill with a color matte signal (always white).

Note
An external key can only be used when the pair mode is enabled (see page 
65).

MIX: Mix the background image with the signal selected on the frame memory 
source bus or color matte signal. The mix ratio can be set.

NAM: Non-additive mix the background image with the signal selected on the 
frame memory source bus or color matte signal.

Image output

Moving the output image (reposition function)
For up to two channels of FM1 to FM8 (one from FM1, FM3, FM5 and FM7 
and the other from FM2, FM4, FM6 and FM8), you can move the output image 
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with respect to the screen. The area of the screen around the image that has 
been moved is filled with black. There are two ways of carrying out this 
repositioning.
Normal mode: Movement in the horizontal direction is in two-pixel 

increments.
Black and white mode: Movement in the horizontal direction is in one-pixel 

increments, and for each pixel moved the color is inverted.

Note
It is not possible to save an image moved with the reposition function directly 
to frame memory.

Fixing the output image selection (lock function)
For the output of each of FM1 to FM8, this fixes the image at the current 
output. When this lock is enabled, even if the output is recalled in a snapshot 
or keyframe, the images output to FM1 to FM8 are preserved.

Image data management

File management
The following operations are possible on files created to hold images.
Delete: Specify a file to be deleted. It is also possible to delete all files 

simultaneously in a single operation.
Rename file: Change the name of the specified file.

Image data transfer
Files can be transferred between such devices as a hard disk and memory card. 
In the File menu, files can be saved and recalled.
It is possible to import images such as BMP files or convert frame memory files 
into a different format and save them in an external device.

For details, see Chapter 17 “Files” (Volume 2).

Notes on transferring multiple still images together
• Transferring all of the still image files within frame memory together fails if 

the capacity of the memory card is too small to hold all of the images. In this 
case, replace with a larger capacity memory card, or delete still images until 
saving is possible.

The relation between memory card capacity and number of images that can 
be saved is as follows.
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Note that when transferring to the hard disk, there is ample capacity, so that 
problems such as this do not occur.

• If you cancel the operation during a data transfer between frame memory and 
hard disk or memory card, then an image which was not completely 
transferred will not be reproducible. Avoid canceling such operations.

• When loading a still image file from hard disk or memory card, if [Freeze 
Enable] in the Freeze menu is on, the loaded still image file may sometimes 
be overwritten by the frame memory input image.
To avoid this when loading a file, ensure that [Freeze Enable] is turned off.

Notes on saving or recalling a frame memory still image for or by 
a snapshot/keyframe 
• Storing a frame memory still image for a snapshot or keyframe is simply 

storing a still image as it is on one of the eight frame memory outputs. 
Similarly, reproducing a frame memory still image by means of a snapshot 
or keyframe is simply reproducing a still image as it is on one of the eight 
frame memory outputs. As concerns as a snapshot or keyframe, settings in 
the Freeze menu, Composite menu or other menus relating to frame memory 
have no effect.

• To reproduce a frame memory still image by recalling a snapshot or 
keyframe, you must have the same still image that was present in the frame 
memory when you saved the snapshot or keyframe.
Therefore, when saving a snapshot or keyframe using frame memory, you 
must also save the still image to a storage media such as the hard disk.

Memory card capacity Number of images that can be saved

SD system HD system

16MB 13 2

32MB 27 5

64MB 55 11

128MB 112 23
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Color Backgrounds

The dedicated generators generate color signals, and these can be used as color 
backgrounds in video effects.

Color background selection
There are two color backgrounds, color background 1 and color background 2, 
which you use by assigning to cross-point buttons.

Color combinations (“color mix”)
The color generators can output the result of combining two colors, which are 
color 1 and color 2.
Using a pattern from a dedicated pattern generator, color 1 and color 2 can be 
combined in the boundary region, forming a color gradation. This is referred to 
in the menu system as “color mix.”
You can also apply modifiers to the selected pattern.
When the “color mix” function is not used, the result is a flat color, and color 
1 is always output.

For details of operations, see “Color Background Setting Operations” (page 
316).
Color Backgrounds
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Copy and Swap

You can copy and swap the settings between the banks or between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E-1 and PGM/PST banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition control block
• Matte data (color 1, color 2, and how to compose them)
• Color settings
• DME channel settings

You can carry out copy operations with a simple button operation. Swap 
operations, and copy operations on DME data can only be done with a menu 
operation.

For details of the operations, see Chapter 9 “Copy and Swap” (page 321).

M/E copy and M/E swap
You can copy and swap the overall bank settings between the M/E-1 and PGM/
PST banks.

Note
If a DME is being used on the source M/E bank, then if for example there are 
insufficient DME channels, it may not be possible to select the DME.
There are no such restrictions on a swap.

Keyer copy and keyer swap
You can carry out copy and swap operations among the keyers listed in the 
following table.

Target bank Target data

M/E-1
PGM/PST

Bank settings excluding the following data items:
• Setup data
• Snapshots
• Keyframe effects
• Key snapshots
• Key memory
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Note
If a DME is being used on the source keyer for a copy or either keyer for a 
swap, then if for example there are insufficient DME channels, or the limit on 
using DME channels within an M/E bank is exceeded, it may not be possible 
to select the DME.

Wipe copy and wipe swap
You can copy and swap the wipe settings between ths banks.

Wipe copy and wipe swap in the independent key transition 
control block

You can copy and swap the wipe settings among the keyers listed in the 
following table.

DME wipe copy and DME wipe swap
You can copy and swap the DME wipe settings between the M/E-1 and PGM/
PST banks.

Target bank Target keyer Target data

M/E-1 Keys 1 to 4 Key settings excluding the following data 
items:
• Setup data
• Key snapshots
• Key memory

PGM/PST Downstream keys 1 to 4

Target bank Target data

M/E-1
PGM/PST

Wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition wipe settings.

Target bank Target keyer Target data

M/E-1 Keys 1 to 4 Wipe settings in the independent key 
transition control block.
It is not, however, possible to copy or 
swap wipe settings to or from an external 
downstream keyer.

PGM/PST Downstream keys 1 to 4

Target bank Target data

M/E-1
PGM/PST

DME wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition DME wipe settings.
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DME wipe copy and DME wipe swap in the independent key 
transition control block

You can copy and swap the DME wipe settings among the keyers listed in the 
following table.

Matte data copy and swap
You can copy or swap the matte data among the color generators listed in the 
following table.

Color data copy and swap
You can copy or swap the color data among the color generators listed in the 
following table.

Target bank Target keyer Target data

M/E-1 Keys 1 to 4 DME wipe settings in the independent 
key transition control block.

PGM/PST Downstream keys 1 to 4

Target bank Target keyer and data

M/E-1
PGM/PST

• Keys 1 to 4
• Downstream keys 1 to 4

• Matte data for key fill
• Matte data for key edge fill

Matte data for wipe border edge

Color background • Matte data for color background 1
• Matte data for color background 2

Target bank Target keyer and data

M/E-1
PGM/PST

• Keys 1 to 4
• Downstream keys 1 to 4

• Colors 1 and 2 for key fill
• Colors 1 and 2 for key edge fill
• “Zabton” color data

Colors 1 and 2 for wipe border

Color data for preset color mix

Color background • Colors 1 and 2 for color background 1
• Colors 1 and 2 for color background 2

Frame memory • FM1 color
• FM2 color

DME ch1 to ch4 • Background
• Border
• Sepia
• Light
• Shade
• Drop shadow (other than DME ch4)
• Trail
73Copy and Swap



   C
hapter 1 

M
V

S
-8000 F

unctions

74
DME channel copy and swap
You can copy and swap the channel data among DME channels 1 to 4.
Copy and Swap
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Video Process

The term “video process” is applied to adjustments to the luminance and hue 
of the input video signal.
There are two types of adjustment, depending on the application:
• Adjustment of an individual primary input signal
• Image effects on a particular bus

Note
These types of adjustment may be carried out independently. However, since 
they are implemented by the same hardware, if the same signal is subjected to 
processing twice, there may be limitations on the range of effects obtained in 
the final result.

Video Process Adjustment of a Primary Input Signal

For each primary input, you can switch video process adjustments on or off, 
and can adjust the parameters (Video Gain, Y Gain, C Gain, Hue Delay, and 
Black Level) in the Setup menu. The adjustments do not, however, apply to the 
output video on the MON (monitor) bus.

For details of the settings, see “Signal Input Settings” in Chapter 16 (Volume 
2).

Video Process Adjustments on a Particular Bus

Buses to which the adjustments apply
For each of the following buses, you can switch video process adjustments on 
or off, and adjust the parameters.
• Following buses in the M/E-1and PGM/PST banks

– Key fill buses for keys 1 to 4
– Background A and background B buses
– Utility 1 and utility 2 buses

• Frame memory source 1 and frame memory source 2 buses
• Aux 1 to 48 buses
These settings also apply to keyframes and snapshots.
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Making the adjustments
Adjust VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, and HUE DELAY 
in the following menus.

Video Process Memory

When using video process adjustments for an image effect on a bus, this 
function saves the final values for each pair number for the signals. The video 
process on/off setting is not saved.
When you change the adjustments the values are automatically saved, and 
these last values are recalled when the pair number is selected.
In other words, by switching video process memory on, regardless of the video 
process information for each bus, you can carry out video process adjustments 
for each input signal.
The parameters saved are as follows.

VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, HUE DELAY

Switch the video process memory on or off in the Setup menu.

For details of setting operations, see “Settings Relating to Keys, Wipes and 
Frame Memory (Key/Wipe/FM Menu)” in Chapter 16 (Volume 2).

Applicable bus Menu used for operation See page

M/E-1 bank Key fill buses for keys 
1 to 4

M/E-1 menu page 241

background A and B 
buses

Video Process menu page 329

Utility 1 and 2 buses

PGM/PST bank Key fill buses for 
DSK1 to DSK4

PGM/PST menu page 241

Background A and B 
buses

Video Process menu page 329

Utility 1 and 2 buses

Frame memory source 1 and 2 buses Frame Memory menu page 301

Aux 1 to 48 buses AUX/MON menu page 328
Video Process
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Digital Multi Effects (DME)

DME allows you to add three-dimensional effects such as image movement, 
rotation, magnification and shrinking, as well as a wide variety of special 
effects. DME is the general name for all of these effects.
You can use up to four channels as dedicated DME channels. Each channel can 
be used on its own or in combination with other channels, which allows you to 
create advanced effects with more complexity.

Three-Dimensional Transformations

Transformation is the process of placing a video image in a three-dimensional 
DME coordinate space and subjecting it to manipulations such as movement, 
rotation, magnification or shrinking.

Three-dimensional coordinate space

Source coordinate space and target coordinate space
Images are placed in one of two types of coordinate space: source coordinate 
space and target coordinate space.
• The source coordinate space is a three-dimensional coordinate space with 

reference to the image itself. The x- and y-axes are defined parallel to the 
plane of the image, and the z-axis is defined perpendicular to the plane of the 
image. When you move the image, the coordinate axes also move.

• The target coordinate space is a three-dimensional coordinate space with 
reference to the output monitor screen. The x- and y-axes are defined parallel 
to the plane of the monitor screen, and the z-axis is defined perpendicular to 
the plane of the monitor screen. The coordinates do not move even if the 
image moves.

Source coordinate space and target coordinate space

Z
Y

X X

Y

Z

Source coordinate space Target coordinate space
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For example, as shown below, the image moves in a different direction when 
you move it along the x-axis of the source coordinate space and along the x-
axis of the target coordinate space. 

Movement along the x-axes of the source 
coordinate space and target coordinate space

Local coordinate space and global coordinate space
The coordinates of an individual DME channel are called its local coordinate 
space. The coordinates common to all channels are called the global coordinate
space.
By switching from local to global coordinate space, you can add new 
movement to the movement of images in individual channels, and also apply 
transformation effects to multiple channels that have been combined by Global 
effects (page 104).

Local coordinate space and global coordinate space

Three-dimensional parameters
Three-dimensional parameters are x, y, and z values which define the position 
of an image, its axis of rotation, the position of an imaginary point of view on 
the image, and so on. 

Source coordinate space Target coordinate space

Rotation around y-axis in 
local coordinate space

Rotation around y-axis in 
global coordinate space
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The standard values of parameters are as shown below, depending on the 
aspect ratio of your monitor (4:3 or 16:9).

Values for 4:3 mode
• Origin at center of image (source coordinate space) or center of monitor 

(target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 3.00, z = 0.00
When using HD format signals: x = 12.00, y = 9.00, z = 0.00

• Lower left corner of image or monitor
When using SD format signals: x = −4.00, y = −3.00, z = 0.00
When using HD format signals: x = −12.00, y = −9.00, z = 0.00

Values for x-, y-, and z-axes (4:3 mode)

Values for 16:9 mode
• Origin at center of image (source coordinate space) or center of monitor 

(target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 2.25, z = 0.00
When using HD format signals: x = 16.00, y = 9.00, z = 0.00

–4(–12) a)

+4(+12) a)

+3(+9) a)

–3(–9) a)

x-axis

z-axis −
y-axis

y-axis
z-axis +

The plus direction on the 
z-axis is depth into the 
image or monitor screen.

a) The value in parentheses is for HD format.

x-axis
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• Lower left corner of image or monitor
When using SD format signals: x = −4.00, y = −2.25, z = 0.00
When using HD format signals: x = −16.00, y = −9.00, z = 0.00

Values for x-, y- and z-axes (16:9 mode)

Limits of three-dimensional parameters
The following table shows the limits of three-dimensional transformation 
parameters.
The three-dimensional parameters of an image change when you use the 
trackball or Z-ring to execute a transformation. You can also execute a 
transformation by entering parameter values from the numeric keypad control 
block. 

Operation mode Limits of three-dimensional transformation parameters

Location XYZ HD format: −999.9999 to +999.9999 
SD format: −333.3333 to +333.3333

Rotation, Spin −999.9999 to +999.9999

Axis Location HD format: −999.9999 to +999.9999 
SD format: −333.3333 to +333.3333

Location Size 0.0000 to +999.9999

Aspect 0.0000 to +2.0000

Perspective Perspective (x, y)
HD format: −999.9999 to +999.9999
SD format: −333.3333 to +333.3333

Perspective (z)
HD format: 0.0000 to 333.3333
SD format: 0.0000 to 999.9999

Skew HD format: −9.9999 to +9.9999
SD format: −3.3333 to +3.3333

–4.00 (–16.00)a)

+4.00 (+16.00)a)

+2.25 (+9.00)a)

–2.25 (–9.00)a)

x-axis

z-axis −

y-axis

y-axis

z-axis +

The plus direction on the z-axis is depth 
into the image or monitor screen.

x-axis

a) The value in parentheses is for HD format.
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Detents

The system defines points called detents at regular intervals on the three-
dimensional space. Pressing the [CTR] button in the device control block sets 
the current three-dimensional parameter values to the closest detent points. 
(For details, see “Three-Dimensional Transformation Operations” in Chapter 
11 (Volume 2).)

The following table shows the interval between successive detents for each 
transformation operation mode (see page 82).

a) When a value is smaller than 1, 1/Aspect or 1/Perspective (z) is adjusted to an integral value.

Three-dimensional parameter default values
Each of the transformation operation modes has default values for three-
dimensional parameters. If required, you can return the current value to the 
defaults by pressing the [CTR] button in the device control block twice in rapid 
succession. (For details, see “Three-Dimensional Transformation 
Operations” in Chapter 11 (Volume 2).) 

The following table shows the default parameter values for each 
transformation operation mode.

Operation mode Detent interval

Location XYZ 1.00

Rotation, Spin 0.25

Axis Location 1.00

Location Size 0.25

Aspect 1.00 a)

Perspective (x, y)
Perspective (z)

1.00
1.00 a)

Skew 0.10

Operation mode Default value

Location XYZ 0.00

Rotation, Spin 0.00

Axis Location 0.00

Location Size 1.00

Aspect 1.00

Perspective (x, y)
Perspective (z)

0.00
1.00

Skew 0.00
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Resetting of parameter values set in the source coordinate space
In some transformation operation modes, if you switch to the target coordinate 
space after setting up a three-dimensional transformation in the source 
coordinate space, the setting values in the source coordinate space (three-
dimensional parameter values) are converted to values in the target coordinate 
space (source/target conversion).
Once a conversion has taken place, the original source coordinate space 
parameters do not return to their original values when you switch back to the 
source coordinate space. They are reset to zeros.
Source/target conversion occurs in the following operation modes: 
• Location XYZ
• Rotation

Transformation Operation Modes

The following operation modes are available for three-dimensional DME 
transformations. These operations are carried out in the device control block. 
(For details, see “Three-Dimensional Transformation Operations” in Chapter 
11 (Volume 2).)

Location XYZ
Moves the image on the x-axis, y-axis, or z-axis. The direction of movement 
differs depending on whether you are manipulating the image in the source 
coordinate space or the target coordinate space.

Image movement in the source coordinate space

Movement on the x-axis Movement on the y-axis Movement on the z-axis
Digital Multi Effects (DME)
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Image movement in the target coordinate space

Rotation
Rotates the image on the x-axis, y-axis, or z-axis. The type of rotation differs 
depending on whether you are manipulating the image in the source coordinate 
space or the target coordinate space.

Image rotation in the source coordinate space

Image rotation in the target coordinate space

Movement on the x-axis Movement on the y-axis Movement on the z-axis

Rotation around the y-axis Rotation around the x-axis Rotation around the z-axis

Rotation around the y-axis Rotation around the x-axis Rotation around the z-axis
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Spin
When rotating the image in Rotation mode, it may not always be possible to 
achieve the kind of rotation around an axis that you want. Combining Rotation 
mode with Spin mode creates an effect that rotates the image around a specified 
axis. The type of rotation differs depending on whether you are manipulating 
the image in the source coordinate space or the target coordinate space. (The 
way the image rotates around an axis is the same as in Rotation mode.)

Axis Location
Moves an axis of rotation in the source coordinate space.

Axis movement

Location Size
Changes the size of the whole image. 
• Because shrinking and magnification of the image in the source coordinate 

space is done in three-dimensional space, magnifying the image emphasizes 
the sense of perspective.

• Because shrinking and magnification of the image in the target coordinate 
space is a conversion of the two-dimensional image displayed on the 
monitor, shrinking and magnification does not change the shape of the 
image.

Magnification and shrinking in the source coordinate space

Z Y Z' Y' Z

X

Z'

X'

Y X

Y' X'

Movement on the x-axis Movement on the y-axis Movement on the z-axis
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Magnification and shrinking in the target coordinate space

Aspect
In the source coordinate space, changes the aspect ratio in the x-direction and 
y-direction, either independently or simultaneously.

Perspective
In the target coordinate space, changes the perspective on the image by 
changing an imaginary view point, without changing the position of the image.
The x-axis and y-axis values define the position of the view point. The z-axis 
value defines its distance from the image.

Change of aspect ratio in 
x-direction

Change of aspect ratio in y-
direction

Simultaneous change 
aspect ratio in x-direction 
and y-direction

Change of view point on 
x-axis

Change of view point on y-
axis

Change of distance from 
view point to image
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Skew
In the source coordinate space, change the skew of the image on the x-axis or 
y-axis.

Graphics Display

Graphics display is a function that allows you to display wire frames, 
coordinate axes and a grid over the current DME image, to make it easier to 
create effects in three-dimensional coordinate space.
To make graphics display settings, use the DME menu. (For details, see 
“Graphics Display” in Chapter 11 (Volume 2).)

You can display the following kinds of graphics.

Wire frames
A wire frame displays an image enclosed in a frames, so that you can check the 
position and size of the image. If there is a shadow (see page 107), a frame is 
shown for the shadow as well.

Coordinate axes
This is a three-dimensional display of coordinates in local or global coordinate 
space. You can check the origin of the axes and the directions of the x-, y-, and 
z-axes.

Channel ID
This displays the channel number so that you can check which channel you are 
using, a useful feature when you are working with multiple channels.
Channel IDs are displayed differently in local and global coordinate space.
• In local coordinate space, the channel number is displayed along with “F” or 

“B” to indicate whether you are looking at the front (F) or back (B) of the 
current wire frame. For example, “1F” means the front of the wire frame on 
channel 1 in local coordinate space.

Change of skew on x-axis Change of skew on y-axis
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• In global coordinate space, the channel number is displayed along with “G” 

to indicate global. For example, “G2” means channel 2 in global coordinate 
space.

Wire frame, local coordinate space axes, and channel ID

Grid
This is a grid pattern representing the whole of the monitor screen. The grid 
makes it easy to set the position of an image in two-dimensional coordinates.

Grid (SD format, 4:3 mode)

Shrinking the graphics display
You can shrink the graphics display so that you can see beyond the range 
displayed on the normal monitor screen. This makes it possible to visually set 
the location of images in a larger space. The range displayed on a normal 
monitor screen is indicated by a frame.

Wire frame

Local coordinate space axes

Channel ID

Y

XZ
1F

–4 –3 –2 –1 0 +1 +2 +3 +4
+3

+2

+1

0

–1

–2

–3
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To automatically erase the graphic display
Turn Auto Erase on. The graphic display is erased automatically whenever a 
keyframe is executed. It is displayed again after the keyframe ends, after the 
time set in Recovery Time.

Three-Dimensional Parameter Display

You can display a three-dimensional parameter list for the currently controlled 
image. When more than one DME channel is selected, the status of the 
reference channel is displayed.

For the method of displaying a parameter list and an example display, see 
“Three-Dimensional Parameter Display” in Chapter 11 (Volume 2).

DME Special Effects

You can use DME to add a variety of special effects. To add effects, use the 
DME menu. (See “DME Special Effect Operations” in Chapter 11 (Volume 
2).)

Range displayed 
on normal monitor 
screen

Wire frame
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Border

This effect adds a border to the image frame. You can adjust the width (or 
thickness) of the border, its color, and the softness of the border edges.

Crop
This effect crops away the edges of the image. You can crop the top, bottom, 
left, and right sides individually or all together. You can also soften the cropped 
edges.

Defocus
Defocuses the whole image. The degree of defocusing can be set separately for 
video signals and key signals. You can also cancel the black level leaking that 
occurs at the edge of the screen when the Defocus effect is used.
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Blur
Applies a rounded blurring to the whole image.

Beveled Edge
This gives an image a beveled edge. You can set the edge width and color. The 
inner edge softness and edge boundary softness can also be set.

Multi Move
Shrinks the image and lines up a number of copies vertically and horizontally. 
You can specify the center point of the shrinking, the shrinking ratio, and the 
aspect ratio of the image screen.

Sepia
Overlays a specified color onto the image. You can adjust the sepia color that 
is overlaid, and specify the degree of mixing between the original image and 
the sepia image.

Mono
Converts the image into a monochrome image.

Light Color
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Posterization

Coarsens the luminance gradations of the image, for a painting-like effect. You 
can specify the degree of luminance coarsening.

Solarization
Like the Posterization effect, creates a painting-like effect, but does so by 
coarsening the chroma gradations of the image. You can specify the degree of 
chroma coarsening.

Nega
Reverses the luminance and/or chroma of the image.

Contrast
Changes the contrast of the luminance and/or chroma of the image.

Mosaic
Divides the image into small tiles so that it looks like a mosaic. You can specify 
the size and aspect ratio of the tiles.

Freeze
Freezes the input video. The following types are available:
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Hard Freeze: Freezes the input video at an arbitrary timing.
Time Strobe: Freezes the input video at specified intervals for a specified 

length.
Film: Slows the apparent frame rate, for an effect like film. You can specify 

the ratio of advancement.
For Hard Freeze and Time Strobe, you can select the first field or the frame as 
the freeze timing.

Nonlinear Effects
You can add a variety of effects, including effects that change the shape of the 
image as a whole.
The following nonlinear effects are available.

For more information about settings and operations with nonlinear effects, see 
“Nonlinear Effect Settings” in Chapter 11 (Volume 2). 

Note
It is not possible to apply two or more nonlinear effects at the same time. 
Turning any nonlinear effect on automatically turns all other nonlinear effects 
off.

Wave
Produces a wave-like effect in the image.
There are two modes: H&V and Size. You can set the size and frequency of the 
waves, the wave form, the amount of wave movement, and the range. In H&V 
mode, you can also set the wave angle.

Mosaic Glass
Makes the image rougher and finer at a specified interval.
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There are two modes: H&V and Size. You can set the size and frequency of 
waves in the image, the wave form, the amount of wave movement, and the 
range. In H&V mode, you can also set the wave angle.
.

Flag
Applies an effect like a flag waving in the wind.
There are two modes: H&V and Size. You can set the size and frequency of 
waves in the image, the wave form, the amount of wave movement, and the 
range. In H&V mode, you can also set the wave angle.

Twist
Twists the image.
You can twist the image in the horizontal or vertical direction.
You can set the size and frequency of waves in the image, the wave form, the 
amount of wave movement, and other parameters.

Ripple
Applies an effect like ripples moving across the image.
There are four modes: Radial, Angular, Both, and Shape. The direction of 
modulation differs depending on the mode. You can set the size and frequency 
of the ripples, their direction and speed, their center point, and other 
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parameters. In Shape mode, you can select ripple shapes other than circles 
(stars, etc.). 

Rings
Partitions the image into rings that rotate while moving in the same direction.
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, the starting angle, 
and other parameters.

Broken Glass
Partitions the image like broken glass, with shards flying outward.
You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, the starting angle, 
and other parameters.
You can also fix the direction in which shards scatter.

Flying Bar
Divides the image into bars which peel off in two blocks as they move. 
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You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the direction of movement, the width of the partitions, 
the degree of randomness in partition width, the partition angle, and other 
parameters.

Blind
Divides the image into bars or wedges, with blocks rotating like the slats of 
venetian blinds. 
There are two modes: Bar and Wedge. You can set the number of rotations by 
blocks, the perspective, the width and position of blocks, the direction, the 
center position, and other parameters. 

Split
Splits the image upper and lower, left and right. 
You can set the degree to which the image is split, the split positions, and other 
parameters.

Split Slide
Divides the image into bars which slide alternately in reverse directions.
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You can set the degree of transition, the degree of randomness in the distance 
moved by each block, the degree of sliding, block width, block angle, and other 
parameters.

Mirror
Partitions the image vertically and horizontally, creating an image like a 
reflection in a mirror. 
You can choose to reflect in the directions left to right, right to left, bottom to 
top, top to bottom, or any combination of directions. You can also set the 
position of the border between original and reflections.

Multi Mirror
Divides the image into originals and reflections, lining them up vertically and 
horizontally.
You can set the width of the original, the center position of the original, the 
offset of the image with fixed mirrors, the direction of the mirrors, and other 
parameters.

Kaleidoscope
Creates an image like a view into a kaleidoscope. 
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You can set the number of blocks, the partition reference point and angle, 
horizontal and vertical offsets, a reflection position, and other parameters. 

Lens
Creates an image like a view through a lens.
You can set the shape and aspect ratio of the lens, the angle, the magnification 
ratio, the curve ratio, the size, the center position, and other parameters. 
You can also choose to display only the portion of the image that is seen 
through the lens.

Circle
Makes a circle with the image.
You can set the size of the circle, and make the axis of modulation vertical.

Panorama
Curves the upper and lower edges of the image to emphasize the sense of 
perspective.
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You can set the horizontal and vertical curve ratio, and the curve center 
position.

Page Turn
Turns the image like a turning page.
There are four modes: H&V, H, V, and Off. You can select the turn position, 
the radius of the turned portion, the amount and angle of turning, and the input 
video for the front and back pages. 

Roll
Rolls the image up.
There are four modes: H&V, H, V, and Off. You can select the turn position, 
the radius of the turned portion, the amount and angle of turning, and the input 
video for the front and back pages. 

Cylinder
Winds the whole image onto a cylinder.
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You can set the degree of winding onto the cylinder, the radius, the horizontal 
position of the wound image, and front and back side output for the image.

Sphere
Winds the whole image onto a sphere.
You can set the degree of winding onto the sphere, the radius, the horizontal 
position of the wound image, and front and back side output for the image.

Note
You cannot monitor the part of a rotating sphere that corresponds to its axis on 
the monitor screen.

Explosion
Divides the image into fragments which expand as they fly out. 
You can set the pattern shape and aspect ratio, the center position, the amount 
of movement by fragments, the curvature of the transition path, and other 
parameters.

Swirl
Swirls the image.
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You can set the amount of swirl, the swirl region, the amount of rotation, and 
the swirl center position.

Melt
Melts the image away from a specified part.
You can set the degree of transition, the degree of extension in the image, the 
jaggedness of the melting sections, and the amplitude, frequency, amount of 
movement, and speed of the melting sections. You can also set the slant of the 
borders, the shape of the sections that begin to melt, and other parameters.

Character Trail
Extends the edge of the image like a trail.
You can set the effect starting position, the degree of expansion, the slant angle 
of the effect region, and trail direction, the degree to which the image 
disappears, the trail type and amount of stardust, and other parameters.

Lighting
Provides the effect of light striking the image. You can specify the intensity and 
color of the light and the lighting pattern. The following lighting patterns are 
available:
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Plane: Illumination of the entire screen.
Bar: Bar illumination. You can specify the width and angle of the bar, and its 

softness.
Preset: Lighting pattern suitable for nonlinear effects.

Trail
Recursively freezes the input video at regular intervals so that a trail of 
afterimages is created. You can make the afterimages stardust trails.

Note
Of the three effects of trail, motion decay and keyframe strobe, only one can be 
on at a time. When one of them is on, turning another of them on automatically 
turns off the one that has been on.

Motion Decay
Blurs the motion of a moving video by creating afterimages of the moving 
video. (See “Note” in the preceding section “Trail.”)
You can make the afterimages stardust trails.

Keyframe Strobe
Freezes the video each time the effect passes a keyframe. (See “Note” in the 
preceding section “Trail.”)
You can make the afterimages stardust trails.
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Background
Adds a color to the background of the image.

Separate Sides
Applies separate video signals and key signals to the front and back of the 
image.

Front and back sides

Invert
Inverts the input video signal and/or key signal horizontally or vertically. You 
can make separate settings for the front and back.

Inversion of input signal

Interpolation

Specifies the methods used for interpolation processing of input video signals 
and input key signals.
For input video signals, you can select from the following four methods.

Front Back

Horizontal inversion Input signal Vertical inversion
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Note
This setting is valid only in an SD system.

• Detect changes in the luminance and chrominance signals separately, and 
switch automatically between fields and frames. You can select the degree of 
change detection.

• Detect changes in the luminance signal separately, and switch automatically 
between fields and frames. You can select the degree of change detection.

• Do interpolation in field units.
• Do interpolation in frame units.

For input key signals, you can select from the following three methods.
• Detect changes in the luminance signal separately, and switch automatically 

between fields and frames. You can select the degree of change detection.
• Do interpolation in field units.
• Do interpolation in frame units.
You can also select the number of pixels used in interpolation processing, and 
select the method used to show the picture reduced or expanded.

Key Density Adjustment

You can adjust the key density for the key signal input to the DME.

Key Source Selection

You can select either the key signals received from the switcher or the key 
signals generated in the DME for application to the front and back of the image 
(see page 102).

Global Effects

Global effects are special effects created by combining the images of 
successive channels. The Global Effect menu is used to add these effects.

For details of this menu, see “Global Effect Operations” in Chapter 11 
(Volume 2).

The following types of global effects are available.
• Combiner
• Brick
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• Shadow

Combiner
When multiple channels are selected on one keyer or for one transition, the 
Combiner automatically combines the selected images. Up to three channels 
can be combined.
You can also control the way in which the combination is carried out, as a mix 
or an overlap with priority set automatically. For a mix, you can control the 
relative amounts of each channel.

Combination of channel 1 (Ch1) and channel 2 (Ch2)

Combination of Ch1, Ch2, and Ch3

Ch1

Ch2
Ch1

Ch3

Ch4

Ch3

Ch4

1

2
1

2

3

4

3

4

Combiner

Ch1

Ch2
Ch1

Ch4Ch4

1

2

Ch3 3

2 3
1

44

Combiner
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Combination of Ch1 and Ch2 / combination of Ch3 and Ch4

Mixing Ch1 and Ch2

If the Mix1 setting is 70, the proportion of the channels in the mixed portion in 
the illustration above is as shown in the following table.

Mixing Ch1, Ch2, and Ch3

Combination Indication in figure Ch1 Ch2

Ch1 and Ch2 30% 70%

Ch1

Ch2
Ch1

Ch3

Ch4

1

2 1 1
2

Ch3
2 43

3

4

Combiner

Combiner

Ch1

Ch2

1

2

Mix1
Ch1

Ch2

Ch1

Ch2

1

2

Mix1

Ch3 3

Mix2

Ch2

Ch1

Ch3
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If the Mix1 setting is 70 and the Mix2 setting is 40, the proportions of the 
channels in the mixed portions in the illustration above are as shown in the 
following table.

Pairwise mixing of Ch1 and Ch2, and Ch3 and Ch4

If the Mix1 setting is 70 and the Mix2 setting is 40, the proportions of the 
channels in the mixed portions in the illustration above are as shown in the 
following table.

Combination Indication in figure Ch1 Ch2 Ch3

Ch1 and Ch2 30% 70% –

Ch2 and Ch3 – 60% 40%

Ch1 and Ch3 30% – 70%

Ch1, Ch2, and Ch3 30% 42% 28%

Combination Indication in figure Ch1 Ch2 Ch3 Ch4

Ch1 and Ch2 30% 70% – –

Ch3 and Ch4 – – 60% 40%

Ch1

Ch2

1

2

Mix1
Ch1

Ch2

Ch3

Ch4

3

4

Mix2
Ch3

Ch4
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Brick

This effect creates a rectangular parallelepiped from 3 successive channels. 
The Brick effect can combine Ch1, Ch2, and Ch3, or combine Ch2, Ch3, and 
Ch4. The three images are displayed as shown below.

An example of the Brick effect

Combinations of Ch1, Ch2, and Ch3
Upper side: Ch1 image
Side V: Ch2 image
Side H: Ch3 image

Combinations of Ch2, Ch3, and Ch4
Upper side: Ch2 image
Side V: Ch3 image
Side H: Ch4 image

You can adjust the height of the brick, the overlap between the three images 
and the way to insert the side images.

Shadow
This effect gives the image a shadow. The effect uses two successive channels. 
You can adjust the position and density of the shadow with respect to the 
image, and the color of the shadow. The channel with the largest number (for 
example, Ch2 in the case of Ch1 and Ch2) becomes the shadow.

X

Y
Z

Side V Side H

Height

Upper side
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In the MVS-8000 system, you can operate while controlling the following 
types of external device:
• Devices supporting P-BUS (Peripheral II protocol) (referred to as “P-BUS 

devices” in the manual)
• Devices supporting GPI

The following is an outline of external device control.

For external device control operations, see Chapter 12 “External Devices” 
(Volume 2). For details on the devices that can be connected, consult your Sony 
representative.

Shared Functions for External Device Control

Keyframe functions
There are 99 registers, numbered 1 to 99, holding external device control data 
as keyframe data.
The following are the keyframe functions that can be used.
• RECALL (1-99), STORE (1-99), RECALL UNDO, STORE UNDO, empty 

register search, AUTO SAVE, RECALL MODE (RECALL, RECALL & 
REWIND)

• EDIT ENABLE, EDIT UNDO
• CONST DUR, EFF DUR, KF DUR, DELAY, PAUSE, INSERT BEFORE, 

INSERT AFTER, MODIFY, DELETE, COPY, PASTE BEFORE, PASTE 
AFTER, FROM TO, ALL

• PREV KF, NEXT KF, GOTO TC, GOTO KF, RUN, REWIND, FF, STOP 
NEXT KF, NORMAL, JOG, KF FADER

Note 
Actions set in a keyframe are executed only when the keyframe effect is 
executed in the normal direction. Take care when executing simultaneously 
with a switcher or DME keyframe effect, since the actions are not executed in 
the reverse direction.

The following keyframe functions cannot be used.
• KF LOOP, EFFECT LOOP, REVERSE, NORMAL/REVERSE
• PATH
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Saving to registers
Set the data for controlling external devices in the Device menu. You can save 
the set data in keyframe, snapshot, or shotbox registers. You can recall the 
register in which the data is saved, and carry out operations on it with the 
keyframe control block.

For details, see Chapter 12 “External Devices” (Volume 2).

Register manipulation functions
You can carry out the following operations on the registers in which the data 
for controlling external devices is saved.
• Copy
• Move
• Swap
• Merge
• Lock
• Name

File related functions
As effect data, you can save and recall, using the File menu.

Control of P-BUS Devices

You can control P-BUS devices from the MVS-8000 system through the 9-pin 
serial port of a DCU.

P-BUS device control modes
There are two modes of P-BUS device control, as follows.
P-BUS trigger mode: Operating a previously specified button outputs the 

command for an action assigned to that button.
P-BUS timeline mode: Carrying out a keyframe effect under the control of the 

center control panel controls external devices.
In the setup, select which of P-BUS trigger mode and P-BUS timeline mode to 
use.

P-BUS trigger mode actions
The actions that can be used in P-BUS trigger mode are as follows.
• Store
• Recall
• Trigger
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For details of the buttons assigned to each action, see Chapter 12, “External 
Devices” (Volume 2).

P-BUS timeline
At a keyframe point on the P-BUS timeline, you can set an action (setting what 
action command is output to which device). At any single keyframe point you 
can set actions for a maximum of 24 devices.

P-BUS timeline mode actions
The actions that can be used in P-BUS timeline mode are as follows.
• Store
• Recall
• Trigger
For the action setting (or P-BUS timeline editing), use the Device menu.
You can save the data set in the Device menu in keyframe effect registers. 
Recalling the register starts execution of the keyframe effect, and when this 
reaches the keyframe point at which actions are set, action commands are 
output to external devices through the 9-pin serial port assigned to P-BUS.

For details, see Chapter 12 “External Devices” (Volume 2).

Control of GPI Devices

You can control GPI devices from the control panel of an MVS-8000 system, 
or through the GPI output port of a DCU.

GPI timeline
For a keyframe effect controlled from the center control panel, the GPI timeline 
allows you to set an action (setting a trigger output from a particular GPI output 
port) at a keyframe point on the GPI timeline. At any keyframe point, you can 
make a maximum of eight GPI output port settings.

GPI timeline actions
The actions that can be used on the GPI timeline are as follows.
• Control panel GPI output port
• DCU GPI output port
For the GPI output settings (keyframe editing), use the Device menu.
The data set in the Device menu are saved in a keyframe effect register. When 
you recall this register and start execution of the keyframe effect, and advance 
the effect to the keyframe point for which the GPI output is set, a trigger pulse 
is output to the external device from the specified GPI output port.
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Regions and Registers

Regions

The term “region” refers to some sort of functional block of the system.
When saving or recalling snapshot registers and effect registers, or creating or 
editing effects, you first select the region to which the operation applies. You 
can also select multiple regions simultaneously.

Classification of the regions
The regions are classified as follows.
• MASTER region
• The following 16 regions

– Switcher: M/E1, PGM/PST, USER1 to USER8
– DME: DME1 to DME4 (inclusive of Global)
– External devices: P-BUS, GPI

Only the regions assigned to the region selection buttons of the numeric keypad 
control block can be used simultaneously.

For details of the region assignment to the region selection buttons, see 
“Overall Control Panel Settings (Config Menu)” in Chapter 16 (Volume 2).

Regions applicable to keyframe operations
All the above 16 regions.

Regions applicable to snapshot operations
Fourteen regions, that is, the above 16 regions less the P-BUS and GPI regions.

“USER” regions
You can optionally assign the following regions to the regions USER1 to 
USER8.
• Color backgrounds 1 and 2
• AUX1 to AUX48
• Monitor 1 to 8
• Frame Memory 1 to 8

For details of the USER1 to USER8 region assignment, see “Overall Control 
Panel Settings (Config Menu)” in Chapter 16 (Volume 2).

Reference region
When multiple regions are selected, only one region appears in the displays for 
menu and numeric keypad operations. This is called the “reference region.”
The reference region is determined according to the following precedence.
Regions and Registers
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M/E1 >P/P >USER1 > USER2 > USER3 > USER4 
>USER5 > USER6 > USER7 > USER8 > DME1> DME2 > DME3 
> DME4 > P-BUS

Master region
The regions saved in a master snapshot register or master timeline register and 
the register numbers saved in such regions can be recalled at a time as the 
master region.
The master region can be saved or recalled using the numeric keypad control 
block.

Registers

A register is an area of memory in a device which holds a snapshot, keyframe, 
and so on.

Keyframe effect registers

Dedicated effect registers
There are 99 dedicated registers for keyframe effects in each region, numbered 
1 to 99.

Shared user-programmable DME registers
In addition to the 99 DME registers for each region (i.e. each channel), there 
are also shared registers for each processor as shown in the following table. 
These are used for user-programmable DME.

Note
When operating with these shared registers, be sure to select the appropriate 
regions depending on the number of channels. When recalling registers in the 
200 range, select two consecutive channels for the regions, as for example 
[DME1] and [DME2].

Work register
This is a temporary register used when editing keyframes.
When you recall an effect, it is read from the effect register into the work 
register, and when you save, the contents of the work register are written to the 
effect register.

Register number Register allocation

101 to 199 Shared register for one-channel effects

201 to 299 Shared register for two-channel effects
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Master timeline registers
There are 99 master timeline registers, numbered 1 to 99, for each control 
panel. They store keyframe effect regions and the register numbers saved in the 
regions.

Snapshot registers
These are registers for snapshots, and there are 99, numbered 1 to 99 for each 
region.

Master snapshot registers
There are 99 master snapshot registers, numbered 1 to 99, for each control 
panel. They store snapshot regions and the register numbers saved in the 
regions.
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A keyframe represents an instantaneous state of an image; it can be saved and 
recalled for reuse.

Effects

By arranging a number of keyframes on the time axis, and interpolating 
between successive keyframes, you can create an effect in which there is a 
continuous change from each keyframe to the next.
The figure below shows three keyframes created with a wipe pattern (the 
circle) in different positions. This is interpolated to create the effect shown.

Example of keyframes and effect execution

You can save the sequence of keyframes representing a single effect in a 
register. Then by recalling this register, you can replay the same effect.

For details of keyframe effect registers, see “Regions and Registers” (page 
112).

Background A

Background B
Interpolated images

Keyframe 1 Keyframe 2 Keyframe 3

Effect execution
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Saving and Recalling Effects

To create a new effect, first recall an empty register, then create the keyframes 
one at a time in this register. To run an effect, it is also necessary to set the time 
and the path.
To edit an existing effect, recall the register holding the effect, then make the 
changes.
When you have finished creating or editing the effect, save it in the recalled 
register or another specified register.

Auto save function
When you recall an effect, the currently recalled effect is automatically saved 
in a register. This is called the auto save function. You can disable this function 
in a Setup menu.

Effect Attributes

An individual effect may also have attached special conditions relating to 
switcher or DME operation when the effect is recalled.
These conditions are called “attributes” of the effect, and can be added when 
the keyframe effect is saved or recalled.

Type of attribute
The attribute that can be attached to an effect is as follows.
Effect dissolve: The transition from the state before the effect recall to the state 

at the effect start point is carried out smoothly, by a dissolve. The dissolve 
duration can be set in the Effect menu.

Temporary attributes
When a keyframe is recalled, independently of the attributes held in the 
register, you can also enable or disable temporary attributes. These temporary 
attributes are set when the keyframe effect is recalled. 

Effect Editing

For editing operations such as to insert, delete, or modify a keyframe, it is 
necessary to stop the effect at the corresponding point on the time axis. This is 
termed an “edit point.”
Keyframes
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You can edit either on a keyframe within the effect, or at any point between 
keyframes.
Insert: Insert the current image as a keyframe. Inserting a keyframe in an 

existing effect may change the duration of the effect (see page 119).
Modify: Modify a keyframe. You can modify a single keyframe or a range of 

keyframes in the effect together.
Delete: Delete a keyframe. You can delete a single keyframe or a range of 

keyframes in the effect together. Deleting keyframes from an effect 
reduces the duration of the effect (see page 120).
After deleting a keyframe, you can reinsert the keyframe with a paste 
operation.

Copy: Copy a keyframe. You can copy a single keyframe or a range of 
keyframes in the effect together.

Paste: Paste the keyframe last copied or deleted anywhere within the effect.
Pause: You can set a pause on a particular keyframe, so that when the effect is 

run it pauses on this keyframe. You can make this setting on any number 
of keyframes. To restart the paused effect, repeat the operation to run the 
effect.

KF Loop: Execute the effect the specified number of times through the 
keyframes in the specified range.

Undo an edit operation: Undo the effect of the last operation to insert, 
modify, delete, or paste a keyframe.

Duration modes
In keyframe editing, there are two duration modes; switch between them in the 
keyframe operation section. (See “Time Settings” in Chapter 13 (Volume 2).)
Variable duration mode: In this mode, inserting or deleting a keyframe 

increases or reduces the duration.
Constant duration mode: In this mode, inserting or deleting a keyframe does 

not change the duration. This is useful for keyframe editing of an effect 
with a fixed duration.
In the variable and constant duration modes, the keyframes to which a 
modify operation applies, and the effect of a paste operation are different.

Difference in keyframes to which a modify operation applies

a) A new keyframe is inserted at the effect position.

Effect position Variable duration mode Constant duration mode

On a keyframe Applies to currently 
selected keyframe

Applies to currently selected keyframe

Between two 
keyframes

Applies to previous 
keyframe

Modify operation not possible a)
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Difference in the effect of a paste operation
Variable duration mode: The copied keyframe is inserted at the specified 

position.
Constant duration mode: The copied keyframe is written over the specified 

position.

Transition mode
You can use an effect created with keyframes as a DME wipe pattern on the 
switcher. In this case, it is necessary to set the transition mode (the way in 
which the effect behaves).

For details of the setting, see “User Programmable DME Transition Mode” 
(page 290).

Time Settings

Keyframe duration and effect duration
You can determine the execution time of an effect by setting either the 
keyframe durations or the effect duration.
Keyframe duration: This is the time from the keyframe to the next keyframe. 

You can set this time in the keyframe control block. (See “Time Settings” 
in Chapter 13 (Volume 2).)
In constant duration mode (see page 117), it is not possible to change the 
keyframe duration setting.

Effect duration: This is the total execution time of the effect, from the first 
keyframe to the last. You can set this time in the keyframe control block.
(See “Time Settings” in Chapter 13 (Volume 2).)
When you change the effect duration, the keyframe duration for each 
keyframe in the effect is automatically recalculated proportionally.

Schematic view of keyframe duration and effect duration

1 2 3 4 5   

Keyframe duration

Keyframe number

 Effect duration
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The effect duration may also be changed by inserting or deleting keyframes.

Changes in the effect duration caused by inserting a keyframe
• When the effect is stopped on a keyframe, inserting a keyframe increases the 

effect duration by the duration of the inserted keyframe.
• When the effect is stopped between two keyframes, inserting a keyframe 

does not change the effect duration.

Note
In constant duration mode (see page 117), the duration of the current keyframe 
is reduced to zero, and the new keyframe is inserted with the previous duration 
of the current keyframe. Thus the effect duration does not change.

Keyframe insertion position and the change in effect duration

Insertion position Change in effect duration

Insertion before the first 
keyframe

Insertion between two 
keyframes

Insertion at an existing 
keyframe

Insertion at the last 
keyframe

0 1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5

1 2 3 4

1 2 3 4 5
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Changes in the effect duration caused by deleting a keyframe
• When the effect is stopped on a keyframe, a delete operation deletes the 

keyframe, and reduces the effect duration by the duration of the deleted 
keyframe.

• When the effect is stopped between two keyframes, a delete operation 
deletes the preceding keyframe, and reduces the effect duration by the 
duration of the deleted keyframe.

Note
In constant duration mode (see page 117), the duration of the keyframe before 
the deleted keyframe is increased by the duration of the deleted keyframe. Thus 
the effect duration does not change.

Keyframe deletion position and the change in effect duration

Deletion position Change in effect duration

Deletion of the first 
keyframe

Deletion of an 
intermediate keyframe

Deletion between two 
keyframes

Deletion of the last 
keyframe

1 2 3 4

1 2 3

1 2 3 4

1 2 3

1 2 3 4

1 2 3

1 2 3 4

1 2 3
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Delay setting

You can set the delay from the time of executing an operation to run the effect, 
and the effect actually starting (that is, the delay until the first keyframe). You 
can make this setting in the keyframe control block. (See “Time Settings” in 
Chapter 13 (Volume 2).)
Note that changing the delay does not alter the duration of the effect.

Paths

The term “path” refers to the specification of how interpolation is carried out 
from one keyframe to the next.

For details of the path setting procedure, see “Path Settings” in Chapter 13 
(Volume 2).

Switcher path settings
Carry out path settings in the Key Frame menu.
For each menu, the following settings are available.

M/E-1 and P/P menus

Item Paths that can be set

M/E1, P/P All For each M/E and PGM/PST, path settings for 
the following items are made simultaneously.

Key1 to Key4 Overall path settings for items relating to keys 
1 to 4 are made simultaneously.

Key 1 All to Key 4 All

Source Key source path for keys 1 to 4

Fill Key fill path for keys 1 to 4

Proc Proc path for keys 1 to 4

Trans Transition path for keys 1 to 4

Bkgd/Util Overall path settings for items relating to 
backgrounds and utility buses are made 
simultaneously.Bkgd/Util All

Bkgd A Path for background A

Bkgd B Path for background B

Util 1 Path for utility 1

Util 2 Path for utility 2
121Keyframes



   C
hapter 1 

M
V

S
-8000 F

unctions

122
User1 to User8 menus
The items that can be adjusted depend on the settings in the Setup menu.

For details, see “Overall Control Panel Settings (Config Menu)” in Chapter 
16 (Volume 2).

Wipe/DME Wipe Overall path settings for items relating to wipes 
and DME wipes are made simultaneously.

Wipe Wipe/DME
Wipe All

Wipe Path for wipes

DME Wipe Path for DME wipes

Trans – Transition path for each M/E and P/P bank

Item Paths that can be set

User1 All to User8 All Overall path settings for the following items for 
each “User” are made simultaneously.

FM All Overall path settings for frame memory items 
are made simultaneously.

FM Src Overall path settings for frame memory source 
items are made simultaneously.

FM Src All

FM Src1 Path for frame memory source 1 and video 
process

FM Src2 Path for frame memory source 2 and video 
process

FM Proc Overall path settings relating to the signal 
processing other than frame memory source 
and frame memory freeze outputs are made 
simultaneously.

FM Proc All

FM Proc1 Path for frame memory signal processing 1

FM Proc2 Path for frame memory signal processing 2

FM Still Store Overall path settings for frame memory freeze 
image output are made simultaneously.

FM Still Store All

FM Still Store 1 to 8 Paths for frame memory freeze image outputs 
1 to 8

Aux Overall path settings for Aux buses are made 
simultaneously.

Aux All

Aux 1 to 48 Paths for Aux 1 to 48

Mon Overall path settings for monitor buses are 
made simultaneously.

Mon All

Mon 1 to 8 Paths for monitor buses 1 to 8

Item Paths that can be set
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Paths relating to DME

DME 3D Trans Local menu

Color Bkgd Overall path settings for color backgrounds are 
made simultaneously.

Color Bkgd All

Color Bkgd 1/2 Paths for color backgrounds 1 and 2

Item Paths that can be set

Item Paths that can be set

3D Trans Local All Overall path settings for local channel three-
dimensional transform items are made 
simultaneously.

Loc Size Overall path settings for items relating to 
image size changes and movement are made 
simultaneously.Loc Size All

Size Path for image size

Post Loc X, Post Loc 
Y

Paths for movement in the x- and y-axes

Post Size Path for size

Loc XYZ Overall path settings for items relating to 
image movement are made simultaneously.

Loc XYZ All

Loc X, Loc Y, Loc Z Paths for the x-, y- and z-axes

Rot Overall path settings for items relating to 
image rotation are made simultaneously.

Rot All

Rot X, Rot Y, Rot Z Paths for the x-, y- and z-axes

Spin Overall path settings for items relating to spin 
are made simultaneously.

Spin All

Spin Src X, Spin Src 
Y, Spin Src Z

Paths for the x-, y- and z-axes

Spin X, Spin Y, Spin 
Z

Paths for the x-, y- and z-axes

Asp Overall path settings for items relating to 
aspect ratio are made simultaneously.

Asp All

Rate X, Rate Y Paths for the x- and y-axes

Skew Overall path settings for items relating to skew 
are made simultaneously.

Skew All

Skew X, Skew Y Paths for the x- and y-axes

Aspect Path for aspect ratio
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DME 3D Trans Global menu

Pers Overall path settings for items relating to 
perspective are made simultaneously.

Pers All

Pers X, Pers Y, Pers Z Paths for the x-, y- and z-axes

Axis Loc Overall path settings for items relating to 
image rotation axis are made simultaneously.

Axis All

Axis X, Axis Y, Axis Z Paths for the x-, y- and z-axes

Item Paths that can be set

3D Trans Global All Overall path settings for three-dimensional 
transform items in the global channel are made 
simultaneously.

Loc Size Overall path settings for items relating to 
image size changes and movement are made 
simultaneously.Loc Size All

Size Path for image size

Post Loc X, Post Loc 
Y

Paths for movement in the x- and y-axes

Post Size Path for size

Loc XYZ Overall path settings for items relating to 
image movement are made simultaneously.

Loc XYZ All

Loc X, Loc Y, Loc Z Paths for the x-, y- and z-axes

Rot Overall path settings for items relating to 
image rotation are made simultaneously.

Rot All

Rot X, Rot Y, Rot Z Paths for the x-, y- and z-axes

Spin Overall path settings for items relating to spin 
are made simultaneously.

Spin All

Spin Src X, Spin Src 
Y, Spin Src Z

Paths for the x-, y- and z-axes

Spin X, Spin Y, Spin 
Z

Paths for the x-, y- and z-axes

Pers Overall path settings for items relating to 
perspective are made simultaneously.

Pers All

Pers X, Pers Y, Pers Z Paths for the x-, y- and z-axes

Axis Loc Overall path settings for items relating to 
image rotation axis are made simultaneously.

Axis All

Axis X, Axis Y, Axis Z Paths for the x-, y- and z-axes

Item Paths that can be set
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DME Effect menu

DME Global Effect menu

Types of path

Path types for Curve
There are five types, as follows.

OFF: Executing the effect causes no change.

Item Paths that can be set

Effect All Overall path settings for DME effect items are 
made simultaneously.

Edge Overall path settings for edge items are made 
simultaneously.

Edge All

Border Path for border

Crop/Edge Soft Path for crop/edge softness

Video Modify Overall path settings for video modify items are 
made simultaneously.

Video Modify All

Defocus/Blur Path for defocus/blur

Multi Move Path for “multi-move”

Color Modify Path for color modify

Mosaic Path for mosaic

Freeze Path relating to freeze

Non-Linear Path relating to nonlinear effects

Light Path relating to lighting

Trail Path relating to trails

In/Out Overall path settings for items relating to input/
output are made simultaneously.

In/Out All

Bkgd Path for background

Video/Key Path for video/key

Item Paths that can be set

Global Effect All Overall path settings for DME global effect 
items are made simultaneously.

Combine Path relating to combiner

Shadow Path relating to shadow

Brick Path relating to brick
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Step: There is no interpolation between keyframes, so that the effect 
parameters are updated each time a keyframe is passed.

Linear: Linear interpolation between keyframes, resulting in constant 
speed movement.

S-Curve: The rate of change accelerates and decelerates before and 
after a keyframe, so that the rate of change is maximum midway 
between two keyframes.

Spline: The effect follows a smooth curved path from each keyframe to 
the next.

Path types for Hue
There are four types, as follows.

CW: The hue changes in a clockwise direction as seen on a 
Vectorscope.

CCW: The hue changes in a counterclockwise direction as seen on a 
Vectorscope.

Short: The hue changes in whichever of the clockwise and 
counterclockwise directions is shorter.

Long: The hue changes in whichever of the clockwise and 
counterclockwise directions is longer.

Path types for Xpt
There are two types, as follows.

Xpt Hold off: When replaying a keyframe, change the inputs to the 
settings saved in memory.

Xpt Hold on: When replaying a keyframe, do not change the inputs.

Effect Execution

By pressing the [RUN] button in the keyframe control block, you can replay 
the effect as a continuous sequence of images. This is referred to as effect 
execution.
It is also possible to execute effects from the device control block (see page 
169). 

Range of execution
Each time the [RUN] button is pressed, the range of execution of the effect is 
from timecode 01:00:00:00 or the current time (the position at which the 
current effect is stopped) to the end point of the effect. However, if there is a 
pause set on a keyframe, the execution range is up to that point. Pressing the 
[RUN] button again resumes the effect, which then runs to the next pause point 
or the end of the effect.
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Run mode setting
You can select from the following run modes for when the effect is executed.
DIRECTION: Specify the effect execution direction.
STOP NEXT KF: Run the effect, and stop at the next keyframe.
EFFECT LOOP: Repeat the effect in an endless loop.
Make these settings in the keyframe control block. (See “Run Mode Setting” 
in Chapter 13 (Volume 2).)

Master Timelines

You can save the regions selected for a keyframe effect and the register 
numbers saved in the regions in a master timeline register so that operation can 
be applied to two or more regions at a time.
Master timeline registers can be saved or recalled from the numeric keypad 
control block or using a menu operation. (See “Creating and Saving a Master 
Timeline” in Chapter 13 (Volume 2).)
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Snapshots

The term “snapshot” refers to a function whereby the various settings required 
to apply a particular effect to an image are saved in memory as a set of data, for 
recall as required, to recover the original state.
You can carry out snapshot operations using the numeric keypad control block 
or the Snapshot menu.

For details of snapshot operations, see Chapter 14 “Snapshots” (Volume 2).

Snapshot Types

Snapshots are divided as follows.

Snapshots applying to a particular region (functional block of the 
switcher or DME)
The term “snapshot” alone usually refers to this type of snapshot.
Master snapshot: This applies to the selected regions and the register numbers 

saved in the regions. A master snapshot can be saved and recalled using the 
numeric keypad control block.

Snapshots applying only to particular functions
This type of snapshot includes the following.
Key snapshot: This includes the key on/off state and all key settings other than 

key priority for each keyer. (See “Key Snapshots” (page 47).)
To use this function requires the MKS-8032 DSK Fader Module.

The rest of this section describes the snapshots that apply to a particular region 
or regions.

Snapshot Attributes

An individual snapshot may also have attached special conditions relating to 
switcher or DME operation when the snapshot is recalled.
These conditions are called “attributes” of the snapshot, and can be added when 
the snapshot is saved or recalled.
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Types of attribute

There are five snapshot attributes, as follows.
Cross-point hold: When the snapshot is recalled, the cross-point button 

selection remains unchanged. This can be set independently for each bus.
Key disable: When the snapshot is recalled, the key settings remain 

unchanged. This can be set independently for each keyer.
Effect dissolve: The transition from the state before the snapshot recall to the 

snapshot settings is carried out smoothly, by a dissolve. The dissolve 
duration can be set in the Snapshot menu.

Auto transition: An auto transition starts the instant the snapshot is recalled. 
The auto transition setting is valid only for M/E-1, M/E-2, M/E-3, and 
PGM/PST.

Note
If both effect dissolve and auto transition are selected as attributes, the auto 
transition takes precedence.

GPI output: A GPI output is sent to the allocated GPI port the instant the 
snapshot is recalled.
The trigger type depends on the switcher GPI output settings made in the 
Setup menu.

For details, see “Interfacing With External Devices (Device Interface 
Menu)” under “Setup Relating to Switcher Processor” in Chapter 16 
(Volume 2).

Table of available attributes
The attributes that can be used depend on the region, as follows.

a) Applicable only as temporary attributes, but not applicable by a menu operation.
b) Applicable only by a menu operation.

Yes: Can be used   No: Cannot be used

Attribute Region

M/E-1 and PGM/PST USER 1 to USER 8 DME 1 to DME 4

Cross-point hold Yes Yes Yes

Key disable a) Yes No No

Effect dissolve Yes Yes Yes

Auto transition Yes No No

GPI outputs b) Yes Yes No
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Attribute display
You can view the attributes of a snapshot in the Snapshot menu.

For more details, see “Snapshot Operations in the Menus” in Chapter 14 
(Volume 2).

Temporary attributes
When recalling a snapshot, you can temporarily apply attributes distinct from 
the attributes set for each register. These are called “temporary attributes.”
You can set temporary attributes when recalling a snapshot.

For details of snapshot operations, see Chapter 14 “Snapshots” (Volume 2).

Bus override
If you recall a snapshot while holding down an A or B bus button, the selection 
of the signal on the A or B bus does not change when the snapshot is recalled. 
This function is called “bus override.”
This function is effective when cross-point hold is off, and you want to 
temporarily maintain the cross-point setting. When cross-point hold is on, the 
above operation is not necessary.
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The utility function refers to a function whereby you can assign an arbitrary 
action or a shortcut for frequently used menu to a particular button, then 
instantly recall the action or menu by pressing the button.
The functions you can assign include menu shortcuts, enabling/disabling 
functions (recalling utility commands), and recalling (shotbox registers).
Carry out the button assignment in the Setup menu.

For details of the operation, see “Setting Button Assignments (Prefs/Utility 
Menu)” in Chapter 16 (Volume 2).

You can carry out the utility function in the utility/shotbox control block (see 
page 173) or using the user preference buttons in the menu control block (see 
page 163).
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Shotbox

The term “shotbox” refers to a function whereby for each specified region any 
snapshot or keyframe effect can be recalled simultaneously.
The simultaneous recall setting data such as region names, snapshot numbers 
and keyframe effect numbers are stored in “registers.” There are 99 registers 
for each control panel.

The figure above shows schematically the settings in the 99 shotbox registers.
Each register may contain any combination of the regions to which the register 
applies, with the snapshots or effects to be recalled.
The Auto Run function is an attribute which can be set for each register. When 
this is set to On, an effect recalled by a shotbox operation is automatically run.
• When register 1 is executed, this recalls M/E-1 snapshot 1, User2 effect 5, 

and DME3 effect 1. For register 1, auto run is on, and therefore the User2 and 
DME3 effects are run as soon as they have been recalled.

• When register 3 is executed, M/E-1 effect 1, P/P effect 90, and User1 effect 
1 are recalled. For register 3, auto run is off, and therefore to run the recalled 
effects, press the [RUN] button in the keyframe control block.

Shotbox settings and execution
Carry out shotbox register settings from the Shotbox menu or using the 
numeric keypad control block.
You can carry out shotbox execution using the numeric keypad control block 
or the utility/shotbox control block.

For details of operation, see Chapter 15 “Shotbox” (Volume 2).

Register #1

M/E-1: Snapshot #1
User2: Effect #5
DME3: Effect #1

Auto Run: On

Register #2

M/E-1: Snapshot #1
DME1: Snapshot #15
GPI: Effect #1

Auto Run: off

Register #3

M/E-1: Effect #1
P/P: Effect #90
User1: Effect #1

Auto Run: Off

Register #99

P/P: Effect #2
DME1: Snapshot #1

Auto Run: On

Shotbox registers
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Overview of Setup

Various settings are required, in order to operate the switcher, control panel, 
DME, external devices, and so on, connected together in a single system.
This is referred to as “setup,” and you can carry out the setup operations from 
the Engineering Setup menu.

For details of the operations, see Chapter 16 “Engineering Setup” (Volume 2).

The settings in the Engineering Setup menu are grouped under the following 
headings.
• System setup (System): Settings relating to the whole system (see the 

following section “System Setup.”)
• Panel setup (Panel): Settings particular to the control panel (see page 138)
• Switcher setup (Switcher): Settings particular to the switcher processor 

(see page 140)
• DME setup (DME): Settings particular to the DME processor (see page 

143)
• DCU setup (DCU): DCU input and output settings (see page 143)
• Router/tally setup (Router/Tally): Router interface and tally settings (see 

page 144)

System Setup

The system setup settings apply to the whole system. Here the “whole system” 
refers to all devices connected on the Control LAN.
The DCU is connected through the control panel, but is also included in the 
“whole system.”
You can make the following settings.

Network configuration (Network Config)
This provides automatic configuration of all devices connected to the Data 
LAN (excluding the DCU), and displays a list of them.

System configuration (System Config)
Specify the overall system operation mode and the hierarchical relationship of 
the devices.
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Operation mode setting
• Single Proc mode: The control panel controls a switcher and a DME.
• Dual Simul mode: The control panel controls two switchers and DMEs 

simultaneously.

Device hierarchical relationship setting
• Panel Assign: Specify the switcher controlled by a control panel.
• Switcher Assign: Specify the DME connected to a switcher.

Signal format settings (Format)
Make the following settings.

Signal format
Specify the signal format to be handled by the devices.
The combinations of signal formats that can be selected are as follows.

Screen aspect ratio
Switch the screen aspect ratio to 4:3 or 16:9.

Changing the input reference signal in an HD system
This changes the input reference signal.
• Tri Sync: tri-level sync for an HD system
• BB (Black Burst): black burst or sync for an SD system
The following table shows the relation between signal format and the 
frequency of a signal that can be used as the input reference signal.

System Field frequency Effective number of scan lines

HD system 50 1080i

59.94

60

23.976 1080PsF

24

25

29.97

30

SD system 59.94 480i

50 576i

Signal format Input reference signal

Tri Sync Black burst

1080PsF/29.97, 
1080i/59.94

59.94 Black Burst 59.94 Sync 59.94

1080PsF/25, 1080i/50 50 Black Burst 50 Sync 50
Setup



  C
hapter 1 

M
V

S
-8000 F

unctions
a) Interlock mode

Selecting the start up state (Start Up)
Set the initial state of the devices when the system is powered on.
For each device, you can select Resume mode or Custom mode.

Resume mode
This resumes the setting state at the previous power-off operation. This setting 
is only available for the switcher processor and panel.

Custom mode
This uses the settings saved in non-volatile memory or ROM within the device. 
In this mode, there are Setup and Initial Status settings which can be set 
separately.
• Setup mode: Select the setup state to be used after powering on from the 

following.
User: Start up using the user data previously saved with [Setup Define].
Factory: Start up with the factory default settings.

• Initial status mode: Select the state of each device after powering on 
(excluding the settings to which “setup” applies).

User: Start up using the user data previously saved with [Initial Status 
Define]. This does not apply to the control panel.

Factory: Start up with the factory default settings.

For details of saving and recalling setup data, see “Saving and Recalling Setup 
Data” (page 137).

System reset and memory initialization (Initialize)
• Reset: Reset to state after powering on.
• All Clear: Clear the memory, and carry out initialization. The Network 

Config, System Config, Format, and Start Up setup values are set by 
reference to data stored in non-volatile memory, and the system 
automatically starts up. It is not necessary to reset the Date/Time settings.

For more details, see “Saving and Recalling Setup Data” (page 137).

1080PsF/23.976 47.952 Black Burst 59.94 a) Sync 59.94 a)

1080PsF/30, 1080i/60 60 −

1080PsF/24 48 −

Signal format Input reference signal

Tri Sync Black burst
135Setup



   C
hapter 1 

M
V

S
-8000 F

unctions

136
Installation (Install)
This installs the software and firmware in all devices (including the DCU) 
connected to the Data LAN.
Standard Install mode: Installs the standard configuration.
There are also the following functions.
Detail Information: Gives details of the software and firmware installed in 

each device.

Device management (Maintenance)
• Date and time setting
• Formatting a memory card
• Primary settings for USB external storage device
• Reloading a USB driver
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Saving and Recalling Setup Data

Concept of saving and recalling setup data

Updating the switcher or control panel setup data saves the updated setup data 
in RAM in each device.
• In Resume mode (see page 135), even if devices are reset or powered off, the 

data is preserved in RAM, and recalled when the power is turned back on.

Note
The Resume mode cannot be used for DMEs and DCUs.

• In Custom mode (see page 135), the user-defined settings (user setup data) 
saved in non-volatile memory or factory default setup data held in ROM in 
each device is recalled when a reset is made or the power is turned back on. 
(See “Selecting the start up state (Start Up)” (page 135).)

 Hard disk / memory card
User setup data

Load Save

File menu: 
[Load]

File menu: 
[Save]

Current setup data
(If in Resume mode, settings data is saved.)

Store
In Custom mode, power on 
or reset

Initialize

User setup data Factory default setup data

Setup menu:
[Setup Define]

Setup 
menu:
[All Clear]

 RAM

 ROM Non-volatile memory
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Note that the setup data in RAM can also be saved to the control panel hard disk 
or memory card.

Panel Setup

In panel setup, you carry out settings particular to the control panel.
You can make the following settings.

For details of the operations, see “Setup Relating to Operations From the 
Control Panel” in Chapter 16 (Volume 2).

Panel settings (Config)
• M/E Assign: Set the logical configuration of the M/E and P/P banks.
• M/E Operation: For each of the M/E and P/P banks, make operations 

possible, not possible, or disabled (Enable/Disable/Inhibit).
• DSK Fader Assign: Carry out fader function assignment and key delegation 

for the key delegation buttons, in each of the maximum of four downstream 
key control blocks.

• External Bus Link: Make link settings relating internal switcher buses to 
routing switcher destinations.

• Key Trans Link: Select whether or not to link transitions between keyers, 
and if so which keyer to link to. You can set the links between keyers for each 
M/E bank separately.

• Reference Module: When a trackball module and a joystick module are both 
connected as device control blocks, select which is used as the reference.

• 10 Key Region Assign: Assign any regions to the region selection buttons 
in the numeric keypad control block.

Cross-point button settings (Xpt Assign)
• Multi Xpt Assign: For each operating bank or bus, assign a main table and 

“sub” tables 1 to 4.
• Xpt Assign: Carry out main table settings.

– Assign video/key sources for button numbers 1 to 128.
– Set source names of up to 16 characters.
– Set the LCD color for source name display.
– For each cross-point table, specify whether the rightmost cross-point 

button in each row is used as a shift button, and the operation mode when 
it is used as a shift button.

• Sub Table Assign: For sub tables 1 to 4, set rearrangements of the button 
layout set in the main table. Also set the shift button mode.

• Shift Mode: For the [SHIFT] button in the cross-point control block, select 
the mode in which this is a shift button dedicated to the source display 
section, or the mode in which it is a shift button for all buses.
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• Name Export: This function sends the source name and destination name to 

the S-BUS.

AUX bus settings (Aux Assign)
• Aux Assign: Assign the AUX delegation buttons in the auxiliary bus control 

block to any bus.
• Shift Mode: Specify whether the rightmost button of the AUX delegation 

buttons is used as a shift button, and when it is used as a shift button, the 
operation mode.

Button assignment settings (Prefs/Utility)
Assign the [PREFS 1] to [PREFS 8] buttons in the menu control block, and the 
utility/shotbox control block buttons.
• User Preference: Make the settings for the user preference buttons in the 

menu control block. This assigns recalling frequently used menus (menu 
shortcuts), enabling/disabling functions (recalling utility commands) and 
recalling shotbox registers.

• Utility Module Assign: Make the utility/shotbox control block settings. This 
assigns recalling frequently used menus (menu shortcuts), enabling/
disabling functions (recalling utility commands) and recalling shotbox 
registers.

External device connections (Device Interface)
• GPI Input: Set the GPI input ports and trigger type, and make the action 

settings.
• GPI Output: Set the GPI output ports and trigger type, and make the action 

settings.
• P-BUS Control: Set the control mode for P-BUS devices.

Operation settings (Operation)
• Button Tally: Set whether or not the system tally generation results are 

reflected in the panel tally.
• Trans Rate Display: Select whether the transition rate display mode is in 

frames or timecode units.
• Effect: For keyframe effects, you can make the following settings. (See 

Chapter 13 “Keyframe Effects” (Volume 2).)
– Recall mode
– Automatically turning off the [EDIT ENBL] button when an effect is 

recalled
– Automatic insertion of a first keyframe when an empty register is 

recalled
– Effect Auto Save
– Default KF Duration
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– Setting whether or not to replay the first keyframe after rewinding a GPI/
P-BUS effect

• Source/Dest Name: For the Source/Dest (source/destination) names used by 
the system, select one of the following:

– Source name set by cross-point assignment or fixed bus name
– Description name set on routing switcher
– “Type + No.” name set on routing switcher

• Name Display: Specify the number of characters for display of the names 
selected in Source/Dest Name above, as two characters, four characters, or 
Auto.

• Custom Button: Set the following button operation modes.
– [ALL] button for next transition selection
– [AUTO TRANS] or [TAKE] button during auto transition execution
– [RUN] button during keyframe execution
– Interchanging of the [AUTO TRANS] button and [CUT] button
– [TRANS PVW] button

• Sensitivity: Adjust trackball, joystick and double-click sensitivity.
• Main Split Fader: When the split fader is active, specify whether the fader 

to control other than mix is the left side or the right side.

Screen saver, brightness adjustments, and alarm (Maintenance)
• Screen Saver: Make the menu screen saver settings.
• LCD Brightness: Adjust the LCD brightness.
• LED Brightness: Adjust the LED brightness.
• Switch Brightness: Adjust the switch brightness.
• Touch Beep: Select whether or not to sound a beep when a menu operation 

is carried out.
• Touch Panel Calibration: Calibrate the touch panel.

Switcher Setup

In switcher setup, make settings particular to the switcher processor.
You can make the following settings.

Settings relating to overall switcher configuration (Config)
• System Phase: Adjust the switcher internal reference phase.
• Switch Timing: Specify the timing of video switching.
• M/E Config: Set the program configuration for the M/E and P/P outputs.

– Standard mode: Fix the maximum of four outputs (Out1 to 4) and 
program output configuration as follows.
Out1: Program output 
Out2: Preview output 
Out3: Clean output 
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Out4: Key preview output 
Program output: Clean output + key 1 + key 2 + key 3 + key 4

– Multi-program mode: Increase the number of M/E or P/P programs, 
and assign any of the following to the maximum of six outputs (Out1 to 
6).
Program outputs 1 to 4, preview output, key preview outputs 1 and 2, 
clean output.
Further, you can select the program background from Clean or Utility2, 
and change the combination of signals from which it is configured.
Again, you can set the key preview configuration to video mode or key 
mode. In key mode, select whether to link operation to the on/off state 
of the key, or have it always on.

– DSK mode: Treat P/P as four DSKs, with no background transitions. Of 
backgrounds 1 to 4, set one to configure the program output. The signals 
which can be selected as the background are limited to Out1 to 6 from 
M/E-1.

• K-PVW Config: Set the key preview configuration to either video mode or 
key mode. In key mode, select whether to link the key state to the on/off 
operation, or have it always on.

• User 1 to 8 Config: Assign the User regions, being color backgrounds 1 and 
2, AUX1 to 48, monitor 1 to 8, and frame memory 1 to 8, to any of USER1 
to USER8.

• Logical M/E Assign: Make settings for handling PGM/PST hardware 
logically as an M/E.

Input signal settings (Input)
• Input Phase Adjust: Carry out phase adjustment for each primary input.
• Through Mode: Set through mode for the input side. This applies only to 

the primary inputs, and can be set independently for each primary input.
• Video Process: Switch video processing on or off for each input signal, and 

adjust the brightness, hue and so forth.
• Matte Illeg. Color Limit: Switch the illegal limiter on or off for the signal 

generated by the switcher internal matte generator.

Output signal settings (Output)
• Output Assign: Assign the signals output from the Output1 to 48 ports.
• Video Clip: Adjust the clip levels (White Clip, Dark Clip, and Chroma Clip) 

for the output signals from each of the Output1 to 48 ports.
• V Blank: Adjust the vertical blanking width for the output signals from each 

of the Output1 to 48 ports. The setting is the number of scan lines from the 
reference blanking position of field 1 for the particular format which should 
be masked.

• Through Mode: Enable or disable through mode. Through mode can be 
enabled for AUX1 to 48 outputs, M/E and PGM/PST program outputs, and 
clean output.
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• Safe Title: Enable or disable safe title, and carry out settings for box 1 and 2 
and cross.

• Ref. Output Phase: Set the reference output mode and phase adjustment.
• 4:3 Crop: Set the actual video image to be cropped to a 4:3 aspect ratio when 

an HD system has a screen aspect ratio of 4:3.

Settings relating to video switching (Transition)
• Transition Preview: Specify the operation mode for transition preview for 

each of the M/E and P/P banks.
• Key Transition: Specify the operation mode for independent key 

transitions.
• Bus Toggle: Switch the bus toggle for each of the M/E and P/P banks on or 

off.
• Preset Color Mix: Set the stroke mode for a preset color mix, the key status 

for a transition including a key, and the mode in which the transition type 
after a transition ends returns to the previous setting.

• Transition Curve: Set the relationship when carrying out a transition, 
between the fader lever position and the advancement state of the transition.

Key, wipe and frame memory settings (Key/Wipe/FM)
• Key Memory: Set the key memory operation mode for each of the M/E and 

P/P banks.
• Video Proc Memory: Enable or disable video process memory.
• Show Key: Enable or disable show key for edit preview, M/E and P/P Pvw/

K-Pvw.
• DSK Auto Drop: Specify a DSK to be turned off automatically when a 

cross-point button on the P/P program bus is pressed.
• Mask/Border Process: Set the processing order of masks and borders for 

each of the M/E and P/P banks.
• Key Priority: Set the key priority operation mode for each of the M/E and 

P/P banks. In DSK mode, the key priority is fixed.
• Xpt Hold mode: Set the operation mode for the cross-point hold button 

provided on the key bus for each of the M/E and P/P banks.
• Pattern Limit Transition: Set the operation mode when the pattern limit is 

released for each of the M/E and P/P banks.
• Wipe Edge Default: Adjust the wipe edge softness for each of the M/E and 

P/P banks.
• FM Auto Store: Switch on or off the function to automatically attach a name 

and save in frame memory.

Link settings (Link)
• Internal Bus Link: Make a setting of the bus link function that links 

together two buses internal to the switcher.
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• GPI Link: Make settings for linking any cross-point buttons or [CUT] and 

[AUTO TRANS] buttons in the cross-point control block and GPI output 
ports.

External device connections (Device Interface)
• Remote Assign: Set the use of the four 9-pin ports.
• GPI Input: Set the GPI input ports and trigger polarities, and make the 

action settings.
• GPI Output: Set the GPI output ports and trigger polarities, and make the 

action settings.
• Aux Control: Set whether operations on the Aux buses from the four 9-pin 

ports are inhibited.

DME Setup

In DME setup, carry out settings particular to the DME processor.
You can make the following settings.

Input signal settings (Input)
• Initial Crop: Make the initial crop setting.
• Matte Illeg. Color Limit: Switch the illegal limiter for the signal generated 

by the DME internal matte generator on or off.

Interface with external devices (Device Interface)
• Editor Protocol: Set the protocol to be used on the Editor port.
• GPI Input: Set the GPI input ports and trigger polarities, and make the 

action settings.
• GPI Output: Set the GPI output ports and trigger polarities, and make the 

action settings.

Setup Relating to DCU Input/Output

In DCU setup, carry out settings particular to the DCU.
You can make the following settings.
• Input Config: Assign GPI inputs to Parallel input ports.
• GPI Input Assign: Make GPI input settings.
• Output Config: Assign GPI outputs to parallel output ports inserted in an 

option slot.
• GPI Output Assign: Make GPI output settings.
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• Serial Port Assign: Set the protocol to match the devices connected to a 9-
pin serial port. You can also select the control panel used to control each 
device.

Setup Relating to the Router Interface and Tally 
Interface

Carry out settings relating to the interface with the routing switcher, and 
settings relating to the tally interface.
You can make the following settings.

Router interface setup (Router)
These settings are common to the parallel tally and serial tally.
• Matrix Size: Assign the switcher matrix of each switcher processor to S-Bus 

space, and select the matrix size and positioning level, source address 
settings, and so on.

• External Box: To obtain the signal selection status of external devices with 
a parallel input, assign a matrix as an external selector in the S-Bus space. 
Make the matrix size, assignment level, source address, and other settings.

Tally interface setup (Tally)

Group tally settings (Group Tally)
• Tally Group: Select the group tally (Gp1 to 4 or Gp5 to 8) which can be 

used.
• S-Bus Tally Enable: Specify S-Bus tally enabled or disabled.

Wiring information input (Wiring)
Input the information which specifies the physical wiring between switcher 
and routing switcher or between two routing switchers.
These settings are common to the parallel tally and serial tally.

Tally enable settings (Tally Enable)
Specify the destination to be the reference for tally generation, and make 
various settings.
These settings are common to the parallel tally and serial tally.
• Tally Type: Specify the tally type. The tally types which can be specified are 

as follows:
When Group Tally is Gp1 to 4: R1, R2, R3, R4, G1, G2, G3, G4
When Group Tally is Gp5 to 8: R5, R6, R7, R8, G5, G6, G7, G8

• Destination: Specify the address and level.
• Tally Enable: Specify the timing at which a tally is enabled.
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Enable: Always enabled.
Disable: Always disabled.
Tally Input No.: Follow the tally input status.

Copy (Tally Copy)
Copy the tally information pertaining to a particular source to a different 
source.
These settings are common to the parallel tally and serial tally.

Parallel port settings (Parallel Tally)
Make the parallel port settings for output of tally information pertaining to 
sources and destinations.
For each of the tally output terminal numbers, specify the tally type, and source 
address or destination level and address.

Serial tally settings (Serial Tally)
Make the serial tally settings, including tally type and source address for each 
serial tally port.

Simple Connection to MKS-8080/8082 AUX Bus Remote 
Panel (Option)

To connect the MKS-8080/8082 AUX Bus Remote Panel to a CCP-9000 
Center Control Panel using an S-BUS data link requires a BKPF-R70A 
Routing Switcher Controller Board or similar primary station and various 
settings for connection.
However, using a simple connection, the need for an S-BUS data link primary 
station is avoided, and direct connection to the MKS-8080/8082 is possible.
A simple connection is possible if the following conditions are met:

• There are no devices other than the CCP-9000 and MKS-8080/8082 
connected on the S-BUS data link.

• There are no more than 16 MKS-8080/8082 units connected on the S-BUS 
data link.

For details of the connection procedure, see “Procedure for Simple 
Connection” in Chapter 16 (Volume 2).
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Files

You can save register data, including setup information and snapshot 
information, as a file on a hard disk or memory card, and recall it as required.
You can operate on individual files or registers, or together in a batch.
Regarding frame memory, it is possible to capture image data stored in an 
external device into frame memory. You can also convert the format of image 
data in frame memory into a different format and save it in an external device.

Files that can be manipulated
The following files can be saved and recalled.
• Operation mode setup data for system as a whole and individual devices
• Device status data for system startup
• Key memory setting data
• Video process memory setting data
• Keyframe effect setting data
• Snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Frame memory image data

File operations
You can carry out the following file operations.

When operating on individual files or registers
Save: Save the data in a register to the hard disk or memory card.
Load: Load a file from the hard disk or memory card.
Copy: Copy a file within a directory or from one directory to another. When a 

remote panel is used, this function applies to it, too.
Rename: Rename a file on the hard disk or memory card.
Delete: Delete a file from the hard disk or memory card.

When operating on files or registers in a batch
Only the above Save, Load and Delete operations are performable.

Importing or exporting files to or from frame memory
Import: Import a file in a different format from hard disk or memory card into 

frame memory after changing its format.
Export: Export a file in a register to hard disk or memory card after changing 

its format.
The supported file formats are TIF and BMP.
Files
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Names and Functions of Parts of the 
Control Panel

Example Control Panel Configuration

Example control panel configuration

Key control block (page 165)

Keyframe control block (page 156)

Device control block (joystick)(page 154)

Menu control block (page 163)

Transition control block (page 151)

Utility/Shotbox control 
block (page 173)

Numeric keypad control block (page 159)

Auxiliary bus control block (page 161)

M/E-1 bank

PGM/PST bank

Cross-point control block (page 149)

Memory card/USB adaptor block (page 164)

Device control block 
(trackball)(page 169)

Up to three units 
connectable

Downstream key control 
block (page 174)
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Cross-Point Control Block

In the cross-point control block, you can 
select the signals to be used in this M/E 
bank or PGM/PST bank.

a Cross-point buttons
These buttons select the signals used for 
video creation on this M/E bank or PGM/
PST bank. Each row of buttons corresponds 
to one or more signal buses within the 
switcher.
Key row: The buttons in this row select the 

bus signals specified with the key row 
delegation buttons ([DSK1] to [DSK4], 
[DME1] to [DME4], [UTIL1], or 
[UTIL2]) or delegation buttons in the 
auxiliary bus control block.
The later pressed delegation button 

takes precedence and the selection is 
reflected in the key row.

Background A row: Press the desired 
button to select the signal as the current 
background video on this M/E bank or 
PGM/PST bank.

Background B row: Press the desired 
button to select the signal as the 
background after the next transition on 
this M/E bank or PGM/PST bank.

SHIFTUTIL2UTIL1DME4DME3DME2DME1DSK4DSK3DSK2DSK1
XPT

HOLD

1 Cross-point buttons

2 Source name displays

3 Key row delegation buttons

4 XPT HOLD button

5 SHIFT button

Key row

Background A row

Background B row
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Cross-point button numbers
The 12 buttons are numbered 1, 2, ... 11, 12. 
While the [SHIFT] button is held down, 
these switch to numbers 13 to 24, or 
alternatively, every time the button is 
pressed, switching is made between 
numbers 1 to 12 and 13 to 24. 
When the 12th button is used as a [SHIFT] 
button, switch is made between numbers 1 
to 11 and 12 to 22.
Both the assignment of the 12th button to a 
[SHIFT] button and the selection of the 
button operation mode can be done in a 
Setup menu.

Assigning signals to button
You can assign a signal to each button using 
the Setup menu.
This assignment is common to the cross-
point buttons in the M/E-1 and PGM/PST 
banks, and the auxiliary bus control block. 
According to the settings made in the menu, 
the video and key signals are assigned to the 
cross-point buttons in pairs.
You can also make separate signal 
assignments for each operating control 
block.

Visual indications on cross-point 
buttons
The currently selected button in a row (i.e. 
the last button pressed) lights amber or red.
Amber (“low tally”): The signal selected 

on the bus does not form part of the 
program output from the switcher.

Red (“high tally”): The signal selected on 
the bus forms part of the program 
output from the switcher.

b Source name displays
These show the names of the signals which 
can be selected on the cross-point buttons, 
in two or four characters, or in auto mode.
While the [SHIFT] button or the [SHIFT] 
button assigned to the column of cross-

point buttons is enabled, the source name of 
the signal assigned to the column of cross-
point buttons in shift mode appears. You 
can select green, orange, or yellow for the 
background color of the source name 
display, for each source separately. You can 
set the source name display mode and 
background color in a Setup menu.

c Key row delegation buttons
Use these buttons to assign buses to the key 
row, copy keys, or assign DME to keys.

d XPT (cross-point) HOLD button
Turning this button on enables you to recall 
a keyframe or snapshot while keeping the 
current cross-point selection unchanged. 
This function is valid for the background A 
and B rows.

e SHIFT button
When this button is enabled, either the 
source name displays show the shifted 
signal names, or the shifted signals for all 
buses in this M/E (P/P) bank are enabled. 
You can select either mode in a Setup 
menu.
Each press of the button toggles between 
the enabled and disabled states.
Using a Setup menu operation, you can also 
make this button function as the [SHIFT] 
button for the whole cross-point control 
block inclusive of the key row and 
background A and B rows.
Names and Functions of Parts of the Control Panel
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Transition Control Block

In the transition control block, you can 
modify the output of the M/E bank or PGM/
PST bank, and perform transitions. Both 

common transition and independent key 
transition operations are possible.

a Next transition selection buttons
Press these buttons, turning them on, to 
determine what the next transition will 
apply to.
BKGD: Next transition changes the 

background.

KEY1 to KEY4 (DSK1 to DSK4 in the 
PGM/PST bank): Press this button, 
turning it on, to make the next 
transition insert or remove the 
corresponding key (keys 1 to 4). If a 

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

DSK1
TRANS

DSK2
TRANS

DSK3
TRANS

DSK4
TRANS

8 PRIOR SET button

1 Next transition selection buttons

7 Key status display

2 Transition type selection buttons

9 KF button

6 Pattern limit buttons

5 TRANS PVW button

3 Transition execution section

4 Wipe direction selection buttons

0 Independent key/downstream 
key transition execution section
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key is currently inserted it will be 
removed, and vice versa.
In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 4.

KEY PRIOR (priority): When this button 
is lit, the setting of the key priority after 
the next transition is enabled. The key 
priority after the next transition appears 
in the key status display.

ALL: Pressing this button turns on a 
preselected set of the [BKGD], [KEY1] 
to [KEY4], and [KEY PRIOR] buttons.
Make this setting in a Setup menu.

b Transition type selection buttons
Press one of these buttons, turning it on, to 
determine the type of the next transition.
When Multi Program mode is selected in 
setup (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
16 (Volume 2)), more than one of these 
buttons may light.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.
In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 
transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 
100% to zero in the second half while 
the new video is maintained at 100%.

SUPER MIX: The current video is 
maintained at 100% output for the first 
half of the transition as the new video is 
mixed while increasing progressively 
to 100%. The current video is then 
progressively reduced from 100% to 

zero in the second half while the new 
video is maintained at 100%.

PST (preset) COLOR MIX: In the first 
transition, the current video is replaced 
by the color matte in a mix (dissolve), 
then in the second transition the color 
matte is replaced by the new video also 
in a mix (dissolve).

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: A wipe type of transition is carried 
out, using the DME effect selected in 
the DME Wipe menu.

c Transition execution section
Transition indicator: This comprises 30 

LEDs, which show the progress of the 
transition.

Fader lever: Move this to carry out a 
manual transition.

Transition rate display: This shows the 
“transition rate” (the time from the 
beginning of a transition to its 
completion) set for an auto transition, 
in frames.
You can set the transition rate using the 
numeric keypad control block or menu.

AUTO TRANS (transition) button: 
Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

CUT button: Pressing this button carries 
out the transition as a cut (i.e. 
instantaneously).

d Wipe direction selection buttons
When you have selected a wipe or DME 
wipe as the transition type, press one of 
these buttons, turning it on, to select the 
wipe direction.
NORM (normal): The wipe proceeds in 

the direction from black to white as 
Names and Functions of Parts of the Control Panel
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shown on the pattern in the lists of 
patterns (see the appendixes “Wipe 
Pattern List” and “DME Wipe Pattern 
List” (Volume 2)), or in the direction of 
the arrow.

REV (reverse): The wipe proceeds in the 
opposite direction to that when the 
[NORM] button is pressed.

NORM/REV (normal/reverse): The wipe 
direction alternates between normal 
and reverse every time a transition is 
executed.

e TRANS PVW (transition preview) 
button

When this button is lit, you can check in 
advance the video changes during the 
transition, on the preview output from the 
M/E or PGM/PST bank.
During the preview, you can use the fader 
lever, [AUTO TRANS] button, and [CUT] 
button. One of the following functions of 
this button can be selected in a Setup mode.
• When the transition completes, the 

system returns to the normal mode.
• The transition preview mode is 

maintained while this button is pressed.
• Switching is made between the transition 

preview mode and normal mode every 
time this button is pressed.

f Pattern limit buttons
LIMIT SET: Use this button to set a 

pattern limit when the [PTN LIMIT] 
button is off.
Move the fader lever to the position of 
a particular pattern size, and stop it 
there, then press this button to set the 
pattern limit range.

PTN (pattern) LIMIT: Pressing this 
button, turning it on, enables the 
pattern limit function.

g Key status display
For each of keys 1 to 4, the corresponding 
ON indicator lights when the key is 

inserted. It also shows the priority (1 to 4) 
of each key.

h PRIOR (priority) SET button
While this button is held down, you can set 
the key priority.
The setting mode when this button is 
pressed depends on whether or not the 
[KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the 

current key priority is set.
• When the [KEY PRIOR] button is lit, the 

key priority after the next transition is set.
Press the [KEY PRIOR] button as required, 
to switch between these two modes.
In either mode, hold down the [PRIOR 
SET] button, and press the button ([KEY1] 
to [KEY4]) corresponding to the key you 
want to bring to the front.

i KF (keyframe) button

The following controls are used as the 
independent key transition control block.

j Independent key/downstream key 
transition execution section

KEY1 TRANS to KEY4 TRANS (DSK1 
TRANS to DSK4 TRANS in the 
PGM/PST bank) buttons: These 
correspond to keys 1 to 4 from top to 
bottom; press one to carry out an auto 
transition. The transition rate for an 
independent key transition can be set in 
the numeric keypad control block or in 
a menu.
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Device Control Block (Joystick)

The joystick type device control block is 
used for three-dimensional transform 
operations using a DME.

a Operating buttons
The functions of these buttons are 
equivalent to the functions in three-
dimensional transform operation mode of 
the operating buttons of the trackball type 
device control block.

Note
To select a required DME channel, use the 
region selection buttons in the numeric 
keypad control block.

Use of the SHIFT button
Pressing a button in the device control 
block while holding down the [SHIFT] 
button enables the shifted function of the 
button. Also, pressing a button in the 
keyframe control block while holding down 

the [SHIFT] button enables the shifted 
function of the button.

b Joystick
By moving this, you can carry out 
operations in the x-, y-, and z-axes.

When the effect run control mode is 
enabled
By moving the joystick sideways, you can 
run the keyframe effect, independent of the 
STOP NEXT KF, EFF LOOP, and similar 
settings in the keyframe control block. 
Move to the right to run the effect in the 
normal direction, and to the left for the 
reverse direction.

PAUSE

COPY

INS

RUN

MENU LOCAL GLB SRC TRGT

ROT

SHIFT

PASTEREV

MOD

ASP
SKEW
PERS

STOP
NEXT

KF

CLR
WORK
BUFR

DEL

X

DELAY

UNDO

LOC
XYZ

LOC
SIZE

AXIS
LOC

Y Z CTR

NEXT
KF

PREV
KF

GOTO
KF/TC

CONST
DUR

EFF
DUR

KF
DUR

EDIT
ENBL

FROM
TO

RUN
CTRL

KF
LOOP

EFF
LOOP

RE
WIND

NORM
/REV

1 Operating buttons 2 Joystick

3 MENU button
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c MENU button
The function of this button is equivalent to 
the function of the [MENU] button in the 
trackball type device control block.
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Keyframe Control Block

In the keyframe control block, you can 
carry out effect editing and execution.

a EDIT ENBL (edit enable) button
Press this button, turning it on, to enable 
effect editing operations with the keyframe 
control block.

b Edit point specification buttons
GO TO KF/TC (Go to keyframe/

timecode): Press this button, turning it 

on, to enter a numeric value from the 
numeric keypad control block, and 
move the edit point to the specified 
keyframe.
To move the edit point to the specified 
timecode position, hold down the 
[SHIFT] button in the device control 
block, then press this button, turning it 

PAUSE

COPY

INS

RUN

MENU LOCAL GLB SRC TRGT

ROT

SHIFT

PASTEREV

MOD

ASP
SKEW
PERS

STOP
NEXT

KF

CLR
WORK
BUFR

DEL

X

DELAY

UNDO

LOC
XYZ

LOC
SIZE

AXIS
LOC

Y Z CTR

NEXT
KF

PREV
KF

GOTO
KF/TC

CONST
DUR

EFF
DUR

KF
DUR

EDIT
ENBL

FROM
TO

RUN
CTRL

KF
LOOP

EFF
LOOP

RE
WIND

NORM
/REV

0 EFF LOOP button

1 EDIT ENBL button

2 Edit point specification buttons

3 Editing buttons

4 Duration setting buttons

5 KF LOOP button

6 PAUSE button

7 Effect execution section

8 Effect execution direction selection buttons

9 STOP NEXT KF button

qa RUN CTRL button
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on, and enter the desired numeric value 
from the numeric keypad control block.

PREV KF (previous keyframe): When 
this button is pressed, the edit point 
moves to the keyframe immediately 
before the current time (the position 
where the effect is currently stopped).

NEXT KF (next keyframe): When this 
button is pressed, the edit point moves 
to the keyframe immediately after the 
current time.

c Editing buttons
FROM TO: Press this button, turning it on, 

to enter numeric values from the 
numeric keypad control block, and 
select a specified range of keyframes.

INS (insert): When this button is pressed, a 
new keyframe is inserted after the 
current keyframe. Pressing this button 
while holding down the [SHIFT] 
button in the device control block 
inserts a new keyframe before the 
current keyframe.

MOD (modify): When this button is 
pressed, the selected keyframe is 
modified with the values of the current 
keyframe. When the edit point is 
between two keyframes, the 
immediately preceding keyframe is 
modified. You can also select multiple 
keyframes, and modify them in a single 
operation. At this time, pressing this 
button while holding down the 
[SHIFT] button in the device control 
block modifies all selected keyframes 
with the changed values taken as 
relative values.

DEL (delete): When this button is pressed, 
the selected keyframe is deleted. When 
the edit point is between two 
keyframes, the immediately preceding 
keyframe is deleted. You can also 
select multiple keyframes, and delete 
them in a single operation.

COPY: When this button is pressed, the 
selected keyframe is copied. You can 
also select multiple keyframes, and 
copy them in a single operation.

PASTE: When this button is pressed, the 
deleted or copied keyframe is inserted 
after the current keyframe. Pressing 
this button while holding down the 
[SHIFT] button in the device control 
block inserts the deleted or copied 
keyframe before the current keyframe.

UNDO: When this button is pressed, the 
last executed keyframe insertion, 
modification, or deletion, or paste 
operation is canceled.

d Duration setting buttons
KF DUR (keyframe duration): Press this 

button, turning it on, to set the 
keyframe duration of the selected 
keyframe, by numeric value entry from 
the numeric keypad control block.

EFF DUR (effect duration): Press this 
button, turning it on, to set the effect 
duration from the numeric keypad 
control block.

DELAY: Press this button, turning it on, to 
enter a delay value from the numeric 
keypad control block.

CONST DUR (constant duration): Select 
the duration mode. When this is lit, the 
mode is constant duration mode, and 
when off, variable duration mode.

e KF LOOP (keyframe loop) button
Press this button, turning it on, to execute 
the effect the specified number of times 
through the keyframes in the specified 
range.

f PAUSE button
When this button is pressed, a pause is 
applied to the selected keyframe.
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g Effect execution section
RUN: When this button is pressed, the 

effect is run from the first keyframe to 
the last keyframe. However, if a pause 
is set on a keyframe, the effect stops at 
that point. Press this button again to 
resume execution, and continue to the 
next pause point or the end of the 
effect.

REWIND: When this button is pressed, the 
currently recalled effect is rewound to 
the first keyframe.

h Effect execution direction selection 
buttons

REV (reverse): When this button is off, 
effect execution runs from the first 
keyframe to the last keyframe. When 
this button is lit, effect execution runs 
from the last keyframe to the first 
keyframe.

NORM/REV (normal/reverse): Press this 
button, turning it on, to reverse the 
direction of the effect when it reaches 
the last keyframe or first keyframe.

i STOP NEXT KF (stop next 
keyframe) button

When this button is pressed, turning it on, 
the effect execution range is from the 
current time to the next keyframe.

j EFF LOOP (effect loop) button
When the effect reaches the last keyframe 
with this button on, it returns to the first 
keyframe and repeats.

k RUN CTRL (run control) button
When this button is on, you can execute 
keyframe effects without being affected by 
the STOP NEXT KF or EFF LOOP settings 
in the keyframe control block.
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Numeric Keypad Control Block

The numeric keypad control block is used 
for region selection, for saving and 
recalling snapshots, effects, shotboxes, for 

entering numeric values for trackball 
operation and keyframe operation, and for 
transition rate entry.

a Mode selection buttons
EFF (effect): Press to save or recall effects.
SNAPSHOT: Press to save or recall 

snapshots.
SHOTBOX: Press to save or recall 

shotboxes.
MCRO (macro):
TRANS RATE (transition rate): Press to 

set the transition rate. Hold down this 
button, and press one of the key row 
delegation buttons [KEY1] to [KEY4] 
in the cross-point control block to set 
an independent key transition rate.

b Region selection buttons
These select the functional block (“region”) 
of the control panel to which operations 
apply.
You can select more than one region at the 
same time.
The first button you press is taken as the 
reference region, and lights green, 
while the next pressed button lights amber.
With the exception of the [MASTR] and 
[ALL] buttons, you can change the region 
assignment to the buttons as desired using a 
Setup menu.
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MASTR: Press this, turning it on, to save 
region information in a master snapshot 
register or master timeline register, or to 
recall such region information.
ALL: Select all regions. When any region 

is already selected, pressing this button 
makes all regions unselected.

M/E 1 and P/P: Select the corresponding 
regions, M/E-1 and PGM/PST.

USER 1 and USER 2: Select the 
corresponding USER regions.

DME1 to DME4: Select a DME channel.
P-BUS: Select the P-BUS region.
GPI: Select the GPI region.

c Function selection buttons
UNDO: After recalling a register, press this 

button to return to the state before 
recalling the register.

STORE STATS (store status): This lights 
amber when data is stored in a register. 
After saving data to a register, hold 
down this button and press the 
[UNDO] button to return the register to 
the state before the data was saved.

STORE: Press this button to switch to the 
mode for saving a snapshot, effect, or 
shotbox in a register.

RCALL (recall): Press this button to 
switch to the mode for recalling a 
snapshot, effect, or shotbox from a 
register.

d Numeric keypad
In addition to the buttons for numeric input, 
this includes buttons for adding attributes to 
snapshots.
0 to 9: Used to input numeric digits.
. (period): Enters the decimal point.

When the [TRANS RATE] button is lit, 
enters “00.” When the [EFF] button, 
[SNAPSHOT] button, or [SHOTBOX] 
button is lit, this is used to find an 
empty register.

+/–/ EFF DISS (effect dissolve): Invert the 
sign, negative or positive.

When the [SNAPSHOT] button is lit, 
applies the effect dissolve attribute to a 
snapshot.

CLR/AUTO TRANS (clear/auto 
transition): Clear an input value, 
returning to the previous state.
When the [SNAPSHOT] button is lit, 
applies the auto transition attribute to a 
snapshot.

TRIM/GPI ENBL (enable): After 
entering a difference value to be added 
to an existing setting, press this button 
to confirm the change.

ENTER: Confirm an entered value.

e Display
This shows the selected region name and 
entered numeric values.
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Auxiliary Bus Control Block

a AUX delegation buttons
Press one of these buttons, turning it on, to 
select the bus to assign to the key row of the 
bank selected with the bank selection 
buttons. These 10 buttons from left to right 
have ID numbers 1 to 10. When the 
[SHIFT] button is enabled, their ID 
numbers switch to 11 to 20. Pressing one of 
the buttons selects the bus assigned to the 
ID number. That is, you can select up to 20 
buses using these AUX delegation buttons 
in combination with the [SHIFT] button. 
The assignment of buses to the ID numbers 
can be done in a Setup menu.
When the MKS-9011 1M/E Control Panel 
is used, the buses that can be selected are as 
follows.
• AUX buses 1 to 48
• MONITOR 1 to MONITOR 8
• FMS 1 (frame memory source 1) and 

FMS 2 buses
• DME 1V to DME 4V buses

• DME 1K to DME 4K buses
• P/P UTILITY 1 and P/P UTILITY 2 

buses
• DSK 1 fill to DSK 4 fill buses
• DSK 1 source to DSK 4 source buses
• P/P external DME bus
• DME UTILITY1 and DME UTILITY2 

buses

When the MKS-9012 2M/E Control Panel 
is used, the following buses can also be 
selected in addition to the buses listed 
above.
• M/E-1 UTILITY 1 and M/E-1 UTILITY 

2 buses
• M/E-1 external DME bus
For each bank, the key row is shared 
between the auxiliary bus control block and 
cross-point control block. Priority is given 
to the control block in which the delegation 
button is last pressed.
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b Bank selection buttons
These select the bank for which the AUX 
delegation buttons are enabled.

c KEY button
While this button is held down, you can use 
the cross-point row of buttons to select key 
signals.

d SHIFT button
While this button is enabled, the AUX 
delegation buttons have the shifted ID 
numbers. In a Setup menu, you can select 
one of the following three modes for this 
button.
• The button takes effect while being held 

down.
• Every time the button is pressed, it 

toggles between the shifted and unshifted 
states for the AUX delegation buttons.

• The button does not take effect even 
when pressed.
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Menu Control Block

a Top menu selection buttons
These select the menu appearing in the 
menu display.

b Menu display
This shows the menu currently in use.

c Knobs
These adjust the parameter values 
appearing in the menu.

d User preference buttons
These recall the functions or menus 
assigned to them in the Setup menu. In the 
default setup, nothing is assigned to the 
[PREFS 1] to [PREFS 7] buttons.
PREFS 8 button: When this button is on, 

control of an editor from the Remote1 
port on the rear panel of the switcher is 
possible. However, even when it is off, 
control of the Edit PVW bus is always 
possible.
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Memory Card/USB Adaptor Block

a Memory card slot
This slot accepts a PCMCIA Type II 
compliant memory card. You can use it in 
software installation, and for saving and 
reading in data, such as snapshot, keyframe, 
effect, and setup data.

b DEVICE connectors
You can connect a device such as a mouse, 
keyboard, pen tablet, and so on, that is 
equipped with a USB interface to this 
connector.

For details on the devices that can be 
connected, consult your Sony 
representative.

c Memory card access indicator
This indicator lights when the memory card 
is accessed for reading or writing.

Note

When the indicator is lit, do not take out the 
memory card.

1 Memory card slot

2 DEVICE connector

3 Memory card access indicator
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Key Control Block (MKS-8035 Key Control Module, 
Option)

Each of the M/E and PGM/PST banks 
includes four keyers (for keys 1 to 4), and 
you can delegate this control block to any 

desired keyer. In this control block, you can 
adjust and modify keys.

a Delegation buttons
Key delegation: Press one of the [KEY1] 

to [KEY4] buttons to delegate the key 
control block to the corresponding 
keyer.

M/E delegation: Press one of the [M/E 1] 
to [M/E 3], and [P/P] buttons to select 
the bank (the M/E bank or PGM/PST 
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bank) to which the key control block is 
delegated.

Notes
• When the MKS-9011 1 M/E Control 

Panel is used, only the [P/P] is enabled. 
When the MKS-9012 2 M/E Control 
Panel is used, only the [M/E-1] and [P/P] 
are enabled.

• With the MKS-9011/9012, you cannot 
directly control DME5 to DME8.

TRANS: By pressing this button, you can 
check the DME channel used for DME 
wipes on the M/E or PGM/PST bank. 
Also, by pressing this button, then 
pressing one of the DME channel 
selection buttons, you can preset the 
DME channel to be used when a DME 
wipe is selected as the transition type 
for the next transition.
When presetting the DME channel for 
an independent key transition, hold 
down this button, then press one of the 
[KEY1] to [KEY4] buttons, turning the 
two buttons on, beforehand.

b Key type selection buttons
Press one of these buttons, turning it on, to 
select the desired key type.
Depending on the selected key type, 
various parameters are displayed, and you 
can set the values with the knobs.
LUM (luminance key): The background is 

cut out according to the luminance (Y) 
of the key source signal, and at the 
same time the key fill signal is cut out 
and then added to the background 
signal.

LIN (linear key): This is a type of 
luminance key with a reduced variation 
in gain and a higher adjustment 
precision.

CRK (chroma key): A particular hue 
(usually blue) in the key source signal 
is used to determine the hole to be cut 

in the background and filled with the 
key fill signal.

CVK (color vector key): The background 
is cut out with a key source created by 
adding the luminance and chrominance 
components of the key signal. If the 
saturation is high, this allows perfect 
keying even if the luminance level is 
low and the signal is not suitable for 
luminance keying.

PTN (wipe pattern key): A hole is cut in 
the background by a wipe pattern 
selected in the transition, and this is 
filled with the key fill signal.

c Key fill/key source selection buttons
AUTO SEL (selection): Use the signal 

selected on the key fill bus, and the 
paired key source signal. The setting of 
key fill and key source pairs is carried 
out in a Setup menu.

SPLIT: To use the signal selected on the 
key fill bus as key fill, and a signal 
separate from the signal assigned in a 
pair with key fill for key source, press 
this button, turning it on.

To use the signal selected on the key fill bus 
as key source (self keying), press the 
[AUTO SEL] button and [SPLIT] button at 
the same time, so that both are off.
MATTE FILL: To use a color matte from 

the internal generator as key fill, press 
this button, turning it on. You can 
adjust the color matte using the knobs.
When this button is off, the signal 
selected on the key fill bus is used as 
key fill.

d Key modifier buttons
To add an edge modifier to the key, press 
one of these buttons, turning it on.
Depending on the edge type selected, 
parameters appear in the displays, and you 
can set the values with the knobs.
KEY DROP: When drop border or shadow 

is selected, turning this button on 
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lowers the key fill and key source 
position by four or eight scan lines as 
set in the key menu.
To select 4H or 8H, use the Key menu.
When the selected edge type is 
“normal” and soft edge is selected or 
when border, outline, or emboss is 
selected, this button lights 
automatically.

BDR (border): Apply a border of a 
uniform thickness to the whole key.

DROP BDR (drop border): Apply a 
border to two sides of the key (for 
example, below and to the right, or 
below and to the left).

SHDW (shadow): Apply a shadow to two 
sides of the key (for example, below 
and to the right, or below and to the 
left).

OUTLINE: Use the outline of the key.
EMBOS (emboss): Apply an embossing 

effect to the periphery of the key.
• To select a “normal” as the edge type 

(that is, a plain edge), set all five of the 
above buttons off.

• When border, drop border, or shadow is 
selected, you can use a special color 
matte or a signal selected on the utility 1 
bus for the edge.

• When emboss is selected, you can use the 
dedicated color matte signal for the 
emboss function.

• When outline is selected, the signal 
selected on the key fill bus is used to fill 
the edge.

MAIN MASK: Press this button, turning it 
on, to enable the key mask using the 
main pattern. It also enables you to set 
the parameters with the knobs.

SUB MASK: Press this button, turning it 
on, to enable the key mask using the 
sub pattern. It also enables you to set 
the parameters with the knobs.

ZABTN (zabton): When this is pressed, 
turning it on, a translucent pattern is 
inserted behind the key. With the 

knobs, you can adjust the color, size, 
density, and softness parameters.

SOFT EDGE: Soften the edge of the key.

e MORE button
When there are more than four parameters, 
this button lights amber. When it is pressed, 
it changes from amber to green and the fifth 
and subsequent parameters are assigned to 
the knobs, allowing them to be adjusted.

f SHOW KEY button
While this button is held down, a key 
processed key source signal is output from 
the specified output port. You can make the 
output specification independently for each 
of edit preview and the preview of the M/E 
or PGM/PST bank in a Setup menu.

g Knobs
Turn the knobs to adjust the parameter 
values.

h Displays
Each display shows the initial letters of the 
parameter name and the parameter value 
(maximum three digits including a minus 
sign for a negative value).

i DME channel selection buttons
Press one of these buttons, turning it on, to 
delegate a DME channel to the keyer. The 
number of valid DME channel selection 
buttons depends on the number of channels 
installed in the DME processor.
A maximum of three consecutively 
numbered DME channels from DME 1 to 4 
can be assigned to one keyer. A DME 
channel assigned to a keyer cannot be 
selected on another keyer. However, using 
the override function it is possible to 
allocate a channel already allocated to 
another keyer to the currently selected 
keyer. Using the trace function, it is 
possible to check which keyer a DME 
channel is allocated to.
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j ON AIR indicators
These light red when the corresponding 
DME channels are included in the final 
program output.

k Output destination specification 
buttons

MON (monitor): Hold down this button 
and press the selection button for the 
DME channel you want to assign to the 
monitor output; you can then monitor 
the output signal on the DME monitor 
output.
While this button is held down, the 
DME channel selection buttons light as 
follows, allowing you to check the 
monitor assignment.
Lit amber: DME channel that can 

currently be monitored
Lit green: DME channel currently 

assigned to the monitor output
FM FEED (frame memory feed): When 

you press this button, it lights 
momentarily amber, then for the 
currently selected keyer, the key 
processed signals are selected for frame 
memory sources 1 and 2. If a DME is 
selected on the currently selected 
keyer, the key fill and key source 
signals to which a DME effect is 
applied are assigned to frame memory 
sources 1 and 2; otherwise the key fill 
and key source signals are assigned.
Carrying out a frame memory feed 
causes the [PROC KEY] button to light 
amber.

PROC KEY (processed key): When this 
button is on, the key fill/source signal 
subjected to key processing or signal 
subjected to a DME effect on the 
currently selected keyer can be selected 
as a reentry signal (PROC V or PROC 
K) for the M/E or PGM/PST bank, on 
the auxiliary bus or the like.

l OVERRIDE button
To select a DME channel already allocated 
to another keyer or transition to the 
currently selected keyer (or transition), hold 
down this button, and press the DME 
channel selection button.

m TRACE button
When a DME channel is already allocated 
to another keyer or transition, hold down 
this button, and press the corresponding 
DME channel selection button, to switch to 
the state in which the keyer (or transition) to 
which the DME channel is allocated is 
currently selected.

n AUTO DELEG (auto delegation) 
button

When this button is on, the key delegation 
selection state of the key control block is 
linked to the next transition selection state 
of the transition control block.
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Device Control Block (MKS-8031TB Trackball Module, 
Option)

The device control block is used for three-
dimensional transform operations using a 
DME and for wipe pattern position setting.

a Region selection buttons
The operation mode allocated to the device 
control block depends on the selection state 
of the region selection buttons.
When the [M/E 1], [M/E 2], [M/E 3], and 

[P/P] buttons are selected: This 
enables the wipe pattern position 
setting (positioner) operation mode in 
the device control block. You can 
select multiple buttons simultaneously.
When the MKS-9011 1M/E Control 
Panel is used, only the [P/P] is enabled. 
When the MKS-9012 2M/E Control 

Panel is used, only the [M/E-1] and [P/
P] are enabled.

When the [USER] button is selected: This 
enables pattern position setting used 
for color backgrounds.

When the [DME 1] to [DME 8] buttons 
are selected: This enables the three-
dimensional transform operation mode in 
the device control block.
Press a button, turning it on, to select a 
DME channel. You can select multiple 
buttons simultaneously.
The number of valid buttons depends on the 
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number of DME processor channels 
installed.
With the MKS-9011/9012 control panel, 
you cannot directly control DME5 to 
DME8.
When the [RUN CTRL] button is 

selected: This enables the effect run 
control mode in the device control 
block.

The functions of the operation buttons, 
trackball, and Z-ring vary with the 
operation mode as follows.

b Operation buttons

When the positioner operation mode is 
enabled
K1 CB1: Press this button to enable wipe 

pattern position setting for key 1 
(DSK1).
When the [USER] button is selected, 
pattern position setting for color 
background 1 is enabled.

K2 CB2: Press this button to enable wipe 
pattern position setting for key 2 
(DSK2).
When the [USER] button is selected, 
pattern position setting is enabled for 
color background 2.

K3 FM1: Press this button to enable wipe 
pattern position setting for key 3 
(DSK3).

K4 FM2: Press this button to enable wipe 
pattern position setting for key 4 
(DSK4).

MAIN: Press this button to enable main 
wipe pattern position setting for normal 
transitions.

SUB: Press this button to enable sub wipe 
pattern position setting for normal 
transitions.

Among the [K1 CB1] button, [K2 CB2] 
button, [K3 FM1] button, [K4 FM2] button, 

[MAIN] button, and [SUB] button, you can 
make a multiple selection.

POS: Press this button to enable pattern 
movement in the x-axis and y-axis 
directions with the trackball.
When the [USER] button is selected, 
this enables the trackball to move the 
pattern in the x-axis and y-axis 
directions, and the Z-ring to adjust the 
size of the pattern.

X, Y: These restrict the axes affected by the 
trackball and Z-ring to the x- or y-axis. 

Z: This restricts the axes affected by the 
trackball and Z-ring to the z-axis.

CTR (center): When this button is pressed, 
the pattern position returns to the 
center. When the [USER] button is 
selected, the pattern size also returns to 
50.00.

SHIFT/CLR WORK BUFR: These are 
not used in positioner operation mode.

When the three-dimensional transform 
operation mode is enabled
LOCAL: Enable operations in the DME 

local coordinate space. 
GLB (global): Enable operations in the 

DME global coordinate space.
The [LOCAL] and [GLB] buttons can be 
selected at the same time.

SRC (source): Enable operations in the 
DME source coordinate space.

TRGT (target): Enable operations in the 
DME target coordinate space.

The [SRC] and [TRGT] buttons cannot be 
selected at the same time.
AXIS LOC (location): When this button is 

lit, the trackball moves the rotational 
axis of the image in the x- and y-
directions, and the Z-ring moves the 
axis in the z-direction.

ASP PERS (aspect/perspective): When 
the [SRC] button is lit, pressing this 
button enables the trackball to control 
Names and Functions of Parts of the Control Panel
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the x- and y-directions independently, 
and the Z-ring controls the x- and y-
directions together, to vary the aspect 
ratio. When the [SHIFT] button is held 
down and this button is pressed, the 
trackball controls the skew of the 
image in the x- and y-directions.
When the [TRGT] button is lit, 
pressing this button enables the 
trackball to control the perspective of 
the image in the x- and y-directions.
The Z-ring controls the distance to the 
viewpoint.

LOC (location) SIZE: When this button is 
lit, the Z-ring controls the image size.
The trackball moves the image in the x- 
and y-directions.

LOC (location) XYZ: When this button is 
lit, the trackball moves the image in the 
x- and y-directions, and the Z-ring 
moves the image in the z-direction.

SHIFT: While holding down this button, 
pressing the [ASP PERS] button or 
[ROT] button switches to the shifted 
version of the corresponding function.

CLR WORK BUFR (clear work buffer): 
Press this button once to clear only the 
three-dimensional transform 
parameters of the information held in 
the work buffer. Press twice in rapid 
succession to clear all of the 
parameters, and return to the default 
state.

ROT (rotation): When this button is lit, the 
trackball rotates the image about the x- 
and y-axes, and the Z-ring rotates the 
image about the z-axis.
Pressing this while holding down the 
[SHIFT] button enables rotation of the 
image in the “Spin” mode. The 
trackball and Z-ring operate in the 
same manner.

X, Y, Z: These restrict which axes the 
trackball and Z-ring can control. You 
can select more than one.

When one of these buttons is selected, 
you can enter the parameter value for 
the corresponding axis using the 
numeric keypad control block.

CTR (center): Pressing this button 
changes the values of the three-
dimensional parameters currently 
controlled by the trackball and Z-ring 
to the closest detent values.
Pressing twice in rapid succession 
returns the parameter values to their 
defaults.

3 Trackball
When the positioner operation mode is 
enabled
By moving this, you can move the pattern 
in the x-axis and y-axis directions.

When the three-dimensional transform 
operation mode is enabled
Move the trackball to control the x- and y-
axes in a three-dimensional transform.

4  Z-ring 
When the positioner operation mode is 
enabled
When the [USER] button is selected, by 
turning the ring you can adjust the size of 
the pattern.

When the three-dimensional transform 
operation mode is enabled
Turn this ring to control the z-axis in a 
three-dimensional transform.

When the effect run control mode is 
enabled
By turning the Z-ring, you can run the 
keyframe effect, independent of the STOP 
NEXT KF, EFF LOOP, and similar settings 
in the keyframe control block. Turn 
clockwise to run the effect in the normal 
direction, and counterclockwise for the 
reverse direction.

5  MENU button
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Press this button, turning it on, to enable 
adjusting the parameters allocated to the 
knobs in the menu using the trackball and 
Z-ring.
In the case of the DME menu, the operation 
applies to the selected DME channel.
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Utility/Shotbox Control Block (MKS-8033 Utility/
Shotbox Module, Option)

a Bank selection buttons
Press any of the [BANK1] to [BANK4] 
buttons to select a bank of 24 memory recall 
buttons. The selected button lights amber.

b Memory recall buttons
Use these by allocating a shotbox function 
or utility function.
When a utility function is allocated, the 
button lights orange (or green depending on 
the status), and the allocated function name 
appears. Pressing a button executes the 
allocated function. When the function 
constitutes a switching on/off operation, the 
button lights green; otherwise, it only 
momentarily lights green.
When a shotbox function is allocated, the 
button lights orange, and the name of the 
allocated register appears. (If the register is 
empty, the button goes off.) Pressing a 

button executes the allocated shotbox 
function, and the button lights yellow. If 
there is a button immediately previously lit 
yellow, it changes to orange.

1
BANK

1 2 3 4

7
BANK

2

BANK
3

BANK
4

5 6

8 9 10 11 12

13 14 15 16 17 18

19 20 21 22 23 24

1 Bank selection buttons

2 Memory recall buttons
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Downstream Key Control Block (MKS-8032 DSK Fader 
Module, Option)

a Key delegation buttons
Press one of the [DSK1] to [DSK4] buttons 
to delegate this control block to the 
corresponding keyer.
When the MKS-9012 2M/E Control Panel 
is used, it is possible to delegate this control 
block to key 1 to key 4 of the M/E bank 
using a Setup menu.

b Independent key transition type 
selection buttons

Press one of these buttons, turning it on, to 
select the downstream key transition type.

MIX: Carry out a dissolve with the key 
selected with the key delegation 
buttons.

WIPE: Carry out a wipe with the key 
selected with the key delegation 
buttons.

DME: This switches the key selected with 
the key delegation buttons, using a 
DME wipe.

CUT: Instantaneously insert or delete the 
key selected with the key delegation 
buttons.

SHIFT: When setting is made in the Setup 
menu to allow a different transition 
type for inserting or deleting a key, it is 

DSK1 DSK2 WIPEUNDO

DSK3 DSK4 SHIFT MIX

K-SS

CUT

DME

K-SS
STORE

DSK1
ON

DSK2
ON

DSK3
ON

DSK4
ON

TAKETAKETAKETAKE

1 Key delegation buttons

5 Key source name display/key snapshot
buttons

4 Key snapshot setting
buttons

3 Independent key transition execution section

2 Independent key transition type 
selection buttons
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possible to set the transition after the 
next transition while this button is held 
down.

c Independent key transition 
execution section

DSK1 (downstream key 1) ON to DSK4 
ON buttons: Press these to 
instantaneously cut the downstream 
keys 1, 2, 3, and 4 in or, when the 
downstream keys are already inserted, 
cut them out. When the key 
corresponding to the button appears in 
the final program output, the button 
lights red, and otherwise lights amber.

TAKE buttons: These correspond to 
downstream keys 1, 2, 3, and 4 from 
left to right; press to execute an auto 
transition. The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

Fader lever: Move this to carry out a 
manual downstream key transition.

Transition indicator: This comprises 30 
LEDs, which show the progress of the 
downstream key transition.

d Key snapshot setting buttons
K-SS (key snapshot): This enables key 

snapshot mode.
K-SS STORE (key snapshot store): To 

save a key snapshot, hold down this 
button, and press the [key source name 
display/key snapshot] button for the 
register you want to save.

UNDO (key snapshot recall undo): This 
undoes the last key snapshot recall.

e Key source name display/key 
snapshot buttons

These display the selected source name for 
each corresponding keyer. In snapshot 
mode, they correspond to registers 1 to 4 of 
the selected keyer, and pressing the button 
saves or recalls a key snapshot.
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Basic Menu Operations

Menu Organization

Operations on the MVS-8000 switcher 
system make frequent use of menu 
operations.
This section describes the menus and their 
interrelationships.

Overview
All detailed settings for basic operations 
such as transitions, keys, DME, or wipes, 
are made in menus. There are also menus 
for carrying out general system control, 
managing setting data, and initial setup.

Accessing menus
You can use any of the following methods 
to access a menu, and the initially displayed 
menu page depends on the method used.
• Pressing a top menu selection button in 

the menu control block.
This displays the page you last accessed 
in the particular menu. After initially 
powering on the system, however, the 
page of VF1 - HF1 of the particular menu 
is always selected.

• Pressing a top menu selection button in 
the menu control block twice in rapid 
succession.
The page of VF1 - HF1 of the particular 
menu is displayed.

• Pressing a button other than a top menu 
button twice in rapid succession (see 
page 178).
Depending on the button, this may 
display a fixed page or the page selected 
last time you accessed the menu.

For details of the VF buttons and HF 
buttons, see “Interpreting the Menu 
Screen” (page 182).
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Menus accessed from a top menu selection button
Buttons Menus Function See

M/E 1 M/E-1 Transition, keys, and wipe 
settings for the M/E-1 bank

page 198 (transitions), page 
218 (keys), page 260 (wipes)

P/P PGM/PST Transition, downstream key, and 
wipe settings for the PGM/PST 
bank

FRAME 
MEM

Frame Memory Frame memory settings page 296

COLOR 
BKGD

Color Bkgd Color background settings page 316

AUX/MON Aux/Mon Aux bus settings page 328

COPY 
SWAP

Copy/Swap Copy and swap settings page 322

MISC Misc Safe title settings page 326

DME DME DME special effect settings Chapter 11 (Volume 2)

GLB EFF Global Effect Global effect settings Chapter 11 (Volume 2)

DEV Device Settings for external device 
operation

Chapter 12 (Volume 2)

KEY 
FRAME

Key Frame Keyframe settings Chapter 13 (Volume 2)

EFF Effect Keyframe effect register settings Chapter 13 (Volume 2)

SNAP 
SHOT

Snapshot Snapshot register settings Chapter 14 (Volume 2)

SHOTBOX Shotbox Shotbox register settings Chapter 15 (Volume 2)

FILE File File settings Chapter 17 (Volume 2)

ENG 
SETUP

Engineering Setup Setup functions Chapter 16 (Volume 2)
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Menus accessed by pressing a button twice
For certain buttons other than the top menu 
selection buttons, pressing twice in rapid 
succession directly recalls a related menu 
page. The following table lists these 

buttons, together with the menus they 
recall.
(“Xx” represents the HF menu recalled last 
in the VF menu.)

Menus accessed by pressing a button twice

Button locations Buttons Menus See

Transition control block of M/E-1 
bank

KEY1 M/E-1 Key1>Xx page 218

KEY2 M/E-1 Key2>Xx

KEY3 M/E-1 Key3>Xx

KEY4 M/E-1 Key4>Xx

Transition control block of PGM/
PST bank

DSK1 PGM/PST DSK1>Xx

DSK2 PGM/PST DSK2>Xx

DSK3 PGM/PST DSK3>Xx

DSK4 PGM/PST DSK4>Xx

Transition control block of M/E-1 
or PGM/PST bank

PRIOR 
SET

M/E-1, PGM/PST Misc>Key Priority page 195

KEY 
PRIOR

M/E-1, PGM/PST Misc>Next Key Priority page 196

WIPE M/E-1, PGM/PST Wipe>Main Pattern page 260

DME M/E-1, PGM/PST DME Wipe>Xx page 282

SUPER 
MIX

M/E-1, PGM/PST Misc>Transition page 199

PST 
COLOR 
MIX

M/E-1, PGM/PST Misc>Transition page 200
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Key control block a) KEY1 M/E-1 Key1>Xx and 
PGM/PST DSK1>Xx

page 218

KEY2 M/E-1 Key2>Xx and 
PGM/PST DSK2>Xx

KEY3 M/E-1 Key3>Xx and 
PGM/PST DSK3>Xx

KEY4 M/E-1 Key4>Xx and 
PGM/PST DSK4>Xx

LUM • M/E-1 Key1 to Key4>Type
• PGM/PST DSK1 to DSK4>Type

LIN

CVK

PTN

CRK • M/E-1 Key1 to Key4>Type>Chroma 
Adjust

• PGM/PST DSK1 to 
DSK4>Type>Chroma Adjust

page 222

Numeric keypad control block EFF • Effect>Effect b)

• Effect>Master Timeline>Store c)

Chapter 13 
(Volume 2)

SNAP 
SHOT

• Snapshot>Snapshot b)

• Snapshot>Master Snapshot>Store c)

Chapter 14 
(Volume 2)

SHOTBOX Shotbox>Register>Store/Recall Chapter 15 
(Volume 2)

TRANS 
RATE d)

• PGM/PST Misc>Transition
• M/E-1 Misc>Transition

page 204

Downstream key control block e) DSK1 • M/E-1 Key1 to Key4>Xx
• PGM/PST DSK1 to DSK4>Xx

page 218

DSK2

DSK3

DSK4

WIPE • M/E-1 Key1 to Key4>Transition>Wipe 
Adjust>Pattern Select

• PGM/PST DSK1 to 
DSK4>Transition>Wipe 
Adjust>Pattern Select

page 276

DME • M/E-1 Key1 to Key4>Transition>DME 
Wipe Adjust>1ch Pattern Select

• PGM/PST DSK1 to 
DSK4>Transition>DME Wipe 
Adjust>1ch Pattern Select

page 288

Menus accessed by pressing a button twice

Button locations Buttons Menus See
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a) The menu recalled depends on which of the M/E 
delegation buttons and key delegation buttons are 
selected in the key control block.

b) When other than [MASTR] is selected with the 
region selection buttons.

c) When [MASTR] is selected with a region selection 
button.

d) The menu recalled depends on which of the M/E-1 
and PGM/PST banks the numeric control block is 
delegated to.

e) The menu recalled depends on which keyer is 
delegated to in the Setup menu.

f) Recalling is possible only when the function is 
enabled.

Buttons in M/E-1, PGM/ PST, or 
AUX bank to which the signal 
indicated in “Buttons” column is 
assigned

K-SS 
STORE f)

Snapshot>Key Snapshot>Xx Chapter 14 
(Volume 2)

FM1 to 8 Frame Memory>Recall>Recall 
Thumbnail

page 302

Color 
Bkgd1

Color Bkgd>Color Bkgd1 page 316

Color 
Bkgd2

Color Bkgd>Color Bkgd2

AUX delegation buttons FMS1, 
FMS2

Frame Memory>Edit>Freeze page 300

Cross-point control block of M/E-
1 or PGM/PST bank

DME1 to 
DME4

DME>Xx Chapter 11 
(Volume 2)

KEY1 to 
KEY4 
(DSK1 to 
DSK4)

• M/E-1 Key1 to Key4>Xx
• PGM/PST DSK1 to DSK4>Xx

page 218

Menus accessed by pressing a button twice

Button locations Buttons Menus See
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Accessing a Menu

To display, for example, the M/E-
1>Key1>Type menu, use any of the 
following operations.
• Press the top menu selection button [M/E 

1], then press the VF1 ‘Key1’ button and 
the HF1 ‘Type’ button in that order.

• Press the menu page number button in the 
upper left corner of the menu screen to 

display the numeric keypad window, then 
enter the page number of the M/E-
1>Key1>Type menu, which is 1111, and 
press the [Enter] button.

For details of the menu page numbers, see 
the appendix “Menu Tree” (Volume 2).

The M/E-1>Key1>Type menu appears in 
the menu display as follows.

M/E-1>Key1>Type menu

2 Menu page number button

1 Menu title button

6 Function button area

7 Parameter group button

8 Knob 
parameter 
buttons3 VF buttons

4 HF buttons

9 Previous page button

5 Status area

0 Keyframe status
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Interpreting the Menu 
Screen

The menu screen consists of the following 
principal parts.
When buttons on the screen are lit or 
represented in a depressed state, this 
indicates that the corresponding item or 
function is selected (set on).

a Menu title button
This shows the title of the menu screen.
Pressing this button displays status 
information about the top menu.

b Menu page number button
This shows the menu screen page number. 
Pressing this button brings up the numeric 
keypad window (see page 185). You can 
enter the page number of another menu, and 
move directly to that menu.

c VF buttons
These indicate the larger subdivisions of 
this menu.
Depending on the selected item, the menu 
screen contents including the HF button 
indications change.

d HF buttons
These indicate the items within the menu.
Depending on the selected item, the menu 
indications change.

e Status area
This shows the status of the settings items 
controlled by the selected menu.

f Function button area
This shows the functions which can be 
operated in the currently selected menu by 
means of buttons.
Each function button corresponds to a 
function which can be set in the currently 

selected menu. Press it to enable the 
function, to display a parameter group and 
adjust the parameters with the knobs, or to 
execute the function.
These buttons are in groups by function. In 
the screen example shown on the previous 
page, the [Key Bus] and [Matte] function 
buttons constitute the <Key Fill> group.

g Parameter group button
This displays parameter group names for 
which the knobs can make adjustments, the 
current parameter setting page number, and 
the total number of the parameter setting 
pages. (Example: Color Vector 1/2)
When there are more than five parameters 
within the same parameter group, press this 
button to display the sixth and subsequent 
parameters, which can then be controlled 
by the knobs.

h Knob parameter buttons
These show the parameters currently 
controlled by the knobs and their values. 
Pressing one of these buttons displays the 
numeric keypad window (see page 185), 
and you can then enter a new value for the 
corresponding parameter with the numeric 
keypad.

i Previous page button
This shows the page number of the 
previously displayed menu screen. Press it 
to go back to that page. When the indication 
[Parent] appears, this displays the parent 
directory.

j Keyframe status
This shows the keyframe status of the 
reference region. Pressing this button 
switches the menu screen as follows.
When a menu other than the Key Frame 

menu is currently shown: The menu 
screen switches to the Key Frame 
menu.
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When the Key Frame menu is currently 
shown: The menu screen switches to 
the menu that was on the screen 
immediately before the Key Frame 
menu.

Menu Operations

Selecting an item
Use the following procedure.

1 Press the VF button (1 to 7) for the 
desired group of items.

The HF button (1 to 7) indications 
change to show the items within the 
selected group.

2 Press the HF button for the desired 
item.

The indications in the status area and 
function button area change, and you 
can now make various changes to the 
selected item.

Selecting a function
Press the appropriate function button within 
the function button area.

Shape and color of the button
Pressing the button turns it on, and it lights, 
showing the state.

Lit pale blue: The function is enabled, 
and the parameters can currently 
be adjusted with the knobs.

Lit orange: The function is enabled.

Lit purple: Execution button. Pressing 
the button immediately executes 
the function. (Example: [Auto 
Start] button in the Chroma Adjust 
menu)

Pressing a button of this type displays a 
further menu, allowing more detailed 
settings. (Example: [Chroma Adjust] 
button in the Type menu)

Setting parameters

This marking on a function button indicates 
that there are parameters which can be 
adjusted with the knobs.
Pressing this function button assigns 
parameters to the knobs.
You can set the parameter values by any of 
the following methods.
• Turn the knob (1 to 5) corresponding to 

the parameter, to adjust the value.
• Press the knob parameter buttons (1 to 5) 

corresponding to the parameter. This 
displays the numeric keypad window 
allowing you to enter the desired value.

In the description of specific setting 
procedures, the knob adjustment is 
described, as follows.

Example: When wipe pattern key is 
selected
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When the [MENU] button in the device 
control block is lit, you can use the trackball 
and Z-ring to control the parameters.
• Move the trackball on the x-axis to 

control the parameter for knob 1 or on the 
y-axis to control the parameter for knob 
2. Moving up or to the right increases the 
parameter value, and moving down or to 
the left decreases the parameter value.

• Use the Z-ring to adjust the parameter for 
knob 3. Turning clockwise increases the 
parameter value, and turning 
counterclockwise decreases the 
parameter value.

Going back to the previous menu
To return to the last displayed menu, press 
the previous page button.

Knob Parameter Adjust-
ment

Setting values

1 Size Pattern 
size

0.00 to 100.00

2 Soft Edge 
softness

0.00 to 100.00

3 Density Key 
density

0.00 to 100.00
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Numeric keypad window

a Item display
This is the name of the parameter being set 
in the numeric keypad window.

b Max./min. (maximum/minimum) 
value indication

This shows the maximum and minimum 
settings of the parameter.

c Input value
This is the value being input into the 
numeric keypad window.

d Close button
This closes the numeric keypad window.

e TC (timecode) button
When the numeric keypad window is 
opened for a setting requiring a timecode 
value to be entered, this button appears in a 
depressed state.

You can enter a timecode value in the range 
that depends on the signal format (page 
144) as follows:

00:00:00:00 to 23:59:59:nn,
where nn = (number of frames per 
second) – 1.

f  – (minus) button
This toggles the sign of the entered value. 
When it is pressed, the value is negative.

g Clear button
This clears the input. It does not change the 
parameter setting.

h Trim button
After entering the difference from the 
current value, press this button to confirm 
the numeric input.

i Enter button
This confirms the entered value.

1 Item display

2 Max./min. value indication

3 Input value

4 Close button

5 TC (timecode) 
button

6 − (minus) 
button

7 Clear button

8 Trim button

9 Enter button
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Keyboard window

a Item display
This is the name of the parameter being set 
in the keyboard window.

b Input string
This is the character string being input in 
the keyboard window.

c Close button
This closes the keyboard window.

d BS button
This clears the character immediately 
before the cursor in the input string.

e Caps Lock button
This enables input of capital letters only.

Note
You can enter items to be displayed on the 
control panel LCD using lowercase letters, 
but these will be converted to capitals for 
display.
MS-DOS does not distinguish case in 
filenames, and therefore you are 
recommended to enter filenames in capital 
letters.

f Shift button
This selects the characters on the shift side 
of the keys. The shift is released when you 
enter a character.

g Space button
This enters a space character.

1 Item display 2 Input string

4 BS button

3 Close button

0 Left button

6 Shift button

5 Caps Lock button

7 Space button

8 Clear button

9 Del button

qa Right button

qs Enter button

qd Line feed
button
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h Clear button
This clears all of the characters in the input 
string.

i Del button
This clears the character immediately after 
the cursor in the input string.

j Left button
This moves the cursor one character to the 
left in the input string.

k Right button
This moves the cursor one character to the 
right in the input string.

l Enter button
This sets the input string as a parameter 
value, and closes the keyboard window if 
the value has been entered correctly. If the 
value has not been entered correctly, the 
display color changes.

m Line feed button
After pressing the Shift button, press this 
button to feed a line. The input string shows 
“|”.
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Basic Operating Procedure

The positions of the principal buttons used for basic transition operation are as 
follows.

Transition control block

For basic transition operations, use the following procedure.

1 In the cross-point control block, select the background video with the 
background A row of cross-point buttons.

2 Select the way in which the transition will affect the image, using the next 
transition selection buttons in the transition control block.

For an overview, see “Selecting the Next Transition” (page 26).

To change the background: Press the [BKGD] button, turning it on.
To insert or delete a key: Press one of the [KEY1] to [KEY4] buttons (or 

[DSK1] to [DSK4] buttons in the PGM/PST bank), turning it on.
To enable the key priority setting, which determines the key overlay 

order after the transition: Press the [KEY PRIOR] button, turning it 
on.
You can press more than one button at the same time.

To change the keys and background presets in Setup menus 
simultaneously: Press the [ALL] button.

To allocate a particular next transition button to the [ALL] button 
function, see “Operation Settings (Operation Menu)” in Chapter 16 
(Volume 2).

BKBD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

Next transition 
selection buttons

Transition type 
selection buttons

Transition execution 
section
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3 For the transition to change the key priority, set the priority for after the 

transition.

For details of the key priority, see “Selecting the key priority” (page 28).
For details of the key priority setting operation, see “Key Priority Setting” 
(page 193).

4 Select the new video used for the transition.

• In the background B row of cross-point buttons, select the new 
background video.

• When inserting a key, select the key signal, and make any required 
settings.

For details of key settings, see Chapter 4 “Keys” (page 217).

To carry out a cut transition, skip to step 7; otherwise continue to step 5.

5 Select one of the transition type selection buttons in the transition control 
block.

To carry out a dissolve to the new video: Press one of the [MIX], 
[NAM], [SUPER MIX], and [PST COLOR MIX] buttons, turning it 
on.

To carry out a wipe: Press the [WIPE] or [DME] button, turning it on.

You can also use the Misc>Transition menu to select a desired transition 
type for the M/E or PGM/PST bank. (See “Selecting the Transition Type 
by a Menu Operation” (page 198).)

For an overview of the transition types, see “Transition Types” (page 33).

6 Make the required settings, according to the selected transition type.

For details of the settings, see the relevant section.
Super mix: “Super Mix Settings” (page 199)
Preset color mix: “Color Matte Settings” (page 200)
Wipe: “Basic Procedure for Wipe Settings” (page 260)
DME Wipe: “Basic Procedure for DME Wipe Settings” (page 282)
Using the transition preview function (page 212), you can check the 
transition on the preview monitor.

7 Carry out the transition in the transition execution section.

For a gradual transition such as a mix (dissolve) or wipe: Press the 
[AUTO TRANS] button, or operate the fader lever.
To execute a transition by pressing the [AUTO TRANS] button, first 
set the transition rate (specified as the duration of the transition).
 (See “Setting the Transition Rate” (page 202).)
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When you have selected a wipe or DME wipe as the transition type, 
you can also set the transition range. (See “Pattern Limit” (page 204).)

For an instantaneous transition: Press the [CUT] button.

For details, see “Executing a Transition” (page 201).
Basic Operating Procedure
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You can select the key priority, that is, the order in which the keys are laid over 
each other, in the current video and after the transition. There are two ways of 
setting the priority: either using the [PRIOR SET] button in the transition 
control block, or using the Misc menu to access the Key Priority menu for the 
M/E or PGM/PST bank.

Setting the Key Priority in the Transition Control Block

The positions of the buttons used for the operation are as follows.

Transition control block

Changing the currently inserted key priority
Use the following procedure.

1 If the next transition selection button [KEY PRIOR] is on, press another 
next transition selection button to turn the [KEY PRIOR] button off.

(When the [KEY PRIOR] button is on, the transition control block 
switches to the mode for changing the key priority for after the transition.)
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2 Holding down the [PRIOR SET] button, press the one of the next transition 
selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] buttons in the 
PGM/PST bank) for the key to appear on top.

The selected key now appears on top, on the program monitor.
The priority of keys other than the selected one does not change.

To change the priority of more than one key, repeat the above operation as 
required.

Changing the key priority for after the transition
When executing a transition, turning on the next transition selection button 
[KEY PRIOR] causes the keys to be rearranged based on the set priority.
To set the key priority for after the transition, use the following procedure.

1 In the transition control block, hold down the [PRIOR SET] button and 
press the [KEY PRIOR] button to turn it on. Do not release the [PRIOR 
SET] button before advancing to step 2.

The [KEY PRIOR] button lights green, and it becomes possible to change 
the key priority setting for after the transition.

2 Hold down the [PRIOR SET] button, and press the one of the next 
transition selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] 
buttons in the PGM/PST bank) for the key you want to bring to the front 
after the transition.

To set the priority to be the same as before the transition, press the [BKGD] 
button.

Note
The [BKGD] button is only effective when in the mode for changing the 
key priority for after the transition. 

Key 1 selected.

Key priority: 3, 1, 4, 2 Key priority: 1, 3, 4, 2
Key Priority Setting
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When the next transition selection button [KEY PRIOR] is on, the selected 
key appears on top on the preview monitor. The priority of keys other than 
the selected one does not change.

3 To change the priority of more than one key, repeat the above operation as 
required.

4 Execute the transition.

The keys are rearranged based on the above set priority.

Setting the Key Priority by a Menu Operation

Changing the priority of the currently inserted keys
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF3 ‘Key 
Priority.’

The Key Priority menu appears.

2 For each of [Priority1], [Priority2], [Priority3], and [Priority4], select a 
key, to determine the key priority sequence.

The keys are inserted in the key priority sequence with priority 1 at the 
front.

Note
It is not possible to select the same key for two or more priority numbers.

1
2

3
4

Priority 1

Priority 2

Priority 3

Priority 4
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The keys appear in the set order on the program monitor.

Changing the key priority for after the transition
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF4 ‘Next 
Key Priority.’

The Next Key Priority menu appears.

2 For each of [Priority1], [Priority2], [Priority3], and [Priority4], select a 
key, to determine the key priority sequence.

For details of the key priority sequence, see the figure shown for step 2 in 
the previous item (see page 195).

The keys appear in the set order on the preview monitor.

3 Execute the transition.

The keys are rearranged in the above set order on the program monitor.

Display of the Key Output Status and Key Priority

You can check whether keys are currently output, and the key priority setting, 
using the key status display in the transition control block of the M/E or PGM/
PST bank.
The display is above the next transition selection buttons [KEY1] to [KEY4] 
([DSK1] to [DSK4] buttons in the PGM/PST bank).

Display of the key output status
When a key is included in the output from the M/E or PGM/PST bank, the 
corresponding ON indicator lights.

Key priority display
The key priority is indicated by numerals 1 to 4 lighting.
The topmost key as seen on the program monitor is priority 1, and the keys 
underneath are numbered 2, 3, 4 away from the viewer (see page 195).
To display the key priority for after the transition, press the [KEY PRIOR] 
button in the transition control block, turning it on. For keys for which the 
priority after the transition is different from the current priority, the 
Key Priority Setting



  C
hapter 3 

Transitions

corresponding numerals 1 to 4 flash. For a key with the same priority, the 
indication remains on.

Example key status display given when the [KEY PRIOR] button is pressed:
• Current key priority: 1, 2, 3, 4
• Key priority after the transition: 3, 2, 1, 4
• Indicators: 1, 3 (flashing), 2, 1 (flashing), 3, 4

Example key status display (showing the key priority after the transition)

BKBD KEY1 KEY2 KEY3 KEY4
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1 2 3 4
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Flashing Flashing
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Selecting the Transition Type by a Menu 
Operation

You can also select the required transition type by a menu operation.
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select the required transition type in the <Transition Type> group.

The parameter settings can now be adjusted with the knobs according to 
the selected transition type.

For details, see the following.
• “Super Mix Settings” (page 199)
• “Color Matte Settings” (page 200)
• “Setting the Transition Rate” (page 202)

Note
When multi-program mode is selected in the Setup menu (see “Settings for 
Switcher Configuration (Config Menu)” in Chapter 16 (Volume 2)), there 
may be cases in which two or more transition types have been selected.
Selecting the Transition Type by a Menu Operation
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To make the super mix settings, use the following procedure.

For an overview of the super mix, see page 34.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Super Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the output levels.

a) Default: 100.00%

Knob Parameter Adjustment Setting values

2 A Gain Background A output level 0.00 to 100.00% a)

3 B Gain Background B output level 0.00 to 100.00% a)
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Color Matte Settings

To set the color matte of a preset color mix, use the following procedure.

For an overview of the preset color mix, see page 34.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Preset Color Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the color matte parameters.

Knob Parameter Adjustment Setting values

2 Luminance Luminance 0.00 to 100.00%

3 Saturation Saturation 0.00 to 100.00%

4 Hue Hue 0.00 to 359.99%
Color Matte Settings
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Executing a Transition

There are two ways of executing a transition: as an auto transition by a button 
operation, and as a manual transition using the fader lever. You can also use a 
combination of these two modes.

For an overview of the auto transitions and manual transitions, see “Executing 
a Transition” (page 36).

Transition Indicator Function

In each of the M/E banks and PGM/PST bank, to the left of the fader lever is a 
transition indicator composed of 30 LEDs. This indicator shows the state of the 
transition, whether auto or manual, by which LEDs are lit.

Transition indicator

For example, in the illustration above, it can be seen that the transition is more 
than half completed.
When the transition is completed, all of the LEDs go off.

Lit
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Setting the Transition Rate

There are two ways of setting the transition rate: using the numeric keypad 
control block to enter a numeric value, or using the Misc menu to access the 
Transition menu for the M/E or PGM/PST bank.

Frame display mode and timecode display mode
For the transition rate display in the transition control block, there are two 
modes: frame display mode and timecode display mode. You can select one of 
these modes in setup. (See “Operation Settings” in Chapter 16 (Volume 2).)

Note
The setting is common to all banks of the switcher.

Frame display mode: Values are shown as from 0 to 999 frames. In this 
display mode, a value entered in timecode input mode is converted for 
display as a number of frames.

Timecode display mode: Values are shown as timecode values, consisting of 
seconds and frames. In this display mode, a value entered in frame input 
mode is converted for display as a timecode value. If the value consists of 
four or more digits, the last digit is not shown.
Example: A value of 9 seconds 23 frames appears as “9.23” and a value of 
10 seconds 1 frame appears as “10.0.”

Frame input mode and timecode input mode
For numeric input of the transition rate value, there are two modes: frame input 
mode and timecode input mode. The frame input mode is selected 
automatically when the frame display mode is selected. The timecode input 
mode is selected automatically when the timecode display mode is selected.
Frame input mode: The entered value is a number of frames.

Example: Entering 123 constitutes an entry of 123 frames
Timecode input mode: The entered value is a timecode value.

Example: Entering 123 constitutes an entry of 1 second 23 frames.

Note
Whereas you can enter a value of up to 999 in frame input mode, a value not 
smaller than 10 seconds cannot be entered in timecode input mode.
Executing a Transition
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Setting the transition rate in the numeric keypad control block

Numeric keypad control block

Use the following procedure.

1  In the numeric keypad control block, press the [TRANS RATE] button.

2 Press the region selection button for the M/E or PGM/PST bank for which 
you want to set the transition rate, turning it on.

The numeric keypad control block display now shows the selected region 
name and the current transition rate setting for the region.

3 With the numeric keypad, enter the transition rate.

• Enter a value of up to three digits.
• To clear the entry, press the [CLR] button.

4 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.
The transition control block display of the same bank (M/E or PGM/PST) 
also shows the setting.
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To enter a difference from the current value
After pressing the [+/−] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or −), press the [+/−] button.

Setting the transition rate by a menu operation
Use the following procedure.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select any transition type in the <Transition Type> group.

3  Turn the knob to set the transition rate.

Pattern Limit

There are two ways of setting a pattern limit: either by operating the fader lever 
to save the fader position, or by using the Wipe menu or DME Wipe menu to 
access the Edge/Direction menu for the M/E or PGM/PST bank.

For an overview of the pattern limits, see page 38.

Notes
• A pattern limit only applies when a wipe or DME wipe is selected as the 

transition type.
• A pattern limit cannot be applied to an independent key transition (see page 

213).

Knob Parameter Adjustment Setting values

1 Transition Rate Transition Rate 0 to 999 (frame count)
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Setting the pattern limit with the fader lever
Use the following procedure.

1 Move the fader lever to the position corresponding to a particular pattern 
size.

• First make sure that the [PTN LIMIT] button is off.
• To check the pattern size on the preview monitor, first press the [TRANS 

PVW] button, to select the transition preview mode (see page 212).

2 Press the [LIMIT SET] button.

This sets the current fader lever position as the pattern limit.

Setting the pattern limit by a menu operation
Use the following procedure.

1 When a wipe is selected as the transition type, in the M/E or PGM/PST 
menu, select first VF5 ‘Wipe,’ then HF4 ‘Edge/Direction.’
When a DME wipe is selected as the transition type, in the M/E or PGM/
PST menu, select first VF6 ‘DME Wipe,’ then HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.
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2 Press the [Pattern Limit] button, turning it on.

3 Turn the knob to adjust the following parameter.

a)  0.00%: Executing the transition does not change the video output at all.
b) 100.00%: The transition is the same as when no pattern limit is set, but the cross-point 

button selections of the background A and B buses do not interchange when the transition 
completes.

Executing a pattern limit transition
Use the following procedure.

1 Press the [PTN LIMIT] button, turning it on.

The button you pressed lights amber.

2 Carry out the transition.

The transition progresses as far as the set pattern limit. Even if the 
transition completes, the cross-point button assignments of the background 
A and B buses do not interchange.

3 Carry out the transition once again.

The status before the previous transition is restored.

To cancel the pattern limit
To cancel the pattern limit after completion of step 3 of the above procedure, 
press the [PTN LIMIT] button, turning it off.
If after carrying out step 2 above, the pattern limit has been reached, carry out 
the following procedure.

1 Press the [PTN LIMIT] button.

The button you pressed lights green.

2 Carry out the transition.

The [PTN LIMIT] button goes off, and the pattern limit state is released.
Depending on the way in which the transition was executed, the action will 
be as follows.
• When you press the [CUT] button, the pattern limit is immediately 

released, and the image switches instantaneously.

Knob Parameter Adjustment Setting values

1 Pattern Limit Pattern limit 0.00 a) to 100.00% b)
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• When you press the [AUTO TRANS] button, until the state of the next 

transition, the transition is carried out over the duration given by the 
transition rate.

• When you move the fader lever, the transition is carried out from the 
pattern limit state to the state before the pattern limit transition was 
carried out.
However, moving the fader lever even a little synchronizes the fader 
lever position with the transition state, and you can move the fader lever 
either in the forward direction or in the reverse direction.

Depending on the Setup settings, the transition may be executed at the 
instant you press the [PTN LIMIT] button, and the button goes off. In this 
case, execution continues for the time specified by the transition rate in the 
menu setting (see the next item), as far as the state of the next transition.

For details of the setting, see “Settings Relating to Keys, Wipes and Frame 
Memory (Key/Wipe/FM Menu)” in Chapter 16 (Volume 2).

To set the transition rate when the pattern limit is released
Use the following procedure.

1 In the <Pattern Limit Release> group of the Edge/Direction menu, select 
one of the following.

Auto Trans Rate: Use the transition rate set in the transition control block
Independ Trans Rate: Independent transition rate

2 If you selected “Independ Trans Rate” in step 1, adjust the following 
parameter.

Knob Parameter Adjustment Setting values

1 Transition Rate Independent transition rate 0 to 999 (frames)
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Executing an Auto Transition

Transition control block

To execute a transition on the M/E or PGM/PST bank by a button operation, 
use the following procedure in the transition control block.

For an overview of the auto transition, see page 36.

To carry out an instantaneous cut transition: Press the [CUT] button.
To carry out a gradual transition: Press the [AUTO TRANS] button.

This executes the transition at the preset transition rate (see page 202).
While the transition is executing, the [AUTO TRANS] button lights 
amber. When it completes the button goes off.

To complete a partially executed transition instantaneously: Press the 
[CUT] button.
The [AUTO TRANS] button goes off.

Executing a Transition With the Fader Lever (Manual 
Transition)

To execute a manual transition with the transition control block fader lever, use 
the following procedure.

For an overview of the manual transition, see page 36.
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To carry out the transition completely: Move the lever over the full range of 

its travel.
To pause a partly executed transition: Stop moving the fader lever.
To resume a paused transition: Resume moving the fader lever.

Combinations of Auto and Manual Transitions

Using the [AUTO TRANS] button, the [CUT] button, and the fader lever, use 
the following procedures.

Moving the fader lever during an auto transition
During an auto transition started by pressing the [AUTO TRANS] button, 
operating the fader lever immediately enables the fader lever, and the [AUTO 
TRANS] button goes off. Thereafter, the fader lever controls the progress of 
the transition.

Executing an auto transition after partly moving the fader lever
• Press the [CUT] button to instantaneously complete the transition.
• Press the [AUTO TRANS] button to complete the rest of the transition at the 

preset transition rate.
If the transition rate is set to 100 frames, and the fader lever has moved 
through 1/4 of the transition, then the remaining 3/4 of the transition is carried 
out in 100 frames.

Non-Sync State

If the fader lever is in an intermediate position when a transition is completed 
as an auto transition, then the lever position no longer agrees with the transition 
state. This is termed a non-sync state.
In a non-sync state, two lit LEDs indicate the position from which a normal 
transition can be carried out. This is either at one end position or both end 
positions of the fader lever travel.
Moving the fader lever toward the position of the lit LEDs does not carry out a 
transition, but when the fader lever reaches the end position the non-sync state 
is released, and it is now possible to carry out the next transition.
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• If the fader lever is moved in the direction away from the lit LEDs, this 
carries out the next transition, over the remaining part of the fader lever 
travel.

• Even in a non-sync state, you can carry out an auto transition by pressing the 
[AUTO TRANS] button. During the auto transition, the indicators show the 
transition progress in the usual way, but when the transition completes, they 
once again indicate the non-sync state.

Fader Lever Operation in Bus Fixed Mode

In the bus fixed mode there is a fixed relationship between the position of the 
fader lever and the signal output on each bus. Depending on the direction of the 
transition, the fader lever must therefore always be moved in a particular 
direction, as shown in the following table. This does not affect an auto 
transition, which is executed regardless of the fader lever direction.

For an overview of the bus fixed mode, see “Flip-flop mode and bus fixed 
mode” (page 37).

Fader lever operating direction in bus fixed mode

Manual transition completed as auto 
transition when moving the fader 
lever upward: Top two LEDs light.

Manual transition completed as 
auto transition when moving the 
fader lever downward: Bottom two 
LEDs light.

Once the fader lever is moved 
to this position, the non-sync 
state ends, and the next 
transition (direction shown by 
the arrow) is possible.

Next transition Transition direction Fader lever movement

Background A t B Downward

B t A Upward
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• When a transition applies to a combination of more than one of the 
background and keys 1, 2, 3, and 4, then the transition for all of these must 
be in the same direction complying with the above table.

• If as a result of an auto transition, for example, the fader lever position does 
not agree with the signal output, this is a non-sync state (see page 209) and 
LEDs light at both end positions of the fader lever travel. Moving the fader 
lever does not carry out a transition, but when the fader lever reaches the end 
position the non-sync state is released, and it is now possible to carry out the 
next transition. If the fader lever is moved in the direction away from the lit 
LEDs, this carries out the next transition, over the remaining part of the fader 
lever travel. 

Wipe direction in bus fixed mode
The direction of a wipe is also in a fixed relationship to the fader lever 
movement direction.

Keys 1, 2, 3, and 4 On t Off (deletion) Downward

Off t On (insertion) Upward

Next transition Transition direction Fader lever movement

Transition type Wipe direction Fader lever movement

Wipe Normal Upward

Reverse Downward
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Transition Preview

Carrying out a transition preview
To carry out a transition preview, use the following procedure.

For an overview of the transition preview, see page 37.

1 In the M/E or PGM/PST bank transition control block, press the [TRANS 
PVW] button.

The [TRANS PVW] button lights green, and the switcher is now in the 
transition preview mode. At this point, the preview output is the same as 
the program output before the [TRANS PVW] button was pressed.

2 Operate the fader lever, or press the [AUTO TRANS] button or [CUT] 
button.

On the preview monitor, you can check the effect of the transition.

To terminate a transition preview
There are three modes for a transition preview. To terminate a transition 
preview, carry out the operation which depends on the mode, and press the 
[TRANS PVW] button, turning it off.
Lock: Toggling the [TRANS PVW] button on and off switches between the 

transition preview mode and the normal mode.
Hold: The preview mode obtains only while the [TRANS PVW] button is held 

down.
One Time: Each time a transition ends, it reverts to the normal mode.

For details of the mode setting, see “Operation Settings (Operation Menu)” 
and “Settings Relating to Video Switching (Transition Menu)” in Chapter 16 
(Volume 2).

Notes
• During a transition, whether executed with the [AUTO TRANS] button or 

the fader lever, it is not possible to press the [TRANS PVW] button.
• In bus fixed mode (see page 37), transition previews are not available.
Transition Preview
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Independent Key Transitions

Transition control block

You can set independent transitions for the keyers on the M/E or PGM/PST 
bank.

For an overview of the independent key transitions, see page 29.

Basic Independent Key Transition Operations

To execute an independent key transition, press the appropriate button in the 
independent key/downstream key transition execution section of the transition 
control block.
To select the transition type and set the transition rate, use a menu operation.

Note
In an independent key transition, the pattern limit function is not available.
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Setting the Independent Key Transition Type by a Menu 
Operation

You can select the required independent key transition type by a menu 
operation.
Use the following procedure.

1  In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected appears.

2 Select the required transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.

Setting the Independent Key Transition Rate

There are two ways of setting the transition rate: using the numeric keypad 
control block to enter a numeric value, or using the Key menu to access the 
Transition menu for the M/E or PGM/PST bank.
When the setup selection is for separate transition rates for inserting or deleting 
a key, you can set both rates independently. For example, with the system in 
the state with the key not inserted, the transition rate setting applies to key 
insertion.

Setting the independent key transition rate in the numeric 
keypad control block

Use the following procedure.

1 In the numeric keypad control block, hold down the [TRANS RATE] 
button and press the key delegation button [KEY1] to [KEY4] ([DSK1] to 
[DSK4] in the PGM/PST bank) for the key for which you want to set the 
transition rate.

The numeric keypad control block changes to the mode for inputting the 
independent key transition rate, and its display now shows the 
corresponding region name and the current transition rate set for the 
region.
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2 With the numeric keypad, enter the transition rate.

• Enter a value of up to three digits.
• To clear the entry value, press the [CLR] button.

For details of frame input mode and timecode input mode, see page 202.

3 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.

To enter a difference from the current value
After pressing the [+/−] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or –), press the [+/−] button.

Setting the independent key transition rate by a menu operation
Use the following procedure.

1  In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected key appears.

2 Select any transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.

3 Turn the knob to set the transition rate.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frame count)
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Key Setting Operations Using Menus

There are two ways of making key settings: either using menus, or using the 
key control block.
This section describes basic procedures for making key settings using the 
menus, taking the M/E-1>Key1 menu as an example.
Operations in the Key menus are the same for all banks (M/E-1 to M/E-3 and 
PGM/PST).

For details of the method of using the key control block, see “Key Setting 
Operations With the Key Control Block” (page 245).

Key Setting Menus

The key setting menus for each bank (M/E-1 to M/E-3 and PGM/PST) are as 
follows.

Accessing a key setting menu
For example, to access the M/E-1>Key1 menu, carry out any of the following 
procedures.
• In the menu control block, select the top menu selection button [M/E 1], then 

press VF1 ‘Key1.’
• In the M/E-1 bank transition control block, press the KEY1 next transition 

selection button twice in rapid succession.
• In the key control block, press the M/E delegation button [M/E 1], then press 

the key delegation button [KEY1] twice in rapid succession.
Any of the above operations displays the M/E1>Key1 menu.
Note that you can access the DSK menus by pressing the button for the 
corresponding key in the downstream key control block twice in rapid 
succession.

Bank Keys set Menus

M/E-1 Keys 1 to 4 M/E-1>Key1 to 4

PGM/PST Downstream keys 1 to 4 PGM/PST>DSK1 to 4
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Key Type Setting

Setting the key type in a menu
Use the following procedure.

1 In the M/E-1>Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Type> group, select the key type.

Luminance: luminance key
Linear: linear key
Chroma: chroma key
Color Vector: color vector key
Wipe Pattern: wipe pattern key
Key Wipe Pattern: key wipe pattern key

For the selected key type, you can now set the parameters.

For an overview of the key types, see page 39. 

3 Carry out the following settings as required, depending on the key type 
selected in step 2.

To enable clean mode (see page 40) for a luminance key, linear key or 
color vector key: Select [Clean Mode] so that it is set on.
When clean mode is enabled, key fill is added to the background 
without cutting out with key source.

When chroma key is selected: Select [Chroma Adjust] to access the 
Chroma Adjust menu (see page 222), and make the required settings.

When a wipe pattern key is selected: In the M/E-1>Wipe menu (see page 
260), select the pattern and set any modifiers, then return to the M/E-
1>Key1 menu.

When a key wipe pattern key is selected: In the M/E-1>Key1>
Transition>Wipe Adjust menu (see page 276), carry out pattern 
selection and modifier setting, then return to the M/E-1>Key1>Type 
menu.

Note
For a wipe pattern selected for a wipe pattern key or key wipe pattern key, 
the [Edge] and [Direction] modifier settings are not available.
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4 Set the parameters.

• When a luminance key or linear key is selected

a) Setting this value to 1, produces the “through” state in which no filter is applied. The larger 
the value, the more strongly the filter applies.

• When a chroma key is selected

• When a color vector key is selected

• When a wipe pattern key or key wipe pattern key is selected

5 Make the following settings as required.

To invert the black/white sense of the key source: Press [Key Invert], 
turning it on.

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109.58 to −7.30

2 Gain Key sensitivity −100.00 to +100.00

3 Density Key density 0.00 to 100.00

4 Filter Filter coefficient 1 to 9 a)

Knob Parameter Adjustment Setting values

3 Density Key density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for creating 
luminance signal

+109.58 to −7.30

2 Y Gain Luminance signal sensitivity −100.00 to +100.00

3 C Clip Reference level for creating 
chrominance signal

100.00 to 0.00

4 C Gain Chrominance signal sensitivity −100.00 to +100.00

5 Density Key density 0.00 to 100.00

6 Y Filter Luminance signal filter coefficient 1 to 9

7 C Filter Chrominance signal filter 
coefficient

1 to 9

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00
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To adjust the horizontal position or key source width for a luminance 
key, linear key, or chroma key: Press [Key Position], turning it on, 
and set the parameters.

To set the key priority: Press [Key Priority] or select VF7 ‘Misc’ and 
HF3 ‘Key Priority’ to access the Key Priority menu.

For details, see “Setting the Key Priority by a Menu Operation” (page 
195).

Chroma Key Composition

Composing an image by chroma keying
There are two types of composition for chroma keying: normal mix, and 
additive mix.
To carry out chroma key composition, use the following procedure.

For an overview of the chroma key composition, see page 40.

1 In the M/E-1>Key1 menu, select HF1 ‘Type.’

2 Select [Chroma] in the <Key Type> group.

It becomes possible to adjust the key density (see page 220).

3 Select [Chroma Adjust].

The Chroma Adjust menu appears.

4 Carry out auto chroma key adjustments.

Also carry out manual adjustments if necessary to obtain an optimum 
chroma key image.

For the adjustment procedures, see page 222.

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal position −4.00 to +4.00

2 Left Key left edge position −4.00 to +4.00

3 Right Key right edge position −4.00 to +4.00
221Key Setting Operations Using Menus



   C
hapter 4 

K
eys

222
5 In the <Mix Mode> group, select [Normal Mix] or [Additive Mix] 
depending on the desired type of chroma key composition.

When using an additive mix for chroma keying, the (typically blue) 
background parts of the foreground video must be converted to black. For this, 
use the color cancel function (see page 223).

Using the plane function
In an additive mix, since no key is applied to the foreground, any variations in 
the (typically blue) background may appear in the composite image. To avoid 
this, a particular luminance level can be set for the (blue) background, and 
regions of lower luminance forcibly cut.
Use the following procedure.

1 In the Chroma Adjust menu, set [Plane] on.

2 Adjust the following parameter.

Chroma Key Adjustments

There are two ways of making chroma key adjustments: automatically, using 
the auto chroma key function, or manually, making individual adjustments 
such as color cancel adjustments and window adjustments.

Making auto chroma key adjustments
Auto chroma key is an automatic adjustment function which allows you to 
specify a part of the foreground video (for example, the blue background color) 
and use it as a reference for creating the chroma key image.
Use the following procedure.

1 In the M/E-1>Key1 menu, select HF1 ‘Type,’ then select [Chroma] in the 
<Key Type> group.

2 Select [Chroma Adjust].

The Chroma Adjust menu appears.

Knob Parameter Adjustment Setting values

1 Luminance Luminance level 0.00 to 100.00
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3 Select [Sample Mark] in the <Auto> group.

The foreground video only appears on the monitor, with a white box-
shaped sample selector.

4 Adjust the position and size of the sample selector, to specify the color to 
be used as the basis of chroma keying (typically a blue background).

a) The setting ranges depend on the signal format, screen aspect ratio, and size settings.

5 Select [Auto Start] in the <Auto> group.

This executes an auto chroma key based on the color specified by the 
sample selector, and displays the composite image on the monitor.

Making key active adjustments
When the key active function is on, the composite image is output to the 
monitor, and you can watch the monitor while manually adjusting the keying. 
When the key active function is off, only the foreground image appears. Set 
this off when manually adjusting color cancel (see the next section).
Use the following procedure.

1 In the Chroma Adjust menu, set [Key Active] on.

2 Adjust the following parameters.

Making color cancel adjustments
If the background color is leaking into the foreground video, turning the color 
cancel function on allows you to eliminate this leakage.
Use the following procedure.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −100.00 to +100.00 a)

2 Position V Vertical position −100.00 to +100.00 a)

3 Size Size 1.00 to 100.00

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 100.00 to 0.00

2 Gain Key gain −100.00 to +100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

5 Filter Filter coefficient 1 to 9
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1 In the Chroma Adjust menu, turn [Key Active] off.

Only the foreground image appears on the monitor.

2 In the <Color Cancel> group, set [Color Cancel] on.

3 Adjust the following parameters.

4 Set [Key Active] on.

The chroma key composite image now appears in the monitor.

Key signal adjustments for color cancel
When the color cancel function is set on, you can adjust the key signal for color 
cancel.
Use the following procedure.

1 In the <Color Cancel> group of the Chroma Adjust menu, set [Color 
Cancel] on.

2 In the <Color Cancel> group, set [Cancel Key] on.

The cancel key is now on, and you can now adjust the key signal for color 
cancel.

3 Make the following settings, as required, in the <Color Cancel> group.

• When setting [Key Position] on and adjusting the color cancel key 
edge position

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

5 Filter Filter coefficient 1 to 9

Knob Parameter Adjustment Setting values

1 Clip Color cancel key reference level 0.00 to 100.00

2 Gain Color cancel key gain −100.00 to +100.00

Knob Parameter Adjustment Setting values

1 H Phase Move left and right edges of the 
color cancel key simultaneously

Left edge position 
value shown

2 Left Move left edge of the color cancel 
key

−3.00 to +3.00
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• When setting [Window] on and adjusting the detection range of the 
color cancel key

For details of the crop and angle parameters, see “Chroma key window” 
(page 41).

• When setting [Y Balance] on and adjusting the ratio in which Y 
balance is added to the color cancel key

Adjusting the window
Setting the window function on allows you to adjust the detection range used 
to determine the key signal. When this function is off, the default range is used 
for the key.

For an overview of the window, see “Chroma key window” (page 41).

After making sure that the values of Clip, Gain, and Hue are adjusted 
appropriately, use the following procedure to make the window adjustment.

1 In the Chroma Adjust menu, set [Window] on.

2 Adjust the following parameters.

Adjusting the Y balance
Setting the Y balance on allows you to specify that, even if the hue is the same, 
only portions of a particular luminance will be replaced by the background.

For an overview of the Y balance, see page 42.

Use the following procedure.

3 Right Move right edge of the color 
cancel key

−3.00 to +3.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00

Knob Parameter Adjustment Setting values

1 Mixture Ratio of Y balance key 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00
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1 In the Chroma Adjust menu, set [Y Balance] on.

2 Adjust the following parameters.

Adjusting the chroma key shadow
This function allows a shadow falling on the (typically blue) background color 
to be rendered more realistically. Since portions of the (blue) background of 
less than a certain luminance are treated as shadows, there is no effect on 
cutting out of the foreground. 
Use the following procedure.

1 In the Chroma Adjust menu, set [Shadow] on.

2 Adjust the following parameters.

Note
When chroma key shadow is on, key edge is changed to normal, and soft edge 
is switched off.

Adjusting the video signal
You can change the gain of the foreground signal, or vary the Hue. There are 
separate adjustments for the gain of the whole video signal, or Y and C 
individually.
Use the following procedure.

1 In the Chroma Adjust menu, set [FRGD CCR] on.

2 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Clip Luminance range 0.00 to 100.00

2 Gain Key gain −100.00 to +100.00

3 Luminance Luminance 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Reference luminance for shadows 0.00 to 100.00

2 Gain Shadow key gain −100.00 to +100.00

3 Density Shadow opacity 0.00 to 100.00

4 Soft Shadow softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of video signal −100.00 to +100.00
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Selecting Key Fill and Key Source

Selecting key fill and key source
To select key fill and key source for key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1>Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Fill> group, select either of the following for use as key fill.

Key Bus: signal selected on the key 1 fill bus
Matte: signal from the dedicated color matte generator

3 If you selected [Key Bus] in step 2, press the key delegation button 
[KEY1] in the cross-point control block and select the key fill signal in the 
key row.

4 If you selected [Matte] in step 2, in the same Type menu, press the [Matte 
Adjust] button to display the Matte Adjust menu, then adjust the single-
color or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Fill Matte> group.

Flat Color: Adjust color 1 with the following parameters.

Mix Color: Carry out a color mix. Adjust color 1 and color 2, and select a 
mix pattern (see the next section).

5 In the <Key Source> group, specify the key source selection mode.

Self: The key fill bus signal is automatically selected as the key source.
When the key type is selected as chroma key, select [Self].

2 Y Gain Y signal gain −100.00 to +100.00

3 C Gain C signal gain −100.00 to +100.00

4 Hue Hue offset amount −180.00 to +180.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Auto Select: The signal allocated, being paired with the key fill bus signal, 
to a cross-point button is automatically selected as the key source. The 
setting of key fill and key source pairs is carried out in the Setup menu. 
(See “Cross-Point Settings (Xpt Assign Menu)” in Chapter 16 
(Volume 2).)

Split: You can select a key source signal independently of the key source 
automatically selected in Auto Select mode.

6 When [Split] was selected in step 5, to select the key fill signal, press the 
key delegation button [KEY1], turning it on, then press the appropriate 
button in the key row. To select the key source signal, hold down the 
[KEY1] button and press the corresponding button in the key row.

Note
When [Split] is selected, the key memory function (see page 47) is 
disabled.

Carrying out a color mix for key fill
When [Matte] is selected for key fill, you can combine color 1 and color 2. For 
the combination, you can use not only a key wipe generator pattern, but also 
the dedicated pattern for key edge color mix.
Use the following procedure.

1 In the <Key Fill> group of the Type menu, select [Matte] and press [Matte 
Adjust].

The Matte Adjust menu appears.

2 Select [Mix Color] in the <Fill Matte> group.

3 Adjust the following parameters.

4 Select the combining pattern in the <Mix Pattern> group.

Key Wipe: The wipe pattern selected for an independent key transition is 
used for combination.

Edge Pattern: Combine using the dedicated pattern selected for the color 
mix in the key edge fill.
For details, see “Carrying out a color mix for the key edge fill matte” 
(page 232).

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of the edge of the 
pattern

0.00 to 100.00
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5 In the Type menu, adjust color 1 and color 2.

To adjust color 1, select [Color1], and to adjust color 2, select [Color2], 
then adjust the following parameters.

6 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Key Edge Modifications

To modify the key edge of key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1>Key1 menu, select HF2 ‘Edge.’

The Edge menu appears.

2 Select the edge type in the <Edge> group.

For an overview of the key edge modifications, see “Edge modifiers” 
(page 43).

Normal: unadorned edge
Border: edge with border applied
Drop Border: edge with drop border applied
Shadow: edge with shadow applied
Outline: edge used as outline
Emboss: embossing effect applied to edge

If you select [Normal], skip to step 7.

3 Set the border width and other parameters.

When border or outline is selected: The setting parameters depend on 
the key type and whether the separate edge function is enabled or not. 
To enable the separate edge function, press [Separate Edge], setting it 
on.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0.00 
to 4.00.

b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The left, right, top, and bottom border or outline widths can be adjusted 
independently. The separate edge function is only valid when a 
luminance key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0.00 
to 4.00.

When drop border or shadow is selected: The setting parameter values 
depend on the on/off setting of key drop and the selection of 4H mode/
8H mode (see page 45).

• “Key drop OFF” mode 

• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0.00 
to 4.00.

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

(0.00 to 100.00) b)

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Top edge width 0.00 to 8.00 a)

2 Left Left edge width 0.00 to 8.00 a)

3 Right Right edge width 0.00 to 8.00 a)

4 Bottom Bottom edge width 0.00 to 8.00 a)

5 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00

2 Position Position 359.99 to 180.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

2 Position Position 359.99 to 0.00

3 Density Density 0.00 to 100.00
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When emboss is selected:

a) The Density adjustment only affects the key edge. This can be adjusted separately from 
Key Density, and if Key Density is set to 0.00, the embossed edge effect only can be 
applied.

To make edge fill adjustments, carry out the settings in step 6.

4 Select the edge fill signal in the <Edge Fill> group.

Utility 1 Bus: signal selected on the utility 1 bus
Matte: signal from dedicated color matte generator.

It becomes possible to adjust color 1.

When the edge type is outline, in place of the edge fill signal, the selected 
key fill signal fills the outline, and elsewhere remains as the background.

5 Carry out the following operation, depending on the selection in step 4.

When [Utility 1 Bus] is selected: Press the key delegation button 
[UTIL1], turning it on, and select the signal in the key row.

When [Matte] is selected: Press [Matte Adjust] in the same EDGE menu, 
to display the Matte Adjust menu, and adjust a single color or two-
color combination color matte.
You can select whether to use a single color matte or a two-color 
combination color matte in the <Edge Matte> group.

For the color mix operation, see “Carrying out a color mix for the key edge 
fill matte” (page 232).

6 When emboss is selected for the edge type, adjust the color in the <Emboss 
Fill> group.

To adjust matte 1 press [Matte1], and to adjust matte 2 press [Matte2], then 
adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 4.00

2 Position Position 359.99 to 0.00

3 Density a) Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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7 To make the edge soft, press [Soft Edge] to set it on, and adjust the 
softness.

For a normal edge, when [Soft Edge] is enabled, [Key Drop] is kept on.

8 To make separate fine adjustments to the positions of the left, right, top, 
and bottom of the source edge, press [Fine Key], to set it on, and adjust the 
following parameters.

Note
In the emboss function it is not possible to set [Fine Key] on.

• When the edge type is normal, drop border or shadow, enabling the [Fine 
Key] function keeps [Key Drop] on.

• When applying a border to the key edge, enabling the [Fine Key] 
function halves the border width setting range.

Carrying out a color mix for the key edge fill matte
When you select ‘Matte’ for the edge fill of a border, drop border, or shadow, 
you can create a combination of color 1 and color 2 using a wipe pattern 
generated by the dedicated pattern generator.
Use the following procedure.

1 In the <Edge Fill> group of the Edge menu, select [Matte], then press 
[Matte Adjust].

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Key top edge position −2.00 to +2.00

2 Left Key left edge position −2.00 to +2.00

3 Right Key right edge position −2.00 to +2.00

4 Bottom Key bottom edge position −2.00 to +2.00

6 H Phase Key horizontal position Left edge position 
value shown

7 V Phase Key vertical position Top edge position 
value shown
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The edge fill Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 Adjust the following parameters.

a) The patterns are the same as standard wipes. (For details, see the appendix “Wipe Pattern 
List” (Volume 2).)

To select the pattern, display the Mix Pattern Select menu by pressing 
[Mix Pattern] in the edge fill Matte Adjust menu. After selecting one of the 
patterns (standard wipe patterns 1 to 24) displayed in the Mix Pattern 
Select menu, you can adjust the following parameters.

4 Adjust color 1 and color 2.

To adjust color 1 press [Color 1], and to adjust color 2 press [Color 2], 
turning it on respectively, and adjust the following parameters.

5 If required, set the pattern modifiers.

• When turning [Position] on and setting the pattern position

a) See page 54.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Softness Softness of pattern edge 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Softness Softness of pattern edge 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −200.00 to +200.00 a)

2 Position V Vertical position −200.00 to +200.00 a)
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• When turning [Multi] on and replicating the pattern

a) See page 57.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 56.

• When turning [Angle] on in the <Rotation> group and inclining the 
pattern

a) See page 54.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant speed

[

a) See page 55.

6 To interchange color 1 and color 2, press [Color Invert], turning it on.

Applying the zabton effects
Use the following procedure.

1 In the Edge menu, press [Zabton], turning it on.

2 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Pattern edge softness 0.00 to 100.00
Key Setting Operations Using Menus



  C
hapter 4 

K
eys
Note
If in the pattern selection described below you select “Mask Pattern,” and 
“Box” for the main mask, the “Size” parameter here cannot be adjusted. 
Set “Size” in the Main Mask menu.

3 To adjust the pattern and color, press [Zabton Adjust].

The Zabton Adjust menu appears.

4 In the <Zabton Pattern> group, select the pattern.

Key Wipe: Use a key wipe.
Edge Pattern: Use a color mixing pattern for key edge.
Mask Pattern: Use the main mask Box or Pattern.

5 To adjust the color, press [Zabton Color] and adjust the following 
parameters.

Masks

There are two masks, which can be used to mask off unneeded parts of a key 
or background, or to remove defects, and these are known as the main mask and 
subsidiary mask. You can either use the main mask and subsidiary mask 
independently, or at the same time. 

For an overview of the masks, see page 46. 

Using the main mask
For example, to use the main mask for key 1 on the M/E-1 bank, use the 
following procedure.

1 In the M/E-1>Key1 menu, select HF3 ‘Main Mask.’

3 Density Density 0.00 to 100.00

Knob  Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values
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The Main Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Box: signal from the dedicated box generator
Pattern: signal from the dedicated pattern generator

4 Set the mask source parameters.

• When a box is selected

• When a pattern is selected

a) The pattern is the same as a standard wipe. (See the appendix “Wipe Pattern List” (Volume 
2).)

To select the pattern, display the Mask Ptn Select menu by pressing the 
[Mask Ptn Select] button in the Main Mask menu. After selecting one of 
the patterns (standard wipe patterns 1 to 24) displayed in the Mask Ptn 
Select menu, you can adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Top Top position −100.00 to +100.00

2 Left Left position −100.00 to +100.00

3 Right Right position −100.00 to +100.00

4 Bottom Bottom position −100.00 to +100.00

5 Soft Box softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00
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5 To invert the black/white sense of the mask source, press the [Mask Invert] 
button, turning it on.

6 When a pattern is selected as the mask source, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See page 54.

• When turning [Multi] on and replicating the pattern

a) See page 57.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 56.

• When turning [Angle] on in the <Rotation> group and setting the 
angle of the pattern rotation

a) See page 54.

• When turning [Speed] on in the <Rotation> group and setting the 
rate of pattern rotation

a) See page 55.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −200.00 to +200.00 a)

2 Position V Vertical position −200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Pattern angle −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rate of pattern rotation −100.00 to +100.00 a)
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Using the subsidiary mask
For example, to use the subsidiary mask for key 1 on the M/E-1 bank, use the 
following procedure.

1 In the M/E-1>Key1 menu, select HF4 ‘Sub Mask.’

The Sub Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Wipe: wipe pattern selected for a transition
If you select [Wipe], select the pattern and make modifier settings in 
the M/E-1>Wipe menu (see page 260), then return to this M/E-
1>Key1 menu.
In the case of a wipe pattern selected for a mask, the modifier [Edge] 
and [Direction] settings are not available.

Utility 1 Bus: signal selected on the utility 1 bus
When you selected [Utility 1 Bus], press the key delegation button 
[UTIL1], turning it on, in the M/E-1 bank and select the signal in the 
key row.

4 Set the mask source parameters.

• When wipe is selected

• When utility 1 bus is selected

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Clip Reference level for creating mask 
signal

+109.58 to −7.30

2 Gain Gain −100.00 to +100.00
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5 To invert the black/white sense of the mask source, press the [Mask Invert] 
button, turning it on.

Applying a DME Effect to a Key

Assigning a DME to a key
Use the following procedure.

1 In the M/E-1 >Key1 menu, select HF5 ‘Processed Key.’

The Processed Key menu appears.

2 In the <DME Select> group, select the DME channel (DME1 to DME4) to 
be used.

The lit colors of [DME1] to [DME4] indicate the DME assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override] turning it on, then select the DME channel. The later 
selection is valid and the corresponding button lights green.

Note
When assigning two or three DME channels to one key, the selected DME 
channels must be successive. 

Selecting the video signal for the DME assigned to a key

For the operating procedure, see“Selecting the video signal for a DME 
assigned to a key” (page 244).

Assigning a DME output signal as a monitor signal
Use the following procedure.

1 In the Processed Key menu, press [Monitor].

The Monitor menu appears.
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2 Press [Monitor Set], turning it on.

3 In the <DME Select> group, select the DME channel (DME1 to DME4) to 
be used.

This assigns the selected DME output to DME MON V and DME MON K.
The colors with which [DME1] to [DME4] are lit show the key assignment 
status.
Lit green: DME currently being monitored
Lit amber: DME that can be monitored
Off: Unassigned DME

Specifying the Key Output Destination

Using the key processed keyer signals (external processed key)
To select the key processed keyer key fill and key source signals on the AUX 
buses, press [Ext Proc Key], turning it on, in the Processed Key menu.
This assigns the key fill and key source signals for M/E-1 key 1 to reentry 
signals PROC V and PROC K.

Note
You cannot select the PROC V and PROC K signals using the cross-point 
selection buttons of the M/E or PGM/PST bank.

Using the key processed keyer signals or signals to which a DME 
effect is applied in frame memory (frame memory feed)

To use the key processed keyer key fill and key source signals on the frame 
memory source buses, in the Processed Key menu, press [FM Feed]. [Ext Proc 
Key] turns on, and the key fill and key source signals processed on the 
currently selected keyer are automatically assigned to frame memory source 
buses 1 and 2. When a DME is selected on the keyer, the key fill and key source 
signals to which a DME effect is applied are assigned.

Blink Function

With the blink function, you can obtain the following effects.
Key blink: The key is alternately inserted and deleted at regular intervals. You 

can set the period of blinking, and the proportion of each cycle for which 
the key is inserted.
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Edge blink: The key fill and key edge fill signals are interchanged at regular 
intervals. You can set the period of blinking, and the proportion of each 
cycle for which the original state holds.

Using the blink function
For example, to make the required settings for key 1 on the M/E-1 bank, use 
the following procedure.

1 In the M/E-1>Key1 menu, select HF6 ‘Transition.’

The Transition menu appears.

2 In the <Blink> group, select [Key Blink] or [Edge Blink] to set it on.

3 Set the blink parameters.

• When key blink is selected

• When edge blink is selected

Video Processing

You can adjust the luminance and hue of the selected key fill signal.
For example, to apply video processing to the signal selected on the M/E-1 
bank key 1 fill bus, use the following procedure.

1 In the M/E-1>Key1 menu, select HF7 ‘Video Process.’

The Video Process menu appears.

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which key 
inserted

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which 
original state holds

0.00 to 100.00
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2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults
Press [Unity].

Knob Parameter Adjustment Setting values

1 Video Gain Video gain −200.00 to +200.00

2 Y Gain Luminance gain −200.00 to +200.00

3 C Gain Chrominance gain −200.00 to +200.00

4 Hue Delay Hue delay −180.00 to +180.00

5 Black Level Luminance black level −7.30 to +109.58
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Key Setting Operations With the Cross-
Point Control Block

You can make a key signal selection using the cross-point control block of the 
M/E-1 or PGM/PST bank including the relevant key.

Applying a DME Effect to a Key

Checking the DME status
As an example, to check the DME status for M/E1 key 1, hold down the key 
row delegation button [KEY1] in the M/E1 bank.
While the button is held down, the [DME1] to [DME4] buttons light, and the 
colors with which they light indicate the status, as follows.
Lit green: A DME is assigned to M/E1 key 1. In the M/E1 independent key 

transition and transition control blocks, the transition type for KEY1 is set 
to a DME wipe.

Lit amber: A DME is assigned to an M/E1 key other than key 1.
In the independent key transition and transition control blocks, the 
transition type for other than key 1 of M/E-1 is set to a DME wipe.

Not lit: No DME is assigned, or a DME wipe is not selected.

Assigning DMEs to a key
As an example, to assign DME1 and DME2 to key 1, in the cross-point control 
block, hold down the key row delegation button [KEY1] and press the buttons 
([DME1] to [DME4]) for the DME channels to be used.
In this case, press [DME1], followed by [DME2].
The buttons pressed ([DME1] and [DME2]) light green and the DMEs are 
assigned to key 1.

Notes
• If the DME is selected on another keyer, the later selection takes precedence 

and the button lights green.
• When assigning two or more DMEs to a key, use consecutive channels.
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Ending a DME assignment
As an example, to end the assignment of a DME to key 1, in the cross-point 
control block, hold down the key row delegation button [KEY1] and press the 
DME button ([DME1] to [DME4]) that is lit green.
The button goes off, and this ends the assignment.

Selecting the video signal for a DME assigned to a key
Use the following procedure.

1 In the cross-point control block, press the key row delegation button 
[KEY1].

The assigned DME button lights amber.

2 Press the DME button (one of [DME1] to [DME4]) lit amber, which then 
lights green.

3 To select the video signal for the side of the DME image that is currently 
visible, make the signal selection in the key row.

4 To select the video signal for the side of the DME image that is currently 
not visible (the back side), hold down the DME button (one of [DME1] to 
[DME4]) and make the signal selection in the key row.

When two or more DME channels are assigned, select the video signal for each 
DME in the same way.
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Key Setting Operations With the Key 
Control Block

This section describes the basic procedures for key settings using the key 
control block.

Key control block

Operations in the Key Control Block

Selecting the bank and keyer
To make key settings, first select the bank (from M/E-1 to M/E-3 and PGM/
PST) and keyer, then assign them to the key control block.
For example, to set key 1 on M/E-1 with the key control block, use the 
following procedure.

DME
1

DME
2

DME
3

DME
4

M/E
1

M/E
2

M/E
3 P/P

KEY1 KEY2 KEY3 KEY4 TRANS

LUM LIN CRK CVK PTN

AUTO
SEL SPLIT

MATTE
FILL

KEY
DROP

SOFT
EDGE

BDR
DROP
BDR SHDW EMBOS

OUT
LINE

SHOW
KEY

MAIN
MASK

SUB
MASK ZABTN MORE

MON
FM

FEED

OVER
RIDE TRACE

PROC
KEY

AUTO
DELEG

DME
5

DME
6

DME
7

DME
8

M/E delegation buttons

Key type selection buttons

Key fill/key source selection buttons

Knobs

Key delegation buttons

Displays

Edge type selection buttons
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1 Using the M/E delegation buttons in the key control block, press the [M/
E1] button, setting it on.

2 Using the key delegation buttons in the key control block, press the 
[KEY1] button, setting it on.

This assigns the key control block to M/E-1 key 1.

Parameter adjustment with the knobs
When the button for a function requiring parameter settings is pressed (that is, 
on), you can set the parameters with the four knobs. If there are more than four 
values to be assigned to the knobs, the [MORE] button lights amber. At this 
point, press the [MORE] button, which turns green, to assign the fifth and 
subsequent parameters to the knobs, so that the parameter settings can be made.

Selecting the key type
To select the key type, press one of the key type selection buttons in the key 
control block.
[LUM] button: luminance key
[LIN] button: linear key
[CRK] button: chroma key
[CVK] button: color vector key
[PTN] button: key wipe pattern key

When using a wipe pattern key as the key type, in the <Key Type> group 
of the Type menu for the keyer, select [Wipe Pattern] and make the 
settings.

For an overview of the key types, see page 39.

The button you pressed lights green, and you can now adjust the parameters 
with the knobs. The display beside each knob shows the first letter of the 
parameter name and the three-digit setting value.

• When the [LUM] or [LIN] button is lit green

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109 to –7

2 Gain Key sensitivity –100 (shown as −00) 
to +100

3 Density Key density 0 to 100

4 Filter Filter coefficient 1 to 9
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• When the [CRK] button is lit green

• When [Key Active] is off, only the parameters Hue and Density are 
displayed.

• When both [Key Active] and [Color Cancel] are off, only the parameter 
Density is displayed.

• When the [CVK] button is lit green

• When the [PTN] button is lit green

Selecting key fill
Select whether to use a color matte as key fill, or the signal on the key fill bus.

When using a color matte: Press the [MATTE FILL] button, setting it on. The 
button lights green, and you can now set the parameters with the knobs.

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 0 to 100

2 Gain Key sensitivity –100 (shown as −00) 
to +100

3 Hue Hue 0 to 359

4 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for Y signal −7 to +109

2 Y Gain Y signal sensitivity −100 (shown as −00) to 
+100

3 C Clip Reference level for chrominance 
signal

0 to 100

4 C Gain Chrominance signal sensitivity −100 (shown as −00) to 
+100

5 Y Filter Y signal filter coefficient 1 to 9

6 C Filter Chrominance signal filter coefficient 1 to 9

8 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100
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When [Mix Color] is selected in the key fill Matte Adjust menu, you can 
further adjust color 2.

When [Mix Color] is on, and the [MORE] button is lit amber

When [Mix Color] is on, and the [MORE] button is lit green

When using the key fill bus signal: Press the [MATTE FILL] button, turning 
it off. To select the key fill signal, use the key bus buttons in the cross-point 
control block.

Selecting key source
• To use the key source paired with the key fill signal selected on the key fill 

bus, press the [AUTO SEL] button, turning it on. The pairing of the cross-
point buttons for key fill and key source is carried out in the Setup menu. (See 
“Cross-Point Settings (Xpt Assign Menu)” in Chapter 16 (Volume 2).)

• To select key source independently of the key fill signal selected on the key 
fill bus and paired with key source, hold down the key delegation button 
[KEY1], then press the desired key row button in the cross-point control 
block.

• To use as key source the same signal as the key fill signal selected on the key 
fill bus, select the SELF mode by pressing the [AUTO SEL] button and 
[SPLIT] button simultaneously so that both are off. When chroma key is 
selected as the key type, select the SELF mode.

3 Hue Color 1 hue 359 to 0

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100

3 Hue Color 1 hue 359 to 0

4 Size Pattern size 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Color 2 luminance 0 to 100

2 Saturation Color 2 saturation 0 to 100

3 Hue Color 2 hue 359 to 0

4 Soft Edge softness 0 to 100
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Key Edge Modifications

To apply a modification to the key edge, press one of the edge type selection 
buttons in the key control block.
[BDR] button: border
[DROP BDR] button: drop border
[SHDW] button: shadow
[OUTLINE] button: outline
[EMBOS] button: emboss

For an overview of the edge modifications, see page 43.

The pressed button lights green, and you can now adjust the parameters with 
the knobs. The display beside each knob shows the first letter of the parameter 
name and the three-digit setting value.

Setting the border parameters
When the [BDR] button is lit green, the parameter settings depend on the key 
type and whether the separate edge function is active. To activate the separate 
edge function, press [Separate Edge], setting it on, in the Edge menu for the 
key.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The border width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0 to 4.

Knob Parameter Adjustment Setting values

1 Width Border width 0 to 8 a)

(0 to 100) b)

4 Density Border density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)
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To adjust the edge fill color
When [BDR] is selected, the [MORE] button lights amber. Pressing the 
[MORE] button to turn it green then allows you to adjust the edge fill color 
parameters with the knobs.

Setting the drop border or shadow parameters
When the [DROP BDR] or [SHDW] button is lit green, the parameter settings 
differ between the “key drop OFF” and “key drop ON” modes (see page 45) as 
shown below. Switching between these two modes is made by turning the 
[KEY DROP] button on or off.

• “Key drop OFF” mode

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0 to 4.

• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0 to 4.

To adjust the edge fill color
When [DROP BDR] or [SHDW] is selected, the [MORE] button lights amber. 
Pressing the [MORE] button to turn it green then allows you to adjust the edge 
fill color parameters with the knobs.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 180

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0
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Setting the outline parameters
When the [OUTLINE] button is lit green, the parameter settings depend on the 
key type and whether the separate edge function is active. To activate the 
separate edge function, press [Separate Edge], setting it on, in the Edge menu 
for the key.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The outline width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 232) is on, the setting value range is 0 to 4.

When [Outline] is selected with separate edge on, the [MORE] button lights 
amber. Pressing the [MORE] button to turn it green then allows you to adjust 
the key fill density parameter with a knob.

Setting the embossing parameters
When the [EMBOS] button is lit green, adjust the following parameters.

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Width Outline width 0 to 8 a)

(0 to 100) b)

4 Density Outline density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)

Knob Parameter Adjustment Setting values

4 Density Outline density 0 to 100

Knob Parameter Setting values

1 Width 0 to 4
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Selecting a normal edge
When all five edge type selection buttons are off, a normal edge is selected. If 
one of the buttons is lit, press it, turning it off. 

Softening the edge
Press the [SOFT EDGE] button, turning it on. The button lights green, and you 
can now adjust the softness with the knob.

• For a normal edge, when [SOFT EDGE] is enabled, “Key Drop” mode turns 
on.

• When a luminance key or linear key is selected as the key type, and clean 
mode is enabled, enabling [SOFT EDGE] ends the clean mode.

Applying the zabton effects
When the [ZABTN] button is lit green, adjust the following parameters.

Press the [MORE] button lit amber, changing it to green, then adjust the 
following parameters.

2 Position 359 to 0

4 Density 0 to 100

Knob Parameter Setting values

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Pattern edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100
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Masks

Using the main mask
In the key control block, press the [MAIN MASK] button, turning it on. The 
parameter settings depend on the mask source selected as [Box] or [Pattern] in 
the <Mask Source> group of the Main Mask menu for the key.

• When box is selected

When box is selected and the [MORE] button is lit amber, there are more 
settings. Press the [MORE] button, so that it changes from amber to green to 
make the extra setting.

• When pattern is selected

a) The pattern is the same as a standard wipe. (See the appendix “Wipe Pattern List” (Volume 2).)

Using the subsidiary mask
In the key control block, press the [SUB MASK] button, turning it on. The 
parameter settings depend on the mask source selected as [Wipe] or [Utility 1 
Bus] in the <Mask Source> group of the Sub Mask menu for the key.

• When wipe is selected

Knob Parameter Adjustment Setting values

1 Top Top position −100 (shown as −00) to +100

2 Left Left position −100 (shown as −00) to +100

3 Right Right position −100 (shown as −00) to +100

4 Bottom Bottom position −100 (shown as −00) to +100

Knob Parameter Adjustment Setting values

1 Soft Box softness 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100
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• When utility 1 bus is selected

Applying a DME Effect to a Key

Assigning a DME to a key
Use the following procedure.

1 In the key control block, press the delegation buttons [M/E1] and [KEY1].

2 Using the DME channel selection buttons, select the DME channel (DME1 
to DME4) for applying the effect.

The lit colors of the [DME1] to [DME4] buttons indicate the DME 
assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override] turning it on, then select the DME channel. The later 
selection is valid and the corresponding button lights green.

Note
When assigning two or three DME channels to one key, the selected DME 
channels must be successive. 

Selecting the video signal for the DME assigned to a key

For the operating procedure, see“Selecting the video signal for a DME 
assigned to a key” (page 244).

Assigning the DME output signal to a monitor signal
Use the following procedure.

Knob Parameter Adjustment Setting values

1 Clip Reference level for 
creating mask signal

+109 to –7

2 Gain Gain –100 (shown as −00) to +100
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1 Holding down the output destination specification button [MON] in the 
key control block, use the DME channel selection buttons to select the 
DME channel (DME1 to DME4) you want to use.

The selected DME output is assigned to DME MON V and DME MON K.

2 To check the DME assignment status, hold down just the [MON] button.

While it is held down, the lit color of the [DME1] to [DME4] buttons 
shows the key assignment status.
• Lit green: Shows the DME currently being monitored.
• Lit amber: Shows a DME which can be monitored.
• Off: DME is not assigned.

Other Key Setting Operations

Using an external processed key
You can select and use the key processed keyer key fill and key source signals 
on the AUX buses.
Use the following procedure.

1 Select the keyer to be allocated.

2 In the key control block, press [PROC KEY], turning it on.

The button lights amber, and on the currently selected keyer, the key fill 
and key source are assigned to reentry signals PROC V and PROC K.

Note
You cannot select the PROC V and PROC K signals using the cross-point 
selection buttons of the M/E or PGM/PST bank.

Using a frame memory feed
When you press the FM FEED button in the key control block, it lights 
momentarily amber, then the key fill and key source signals processed in the 
currently selected keyer are assigned to frame memory sources 1 and 2.
If a DME is selected on the currently selected keyer, then the key fill and key 
source signals to which a DME effect is applied are assigned to frame memory 
sources 1 and 2.
Carrying out a frame memory feed causes the [PROC KEY] button to light 
amber.
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Using the show key function
While the [SHOW KEY] button is held down, the key-processed key source 
signal appears on the specified output. (Show key mode)

Even when the [SHOW KEY] button is released, for a preset time the show key 
mode is maintained. You can specify the output to which the show key function 
is applied and set the time for which the show key mode is maintained after 
releasing the button in a Setup menu.

For details see “Settings Relating to Keys, Wipes and Frame Memory (Key/
Wipe/FM Menu)” in Chapter 16 (Volume 2).

Using the auto delegation function
To couple the selection in the key delegation buttons of the independent key 
transition control block so that the key control block delegation selection is 
automatically switched, in the key control block press the [AUTO DELEG] 
button, turning it on.

Returning the key adjustment values to their defaults
Holding down a key type button ([LUM], [LIN], [CRK], [CVK], or [KEY 
WIPE]) recalls the key default values (page 48).

Key modify clear
When an M/E delegation button is held down, holding down a key delegation 
button together returns the key settings to the initial status settings.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 16 (Volume 2).
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Key Snapshots

Using the key snapshot function, you can instantaneously save all of the key 
settings, except the key insertion state (on/off) and key priority, in dedicated 
registers for later recall as required.

For an overview of the key snapshots, see page 47.

Key Snapshot Operations

Key snapshot operations are carried out in the downstream key control block 
(MKS-8032 DSK Fader Module). Each keyer is provided with four dedicated 
key snapshot registers.

Independent key transition control block (MKS-8032)

DSK1 DSK2 WIPE

DSK3 DSK4 SHIFT MIX

K-SS

CUT

DME

K-SS
STORE

DSK1
ON

DSK2
ON

DSK3
ON

DSK4
ON

TAKETAKETAKETAKE

Key source name display/key snapshot buttons

Key snapshot setting buttons

Independent key transition type 
selection buttons

Independent key transition execution section

Key delegation buttons
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Saving a key snapshot
For example, the following procedure saves the state of the DSK1 settings.

1 Press the key delegation button [DSK1], turning it on.

2 Press the [K-SS] button, turning it on. The system switches to key snapshot 
mode, and the key source name display/key snapshot buttons show the 
status of registers 1 to 4 for DSK1.

Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
Lit yellow: The most recently recalled register.
For a register holding a snapshot, the register name is shown as up to eight 
characters.

3 Hold down the [K-SS STORE] button, and press the key source name 
display/key snapshot button corresponding to the register in which you 
want to save the snapshot.

The key source name display/key snapshot button which you pressed lights 
yellow.

Note
If you save a key snapshot in a register for which the button is lit orange or 
yellow, the existing contents of the register are overwritten.

Recalling a key snapshot
For example, the following procedure recalls the state of the DSK1 settings.

1 Press the key delegation button [DSK1], turning it on.

2 Press the [K-SS] button, turning it on.

3 Press the key source name display/key snapshot button corresponding to 
the register you want to recall.

The button you pressed lights yellow, and this recalls the key snapshot.
To cancel the recall, press the [UNDO] button.
Key Snapshots
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Basic Procedure for Wipe Settings

You carry out wipe setting operations principally using the Wipe menu for each 
of the M/E-1 to M/E-3 and PGM/PST banks.
This section describes the basic procedures for wipe settings, taking the M/E-
1> Wipe menu as an example.

For details of independent key transition wipe settings, see “Wipe Settings for 
Independent Key Transitions” (page 276).

Wipe Settings Menu

Accessing the wipe settings menu
To access the M/E-1> Wipe menu, use any of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF5 ‘Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [WIPE] twice in rapid succession.
Any of the above operations displays the M/E-1>Wipe menu.

Wipe Pattern Selection

You can select a wipe pattern in the Wipe menu.

Selecting a wipe pattern by a menu operation
Use the following procedure.

1 In the M/E-1>Wipe menu, select HF1 ‘Main Pattern.’

The Main Pattern menu appears.

2 Select the wipe pattern group with the pattern group selection button.

Standard: standard wipes
Enhanced: enhanced wipes
Rotary: rotary wipes
Mosaic1 to Mosaic3: mosaic wipes
Random/Dust: random/diamond dust wipes
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The patterns from the selected pattern group appear on the screen.

For details of wipe patterns, see “Types of Wipe Pattern” (page 49) and 
the appendix “Wipe Pattern List” (Volume 2).

3 Press the button to select the desired pattern.

4 The parameters change according to the selected pattern, and you can 
adjust the pattern.

• When a polygon wipe is selected (pattern number 49)

a) A value of –100.00 completely removes the star “rays,” leaving a circle; at +100.00 the 
“rays” are at their sharpest.

• When a mosaic wipe is selected (pattern numbers 200 to 203, 206 to 
213, 224 to 247, 250 to 257, 260 to 269)

• When a karaoke wipe is selected (pattern numbers 220 to 223)

a) At −100.00 tiles appear from the top (or left edge) of the screen; at +100.00 from the 
bottom (or right edge) of the screen.

b) At −100.00 all rows appear simultaneously; at +100.00 until one row of tiles is completely 
displayed, the next row does not start to appear.

• When a random wipe is selected (pattern number 273)

Knob Parameter Adjustment Setting values

1 No. Number of points 3 to 64

2 Star Rate Angularity of star −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Tile No. Number of tiles horizontally 2 to 36

2 V Tile No. Number of tiles vertically 2 to 18

Knob Parameter Adjustment Setting values

1 Start Position of start tile −100.00 to +100.00 a)

2 Row No. Number of rows of tiles 1 to 36

3 Phase Delay for next row −100.00 to +100.00 b)

Knob Parameter Adjustment Setting values

1 H Size Tile width 0.00 to 100.00

2 V Size Tile height 0.00 to 100.00

3 Volatility Rate of tile generation 0.00 to 100.00
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• When a diamond dust wipe is selected (pattern number 274)

Note
When Flash Rate is set to 0.00, you cannot change the pattern. In this state, 
adjusting H Size or V Size has no effect on the pattern.

For details of a pattern mix, see the next section.
For details of applying pattern modifiers, see “Setting Wipe Modifiers” 
(page 264).

Pattern Mix

Combining two patterns
You can combine two selected patterns (referred to as main and “sub”) to form 
a new pattern. Select a main pattern in the Main Pattern menu, then use the 
following procedure.

1 In the M/E-1>Wipe menu, select HF3 ‘Sub Pattern.’

The Sub Pattern menu appears.

2 In the same way as for the main pattern, select the sub pattern.

The patterns that can be selected for the sub pattern depend on the pattern 
selected for the main pattern (see the following table).

Possible combinations of main pattern and sub pattern

Yes: Combination possible    No: Combination not possible

Knob Parameter Adjustment Setting values

1 H Size Particle width 0.00 to 100.00

2 V Size Particle height 0.00 to 100.00

3 Flash Rate Rate of generation of particles 0.00 to 100.00

 Main 
pattern

Sub pattern

Standard Enhanced Rotary Mosaic Random/
diamond 
dust 

Standard Yes Yes No Yes Yes

Enhanced Yes Yes No Yes Yes

Rotary No No No No No

Mosaic Yes Yes No No Yes
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3 Select HF2 ‘Pattern Mix.’

The Pattern Mix menu appears.

4 In the <Pattern Mix> group, select the type of pattern mix.

Mix: mix
+Nam: positive Nam
–Nam: negative Nam
Morphing: morphing

For an overview of types of pattern mix, see page 50.

5 Depending on the selection in step 4, set the following parameters.

• When mix, positive Nam, or negative Nam is selected

• When morphing (see page 50) is selected

6 In the <Main/Sub Link> group, make the main/sub modifier link function 
settings. (See “Main and sub modifier link function” (page 52).)

Full: full link mode
Semi: semi-link mode

Applying the effect of a diamond dust wipe to the selected 
pattern (Dust mix)

Use the following procedure.

Random/
diamond 
dust

Yes Yes No Yes No

 Main 
pattern

Sub pattern

Standard Enhanced Rotary Mosaic Random/
diamond 
dust 

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of sub pattern to the 
main pattern

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 Start Point in transition at which main 
pattern is at 100%

−50.00 to +150.00

3 End Point in transition at which sub 
pattern is at 100%

−50.00 to +150.00
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1 In the Pattern Mix menu, press [Dust Mix], turning it on.

2 Set the following parameters as required.

You can also apply the dust mix function to the pattern generated by a 
pattern mix.

Note
When a rotary wipe (pattern numbers 100-107, 150, 151, 156, 158, 160, 
162, 516, 518, 604, 606, 624, and 661) or random/diamond dust wipe 
(pattern numbers 270-274) is selected, the dust mix function is not 
available.

Setting Wipe Modifiers

You can apply various modifiers to the wipe pattern: setting the wipe direction, 
pattern position, and so on.

For an overview of the wipe modifiers, see “Wipe Pattern Variation and 
Modifiers” (page 52).
Note that the available modifiers may depend on the pattern you are using. For 
details, see “Possible combinations of wipe patterns and modifiers” (page 
275).

Main pattern and sub pattern modifiers
You can make independent settings of the modifiers for the main pattern and 
sub pattern.
• To set the modifiers for the main pattern, in the M/E-1> Wipe menu, select 

HF5 ‘Main Modify,’ and make the settings in the Main Modify menu.
• To set the modifiers for the sub pattern, select HF6 ‘Sub Modify,’ and make 

the settings in the Sub Modify menu.
Operations in the Main Modify menu and Sub Modify menu are the same.

Independently set modifiers for the main pattern and sub pattern
• Positioner
• Rotation

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of diamond dust 
pattern in mix

0.00 to 100.00

2 H Size Particle width 0.00 to 100.00

3 V Size Particle height 0.00 to 100.00

4 Flash Rate Rate of generation of particles 0.00 to 100.00
Basic Procedure for Wipe Settings



  C
hapter 5 

W
ipes
• Aspect ratio
• Pattern replication (MULTI)
• Pairing
• Modulation
• Spring
• Spiral

The following sections show examples of modifying the main pattern.

Specifying the wipe direction (Direction)
You can specify the wipe direction (normal/reverse).

To specify the wipe direction in a menu
Use the following procedure.

1 In the M/E-1> Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction> group, specify the wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the wipe direction with a button in the transition control 
block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
NORM: Normal
NORM/REV: Normal/reverse
REV: Reverse

Splitting the wipe pattern
Use the following procedure.

1 In the M/E-1 > Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.
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2 Press [Split], turning it on.

3 Set the following parameters.

Modifying the wipe pattern edge
Use the following procedure.

1 In the M/E-1> Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Edge> group, select the edge type.

Border: border
Soft: soft edge
Soft Border: soft border

For an overview of the edge types, see “Edge” (page 53).

3 Set the parameters according to the selection in step 2.

• When border is selected

• When soft edge is selected

• When soft border is selected

4 When you selected border or soft border, select the edge fill signal in the 
<Edge Fill> group.

Utility 2 Bus: signal selected on the utility 2 bus

Knob Parameter Adjustment Setting values

1 Split No. Number of splits 1 to 4 (integer)

2 Spacing Spacing between adjacent 
patterns

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Outer Soft Border outer softness 0.00 to 100.00
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Matte: signal from the dedicated color matte generator

5 Depending on the operation in step 4, carry out the following operation.

When ‘Utility 2 Bus’ is selected: Press the key delegation button 
[UTIL2], turning it on, and select the signal in the key row.

When ‘Matte’ is selected: In the same Edge/Direction menu, press [Matte 
Adjust] to display the Matte Adjust menu, then adjust the single-color 
or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Edge Matte> group.
Flat Color: Adjust color 1 with the following parameters.

When you select Mix Color for a two-color combination, see the next 
paragraph.

Carrying out a color mix for the edge fill matte
When you selected [Matte] for the border or soft border edge fill, you can 
combine color 1 and color 2.
For the combination, you can use not only a normal wipe generator pattern, but 
also the dedicated color mix pattern.
Use the following procedure.

1 In the <Edge Fill> group of the Edge/Direction menu, select [Matte], and 
press [Matte Adjust].

The Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 In the <Mix Pattern> group, make one of the following selections.

Wipe: Use the wipe pattern selected for the transition.
Pattern: Use the dedicated pattern.

4 Depending on the selection in step 3, set the following parameters.

• When Wipe is selected

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00
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• When Pattern is selected

a) The patterns are the same as for a standard wipe. See the appendix “Wipe Pattern List” 
(Volume 2).

If you selected Pattern, you can also carry out the pattern selection by 
pressing the [Mix Ptn Select] button in the Matte Adjust menu, to display 
the Mix Ptn Select menu. Select any pattern appearing in the Mix Ptn 
Select menu (standard wipe patterns 1 to 24) by pressing the appropriate 
button, and you can then adjust the following parameters.

5 If you selected Pattern in step 4, if required, the following modifiers can 
be added. After selecting a wipe mix, skip to step 6.

• When turning [Position] on and setting the pattern position

a) See page 54.

• When turning [Multi] on and using replications of the same pattern

a) See page 57.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 56.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −200.00 to +200.00 a)

2 Position V Vertical position −200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio −100.00 to +100.00 a)
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• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 54.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 55.

6 To adjust color 1, set [Color1] on, and to adjust color 2 set [Color2] on, 
then adjust the parameters.

7 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Setting the wipe position (Positioner)
You can set the position independently for the main pattern and sub pattern. 
Use the following procedure.

1 In the M/E-1> Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Position> group, press [Position], turning it on, and set the pattern 
position.

a) See page 54.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 0.00 to 359.99

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −200.00 to +200.00 a)

2 Position V Vertical position −200.00 to +200.00 a)
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To return the pattern position to the center of the screen
In the <Position> group, press [Center].

To move the pattern from its current position to the center through 
the course of a transition
In the <Position> group, press [Auto Center], turning it on.

To set the wipe position using the trackball
You can also set the wipe position using the trackball in the device control 
block. Use the following procedure.

1 In the device control block, press the [M/E1] or [P/P] button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

Table 1: Buttons and assigned settings

Table 2: Buttons assigned to functions

2 Press the [MAIN] button or [SUB] button, turning it on.

3 Press the [POS] button, turning Position on.

4 Move the trackball, to set the wipe position. By pressing the [X] button, 
turning it on, you can restrict movement to the horizontal direction, and by 
pressing the [Y] button, turning it on, you can restrict movement to the 
vertical direction.

Rotating the wipe pattern (Rotation)
You can apply rotation independently to the main pattern and sub pattern. Use 
the following procedure.

1 In the M/E-1> Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

Button name Setting

MAIN Wipe position for common transition (main pattern)

SUB Wipe position for common transition (sub pattern)

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the center of the screen.
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2 In the <Rotation> group, select the rotation type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a fixed rate.
Magnitude: Rotate through a particular angle during the course of the 

transition.

For an overview of the rotation, see page 54.

3 According to the selection in step 2, set the following parameters.

•  When Angle is selected

a) See page 54.

• When Speed is selected

a) See page 55.

• When Magnitude is selected

a) See page 55.

Setting the wipe pattern aspect ratio (Aspect ratio)
You can set the aspect ratio independently for the main pattern and sub pattern.
Use the following procedure.

1 In the M/E-1> Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

−100.00 to +100.00 a)

2 Magnitude Angle of rotation through course 
of transition

−200.00 to +200.00 a)
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2 Press [Aspect], turning it on.

3 Set the following parameter.

a) See page 56.

Setting the wipe pattern replication (Multi)
You can set pattern replication independently for the main pattern and sub 
pattern. 
Use the following procedure.

1 In the M/E-1> Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press the [Multi] button, turning it on.

3 Set the following parameters.

a) See page 57.

4 To make more adjustments, press the [Multi Adjust] button.

The Multi Adjust menu appears.

5 Make the following settings, as required.

H Invert: When this is on, alternate tiles are inverted left-to-right.
V Invert: When this is on, alternate tiles are inverted top-to-bottom.
Non-Mask: When this is on, even if the positioner function is used to 

move the pattern position, the pattern is always present on the screen.
Position: By adjusting the following parameters, move the pattern position 

within the divisions determined in step 3.

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Shift Replication layout −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Position H Horizontal position of pattern −200.00 to +200.00 a)
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a) See page 54.

Making a wipe pattern like a Venetian blind (Pairing)
Use the following procedure.

1 In the M/E-1 > Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Pairing> group, select the slit direction.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.

3 Set the following parameters.

a) See page 57.

Applying modulation to the wipe pattern (Modulation)
You can apply modulation independently to the main pattern and sub pattern. 
Use the following procedure.

Note
When using 1080PsF mode in an HD system, the modulation function is not 
available.

1 In the M/E-1>Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Depending on the desired effect, in the <Modulation> group select one of 
the following.

H: Modulate the pattern, applying waviness in the horizontal direction to 
edges.

2 Position V Vertical position of pattern −200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Width Width of the slits 1 to 128 (integer)

2 H Offset Spacing in the horizontal direction −100.00 to +100.00 a)

3 V Offset Spacing in the vertical direction −100.00 to +100.00 a)
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V: Modulate the pattern, applying waviness in the vertical direction to 
edges.

Fringe: Modulate the pattern, applying waviness in the radial direction to 
edges.

3 Set the following parameters.
.

a) See page 58.
b) See page 58.

Applying barrel or pincushion distortion to the edge of the wipe 
pattern (Spring)

You can set the spring function independently for the main and sub patterns. 
Use the following procedure.

1 In the M/E-1 > Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Spring], turning it on.

3 Set the following parameters.

a) See page 59.

Applying a spiral effect to the wipe pattern (Spiral)
You can set the spiral function independently for the main and sub patterns. 
Use the following procedure.

1 In the M/E-1 > Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves −100.00 to +100.00 a)

4 Shape Form of the modulation 1 to 3 b)

Knob Parameter Adjustment Setting values

1 Gain Degree of barrel distortion −100.00 to +100.00 a)
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2 Press [Spiral], turning it on.

3 Set the following parameters.

a) See page 60.

Possible combinations of wipe patterns and modifiers

Yes: Can be used    No: Cannot be used

a) Not patterns 1 to 16, 19, and 20
b) Not patterns 300 to 303
c) Not patterns 100 to 103, 150, 151, 516, 518, 604, and 606
d) Not patterns 1 to 8, 17, and 18
e) Not patterns 220 to 223
f) Not patterns 19 and 20
g) But patterns 21, 23 and 24 are possible
h) But patterns 21 and 23 are possible

Knob Parameter Adjustment Setting values

1 Magnitude Size and direction of the spiral −100.00 to +100.00 a)

2 Wave Speed Speed of the lateral waves −100.00 to +100.00 a)

Modifiers Type of wipe

Standard Enhanced Rotary Mosaic Random/
diamond dust

Direction Yes Yes Yes Yes Yes

Split Yes Yes No Yes No

Edge Yes Yes Yes Yes Yes

Positioner Yes a) Yes b) Yes c) No No

Rotation Yes Yes Yes c) No No

Aspect ratio Yes d) Yes No No No

Pattern 
replication

Yes Yes Yes Yes e) No

Pairing Yes f) Yes No No No

Modulation
(H/V)

Yes Yes Yes No No

Modulation 
(Fringe)

No g) Yes No No No

Spring No g) Yes No No No

Spiral No h) Yes No No No
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Wipe Settings for Independent Key 
Transitions

You carry out independent key/downstream key transition wipe setting 
operations using the Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see page 29.

This section describes the independent key transition wipe settings, taking the 
M/E-1>Key1>Transition>Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition Wipe 
Settings

Accessing the independent key transition wipe settings menu
As an example, to access the M/E-1>Key1>Transition>Wipe Adjust menu, 
carry out the following operation.

In the menu control block, select the top menu selection button [M/E 1] and 
select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1, then press [Wipe Adjust].

Carrying out the above operation displays the M/E-1>Key1>Transition>Wipe 
Adjust menu (which will be referred to below as simply the Key1 Wipe Adjust 
menu).

Selecting the independent key transition wipe pattern
You select the independent key wipe pattern from the list of patterns displayed 
in the menu.

Note 
In an independent key transition, you can only use the standard wipe patterns 
(pattern numbers 1 to 24).

To select a wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.

1 In the Key1 Wipe Adjust menu, select [Pattern Select].

The Pattern Select menu appears.
Wipe Settings for Independent Key Transitions



  C
hapter 5 

W
ipes
2 Press the button for the desired pattern.

Setting Independent Key Transition Wipe Modifiers

Available modifiers
You can use the following modifiers with an independent key transition wipe.
Note that the available modifiers may depend on the pattern you are using.
• Direction
• Edge
• Positioner
• Rotation
• Aspect ratio
• Pattern replication

Setting the wipe direction (Direction)
In the <Direction> group of the Key1 Wipe Adjust menu, make any of the 
following selections.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

Softening the wipe pattern edge (Soft edge)
Use the following procedure.

1 Press [Soft] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

Setting the wipe position (Positioner)
There are two methods of setting the wipe position: using the device control 
block, or in a menu.

To set the wipe position using the trackball
You can also set the wipe position using the trackball in the device control 
block. Use the following procedure.

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00
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1 In the device control block, press the [M/E1] or [P/P] button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

Table 1: Buttons and assigned settings

Table 2: Buttons assigned to functions

2 Press one of the buttons in Table 1 above, to select the wipe position to 
which the operation applies. Multiple selection is possible.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X] 
button, turning it on, you can restrict movement to the horizontal direction, 
and by pressing the [Y] button, turning it on, you can restrict movement to 
the vertical direction.

To set the wipe position by a menu operation
Use the following procedure.

1 Press [Position] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

a) See page 54.

Button name Setting

K1 CB1 Wipe position for independent key 1 transition

K2 CB2 Wipe position for independent key 2 transition

K3 FM1 Wipe position for independent key 3 transition

K4 FM2 Wipe position for independent key 4 transition

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the center of the screen.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −200.00 to +200.00 a)

2 Position V Vertical position −200.00 to +200.00 a)
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the course of a transition
Press [Auto Center] in the <Position> group, turning it on.

Rotating the wipe pattern (Rotation)
Use the following procedure.

1 In the <Rotation> group of the Key1 Wipe Adjust menu, select the rotation 
type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a speed rate.
Magnitude: Rotate the pattern through a fixed angle during the course of 

the transition.

2 According to the selection in step 1, set the following parameters.

• When Angle is selected

a) See page 54.

• When Speed is selected

a) See page 55.

• When Magnitude is selected

a) See page 55.

Setting the wipe pattern aspect ratio (Aspect ratio)
Use the following procedure.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

−100.00 to +100.00 a)

2 Magnitude Angle of rotation through course 
of transition

−200.00 to +200.00 a)
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1 Press [Aspect] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

a) See page 56.

Replicating the wipe pattern (Multi)
Use the following procedure.

1 Press [Multi] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

a) See page 57.

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)
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Basic Procedure for DME Wipe Settings

You carry out DME wipe setting operations principally using the DME Wipe 
menu for each of the M/E-1 to M/E-3 and PGM/PST banks.
This section describes the basic procedures for DME wipe settings, taking the 
M/E-1>DME Wipe menu as an example.

For details of independent key transition DME wipe settings, see “DME Wipe 
Settings for Independent Key Transitions” (page 288).

DME Wipe Settings Menu

Accessing the DME Wipe menu
To access the M/E-1>DME Wipe menu, use any of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF6 ‘DME Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [DME] twice in rapid succession.
Any of the above operations displays the M/E-1>DME Wipe menu.

DME Wipe Pattern Selection

You can select a DME wipe pattern in the DME Wipe menu.

Selecting a DME wipe pattern by a menu operation
Use the following procedure.

1 In the M/E-1>DME Wipe menu, select HF1 ‘1ch’ for one-channel mode 
or HF2 ‘2ch’ for two-channel mode. 

2 Select the desired DME wipe pattern group with one of the following 
buttons.

Slide/Squeeze: slide and squeeze
Split/Door: split and door
Flip/Tumble: flip tumble
Page Turn/Roll: page turn and page roll
Frame I/O: frame in/out
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P In P: picture-in-picture
User Program: user programmable DME
In two-channel mode, only Slide/Squeeze, P In P and User Program are 
selectable.

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 61) and the appendix “DME Wipe Pattern List” (Volume 2).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Note
For a key transition, the page turn, page roll and picture-in-picture cannot 
be used.

Setting DME Wipe Modifiers

You can apply various modifiers to the DME wipe pattern: setting the DME 
wipe direction, pattern position, and so on.

For an overview of the DME wipe modifiers, see “DME Wipe Pattern 
Variation and Modifiers” (page 63).

Specifying the DME wipe direction (Direction)
You can specify the DME wipe direction (normal/reverse).

To specify the DME wipe direction in a menu
Use the following procedure.

1 In the M/E-1>DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction>group, specify the DME wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the DME wipe direction with a button in the transition 
control block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
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NORM: Normal
NORM/REV: Normal/reverse
REV: Reverse

Modifying the DME wipe pattern edge
Use the following procedure.

1 In the M/E-1>DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Edge> group, select the edge type.

Border: border
Soft Border: soft border

4 Set the parameters according to the selection in step 3.

• When border is selected

• When soft border is selected

Display indications when multiple channels are selected at the same 
time

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00
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The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Setting the DME wipe position (Positioner)
Use the following procedure.

1 In the M/E-1>DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Position> group, press [Position], turning it on.

4 Set the following parameters.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Displaying and moving the position of the DME wipe pattern 
(position select)

Use the following procedure.

1 In the M/E-1>DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

Knob Parameter Adjustment Setting values

1 H Horizontal position −200.00 to +200.00

2 V Vertical position −200.00 to +200.00
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In the <Position Select> group, the one of the [Top Left], [Top Right], 
[Bottom Left], and [Bottom Right] buttons that is on indicates the current 
display position of the DME wipe pattern.

2 In the <Position> group, press [Position], turning it on.

3 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

In one-channel mode: press [1st Ch], turning it on.
In two-channel mode: from the <Ch Select> group, select the 

corresponding channel. You can select more than one channel at the 
same time.

4 To move the position of the DME wipe pattern, press the button where you 
want to move to, turning it on.

The DME wipe pattern displayed on the screen moves to the position of 
the specified button.

Setting the DME wipe pattern size (Size)
Use the following procedure.

1 In the M/E-1>DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 Press [Size], turning it on.

4 Set the following parameters.

a) The current effect size of the DME wipe pattern is taken as 100.00%.

Display indications when multiple channels are selected at the same 
time

Knob Parameter Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 a)
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The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Adjusting the DME wipe pattern cropping
Use the following procedure.

1 In the M/E-1>DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Crop Mode> group, press [Crop], turning it on.

4 Set the following parameters.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

In 16:9 mode, to crop to 4:3 aspect ratio
In the <Crop Mode> group, press [4:3], turning it on.

Knob Parameter Adjustment Setting values

1 Top Crop the top of the image –100.00 to +100.00

2 Left Crop the left of the image –100.00 to +100.00

3 Right Crop the right of the image –100.00 to +100.00

4 Bottom Crop the bottom of the image –100.00 to +100.00
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DME Wipe Settings for Independent Key 
Transitions

You carry out independent key/downstream key transition DME wipe setting 
operations using the DME Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see page 29.

This section describes the independent key transition DME wipe settings, 
taking the M/E-1>Key1>Transition>DME Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition DME 
Wipe Settings

Accessing the independent key transition DME wipe settings 
menu

As an example, to access the M/E-1>Key1>Transition>DME Wipe Adjust 
menu, carry out the following operation.
• In the menu control block, select the top menu selection button [M/E 1], and 

select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1. Next, press [DME Wipe Adjust].

Carrying out the above operation displays the M/E-1>Key1>Transition>DME 
Wipe Adjust menu (which will be referred to below as simply the Key1 DME 
Wipe Adjust menu).

Selecting the independent key transition DME wipe pattern
You select the independent key DME wipe pattern from the list of patterns 
displayed in the menu.

Note 
For an independent key transition, only the slide, split, squeeze, door, frame in/
out, and user programmable DME patterns are available.

To select a DME wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.
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1 In the <Pattern Select> group of the Key1 DME Wipe Adjust menu, press 

[1ch].

The Pattern Select menu for one-channel mode appears.

2 Select the desired DME wipe pattern group with one of the following 
buttons.

Slide/Squeeze: slide and squeeze
Split/Door: split and door
Frame I/O: frame in/out
User Program: user programmable DME

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 61) and the appendix “DME Wipe Pattern List” (Volume 2).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Setting Independent Key Transition DME Wipe 
Modifiers

You can set the pattern position for an independent key transition DME wipe.

For an overview of this function, see “Positioner” (page 54).

Setting the DME wipe position (Positioner)
Use the following procedure.

1 In the <Position> group of the Key1 DME Wipe Adjust menu, press 
[Position], turning it on.

2 Set the following parameters.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Knob Parameter Adjustment Setting values

1 H Horizontal position −200.00 to +200.00

2 V Vertical position −200.00 to +200.00
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Creating User Programmable DME Patterns

With a user programmable DME, you can use DME effects created through the 
use of keyframes for a transition on the switcher system.
Note the following points when creating a keyframe effect for use as a user 
programmable DME pattern.

Register numbers and pattern numbers
When saving a keyframe effect as a user programmable DME pattern, specify 
the register number that corresponds to the pattern number as shown in the 
following table.

For details of registers and keyframe effects, see “Registers” (page 113) and 
Chapter 13 “Keyframe Effects” (Volume 2), respectively.

Keyframe effects in the global channel
When the effect with the same number as the reference channel is present on 
the DME global (GLBL) channel, executing the user programmable DME will 
also execute the effect on the global channel simultaneously.
When executing a user programmable DME, take note of whether the effect is 
present on the global channel.

User Programmable DME Transition Mode

To create a user programmable DME, it is necessary to set the transition mode 
(the way in which the effect moves). To set the transition mode, use the Key 
Frame>DME User PGM menu.

Execution mode Register number Pattern number

One-channel mode 101 to 199 1901 to 1999

Two-channel mode 201 to 299 2901 to 2999
Creating User Programmable DME Patterns
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The following transition modes are available.

Notes on creating keyframe effects
When creating a keyframe effect to be used as a user programmable DME 
pattern, note the following, depending on the transition mode used.

Notes on single transition mode (one-channel mode)
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the last keyframe to be a full-size image.
• In the <Transition Mode> group of the Key Frame>DME User PGM menu, 

select [Single].

Notes on dual transition mode (one-channel mode)
• Create the first keyframe to be a full-size image. In the DME>Input/

Output>Video/Key menu, press [Separate Side], turning it on. Then, in the 
<Back> group of the same menu, press [H Invert] or [V Invert], turning it on, 
depending on the direction in which you want to rotate the image during the 
transition.

• Create the last keyframe so that the image is reversed and the back side is 
visible, and with the image size remaining at full-size.

• In the <Transition Mode> group of the Key Frame> DME User PGM menu, 
select [Dual].

Notes on frame in-out (one-channel mode)
Create a minimum of three keyframes.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.

Channel Transition mode Effect group

One-channel mode Single transition mode Slide

Squeeze

Split

Door

Page turn

Page roll

Dual transition mode Flip tumble

Frame in-out Frame in-out

Picture-in-picture Picture-in-picture

Two-channel mode Dual transition mode Slide

Squeeze

Picture-in-picture Picture-in-picture
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• Create the first transition to end such that the image can be seen within the 
screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• In the <Transition Mode> group of the Key Frame>DME User PGM menu, 
select [FRAME I/O].

Notes on picture-in-picture (one-channel mode)
Create a minimum of three keyframes.
• Create the first keyframe with the image full-size.
• Create the first transition to end such that the image can be seen within the 

screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Create the last keyframe again with the image full-size.
• In the <Transition Mode> group of the Key Frame>DME User PGM menu, 

select [P In P].

Notes on dual transition mode (two-channel mode)
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• Create the last keyframe for each channel as follows.
Channel 1: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.
Channel 2: create the image full-size.
In the <Transition Mode> group of the Key Frame>DME User PGM menu, 
select [Dual].

Notes on picture-in-picture (two-channel mode)
Create a minimum of three keyframes.
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
In the Global Effect>Ch1 to Ch4>Combiner menu, when setting the priority 
of channel 1 and channel 2, set the channel 1 priority higher.

• In the intermediate part of the transition, create the two images so that both 
are visible within the screen. In the Global Effect>Ch1 to Ch4>Combiner 
menu, when setting the priority of channel 1 and channel 2, set the channel 2 
priority higher.

Note
It is recommended to make the priority settings at a keyframe point at which 
the two images are not overlapping.
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• During the course of a transition, there is a “dead zone” corresponding to the 
intermediate point of the whole effect (see following figure), during which 
the image does not change. Therefore, it is necessary to create the effect so 
that the image in the intermediate part of the transition is the keyframe for 
the mid-point of the whole effect. The range of this “dead zone” corresponds 
to the central one-third of the range of the transition indicator. This also 
applies to an auto transition. 

• Create the last keyframe for each channel as follows.
Channel 1: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
Channel 2: create the image full-size.

• In the <Transition Mode> group of the Key Frame>DME User PGM menu, 
select [P In P].

A B C

Keyframe effect

First keyframe Last keyframe 

Mid-point of effect

Change in image through transition

Image at point C 
appears

Image at point B 
appears 
(dead zone)

Image at point A 
appears

Transition indicator
Fader lever
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Frame Memory Operations

For an overview of frame memory concepts, see “Frame Memory” (page 65).

Preparations

Allocating the frame memory outputs (FM1 to FM8) to cross-
point buttons

To output a frame memory image to a monitor, for example, the output signal 
from the frame memory (FM1 to FM8) must be allocated to a cross-point 
button. Carry out this allocation in the Setup menu.

Accessing the Frame Memory menu
Most frame memory operations are carried out using the Frame Memory menu.
To access the Frame Memory menu, use either of the following procedures.
• In the menu control block, select the top menu selection button [FRAME 

MEM].
• Press the cross-point button to which the frame memory output is allocated 

twice in rapid succession.

Interpreting the Frame Memory Menu

The menu screen consists of the following principal parts.
The status area display is the same for all except the Pattern Adjust/Pattern 
Select/File menus.
Frame Memory Operations
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a Auto store status indication
This appears when the auto store function has been enabled in setup.

b Available frame capacity
This shows the remaining number of frames that can be stored. When there is 
no remaining space the number (1 in pair mode, and 0 in single mode) is shown 
in red.

c Target FM selection buttons
These select which of the selected outputs the operation applies to. When 
manipulating a saved image, the file name appears.

2 Available frame capacity

5 Reposition/Lock status display

6 Pair button

7 <Select> group

3 Target FM selection buttons

4 Enable status display

1 Auto store status indication
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To the right of the button is shown the current frame memory output signal, 
input signal, and processing background signal status.
<Out>: output signal status

Blk: when black signal is output
Thr: when input image is output
Frz: when a freeze is output
Fil: when still image file is output
Com: when image is processed

<FG>: input signal status
FMS: frame memory source
Col: color matte signal

<BG>: processing background signal status
Blk: black signal 
Stl: still image (freeze image or still image file)

d Enable status display
Off: Both Freeze Enable and Edit Enable are off.
Frz: Freeze Enable is on.
Edt: Edit Enable is on.

e Reposition/Lock status display
These appear for frame memory outputs (FM1 to FM8) when reposition (see 
page 308) or lock (see page 309) is currently applied.

f Pair button
Press this button, turning it on, to enable pair mode.

g <Select> group
Select the output to which operations apply.

Selecting an Input Image

For the input image to frame memory, you can use either the signal selected on 
one of the two frame memory source buses or a dedicated color matte signal.
When using the signal on frame memory source bus 1 or 2 for the input image, 
select the signal as described below.

For the method of using a color matte signal, see “Freezing an image and 
writing it to memory” (page 300).

Selecting the signal on a frame memory source bus
As an example, to select a signal on frame memory source bus 1, use the 
following procedure.
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1 Using the bank selection buttons in the auxiliary bus control block, select 
the desired bank.

2 In the auxiliary bus control block, press the AUX delegation button to 
which frame memory source bus 1 is allocated, turning it on.

 For allocation of buses to the AUX delegation buttons, see “AUX 
Delegation Buttons Settings (Aux Assign Menu)” in Chapter 16 (Volume 
2).

3 In the key row of the bank selected in step 1, select the signal to be used 
for the input image.

To select a signal with a key or DME effect applied on the frame 
memory source bus
In the key control block or in the M/E-1>Key1>Processed Key menu, press the 
[FM FEED] button.
This automatically assigns the key fill and key source signals being keyed by 
the currently selected keyer to frame memory source buses 1 and 2.
When DME is selected on the keyer, the key fill and key source signals to 
which a DME effect is applied are assigned.

Selecting Outputs and Target Frame Memory

Selecting outputs (FM) and target frame memory
The signals of frame memory source buses 1 and 2 are used assigned to one of 
the pairs of FM1&2, FM3& 4, FM5&6, and FM7&8. The following 
description applies to the case of assignment to FM1&2, but the procedures are 
similar for the other cases.

1 In the Frame Memory menu, press one of VF1 to VF3, and select the 
required HF menu.

The current status of frame memory appears in the status area. (See page 
297.)

2 If required, press [Pair], to select the FM operation mode (pair mode).

On: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) as a pair.
Off: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) individually.

For more details, see “Pair mode” (page 65).
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3 In the <Select> group, press [FM1 & FM2] to select it.

This assigns the signals to FM1 and FM2.
To the right of the target FM selection buttons (see page 297), the FM 
output status appears.

4 If in step 2 you set [Pair] to be off, press the target FM selection button 
[FM1] or [FM2] (see page 297) to select the FM operations apply to.

When [Pair] is on, whichever of FM1 and FM2 you press, the pair is 
selected. When off, it is necessary to select which the operations apply to.

Capturing an Image (Freeze)

Freezing an image and writing it to memory
To freeze the signal selected as input material, and write it to memory, use the 
following procedure.

1 In the Frame Memory menu, select VF2 ‘Edit’ and HF1 ‘Freeze.’

The Freeze menu appears.

2 Select the target frame memory.

For the procedure, see “Selecting outputs (FM) and target frame 
memory” (page 299).

3 To enable V/K mode, press [V/K Mode] turning it on.

4 Press [Freeze Enable], turning it on.

A freeze is now possible.

5 If necessary, make the video process settings (see page 301) or mask 
settings (see page 302) for application to the selected signal.

6 In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.
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Notes
• All freeze images written to temporary memory are lost when the system 

is powered off.
• If you change the frame memory to use as in step 2 before saving the 

freeze images written to temporary memory, all the freeze images in 
temporary memory are lost, unless the auto store function has been 
enabled in setup. With the auto store function enabled, the freeze images 
written to temporary memory are saved automatically when the frame 
memory selection is changed.

Saving a freeze image
To save a captured freeze image in a file, use the following procedure in the 
Edit>Freeze menu.

1 Press [Store].

The keyboard window (see page 186) appears.
The default file name, “image###” (where ### is a three-digit number) is 
input.

2 In the keyboard window, enter the file name (maximum 8 characters).

3 In the keyboard window, press the [Enter] button.

This saves the freeze image as a file in memory.

Note
When the system is powered off, the file saved in memory is erased, but 
you can restore it in the Frame Memory menu. (See “Restoring Files” 
(page 312).)

Setting video processing
To set video processing for the signal selected on a frame memory source bus, 
use the following procedure in the Edit>Freeze menu.

1 In the <Video Process> group, press [Video Process], turning it on.

2 Use the knobs to adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of the video signal −200.00 to +200.00

2 Y Gain Y signal gain −200.00 to +200.00

3 C Gain Chrominance signal gain −200.00 to +200.00
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302
To return the settings to the default values, press [Unity] in the <Video 
Process> group.

Note
When a pair setting is active, it is coupled to the video process on/off 
setting, but the above parameter settings are only valid for frame memory 
source bus 1. When setting video process for frame memory source bus 2, 
disable the pair setting. To set video process for frame memory source bus 
1 only with the pair setting, return the frame memory source bus 2 settings 
to their default values.

Setting a mask
Masks can be set separately for frame memory source buses 1 and 2. To apply 
a mask to the signal selected on frame memory source bus 1, for example, use 
the following procedure in the Edit>Freeze menu.

1 Press [Box Mask] turning it on.

2 Use the knobs to adjust the following parameters.

3 To link the masks on frame memory source buses 1 and 2, press [Mask 
Link], turning it on.

Recalling Images

Using the thumbnail display to recall an image
To recall an image file saved in memory using the thumbnails, and assign it to 
an FM output, use the following procedure.

4 Hue Delay Hue delay −180.00 to +180.00

5 Black Level Y signal black level −7.30 to +109.58

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Top Top position −100.00 to +100.00

2 Left Left position −100.00 to +100.00

3 Right Right position −100.00 to +100.00

4 Bottom Bottom position −100.00 to +100.00
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1 In the Frame Memory menu, select VF1 ‘Recall’ and HF1 ‘Recall 
Thumbnail.’

The Recall Thumbnail menu appears.
• When [Pair] is on, only pair files (pairs of main file and sub file) are 

displayed.

• When [Pair] is off, both single files and pair files appear.

Main file

Sub file

Single file
303Frame Memory Operations



   C
hapter 7 

F
ram

e M
em

ory

304
2 In the status area, select the FM to be assigned. (See page 300.)

3 Using the arrow keys or turning the knob, scroll the file thumbnail display.

4 Press the thumbnail of the image you want to recall.

This recalls the image file, which is assigned to the FM you selected in step 
2.

Using the list display to recall an image
To recall an image file saved in memory using the list display, and assign it to 
an FM output, use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Recall’ and HF2 ‘Recall List.’

The Recall List menu appears.

2 In the status area, select the FM to be assigned. (See page 300.)

3 Using any of the following methods, select the file to be recalled. The main 
and sub files scroll simultaneously.

• Press directly on the list to select.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the selection.

4 To recall the main file in the selected list, press [Main] in the <Recall> 
group. Similarly, to recall the sub file, press [Sub].

This recalls the image file, which is assigned to the FM you selected in step 
2.
When pair mode is enabled, both are recalled, regardless of whether you 
press [Main] or [Sub].

Image Processing

Combining the background image and input signal
Use the following procedure.

Knob Parameter Adjustment Setting values

1 Scroll Scroll thumbnails 1 to ...

Knob Parameter Adjustment Setting values

1 No Memory file selection 1 to ...
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1 In the Frame Memory menu, select VF2 ‘Edit’ and HF2 ‘Composite.’

The Composite menu appears.

2 In the status area, select the FM to be assigned. (See page 300.)

3 To select V/K mode, press [V/K Mode], turning it on.

4 Press [Edit Enable], turning it on.

This enables the combining of the background signal (the signal providing 
the background for combination) and the input signal (the signal providing 
the foreground for combination).

5 To use a color matte signal for the input signal, press [Frgd Color], turning 
it on.
Even when pair mode is enabled, you can make separate settings for each 
FM.

6 Turn the knobs to adjust the following parameters.

7 If you turned [Frgd Color] off in step 5, if required press [Input Adjust] to 
display the Input Adjust menu, and make the video process (see page 301) 
and mask (see page 302) settings for the input signal.

Note
The input signal is lowered by one line, but when you apply a freeze, the 
freeze image is returned to the correct position.

8 To set the background signal to black, press [Bkgd Black], turning it on.

Notes
• When the background signal is originally black, [Bkgd Black] remains 

on. 
• When the background signal is a freeze image (an image frozen, but not 

saved), turning [Bkgd Black] on erases the unsaved freeze image and, as 
a result, [Bkgd Black] remains on. 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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9 In the <Type> group, set the type of combination (see page 306).

10In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.

Note
All freeze images written to temporary memory are lost when the system 
is powered off.

Saving a processed image
To save a processed image as a file, in the Edit>Composite menu use the 
following procedure.

1 Press [Store].

The keyboard window appears.
The default file name, “image###” (where ### is a three-digit number) is 
input.

2 In the keyboard window, enter the file name (maximum 8 characters).

3 In the keyboard window press the [Enter] button.

This saves the freeze image as a file in memory.

Selecting the way in which images are combined
To select the way in which the background image and input signal are 
combined (see page 67), use the following procedure.

1 In the <Type> group of the Edit>Composite menu, select one of the 
following methods of combination.

• Pattern Key: pattern key
• Ext Key: external key

(This can only be selected when the pair mode is enabled. The signal 
selected on the frame memory source 2 bus is used as the key signal.)

• Mix: mix
• NAM: non-additive mix
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If none of the above is selected, image combination is not carried out.

2 Depending on the selection in step 1, set the following parameters.

• When [Pattern Key] is selected

a) The patterns are the same as for a standard wipe. See the appendix “Wipe Pattern List” 
(Volume 2).

• When [Ext Key] is selected

• When [Mix] is selected

3 When you selected a pattern key, press [Pattern Adjust].

The Pattern Adjust menu appears. In the menu, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See page 54.

• When turning [Multi] on and replicating the pattern

Knob Parameter Adjustment Setting values

1 Size Size of pattern 0.00 to 100.00

2 Soft Edge softness of pattern 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Clip Reference level for key 
signal generation

–7.30 to +109.58

2 Gain Key sensitivity –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Mix Rate Mix proportion 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −200.00 to +200.00 a)

2 Position V Vertical position −200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of 
pattern horizontally

1 to 63

2 V Multi Number of repetitions of 
pattern vertically

1 to 63
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a) See page 57.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 56.

• When turning [Rotation Angle] on and inclining the pattern

a) See page 54.

To select the pattern, display the Pattern Select menu by pressing [Pattern 
Select] button in the Pattern Adjust menu. You can change the pattern 
selected in step 2 here. After selecting one of the patterns (standard wipe 
patterns 1 to 24) displayed in the Pattern Select menu, you can adjust the 
following parameters.

4 When you selected a pattern key or external key, if required press [Key 
Invert] in the Edit>Composite menu to invert the key.

Image Output

There are two functions related to image output: the reposition function for 
moving the output image, and the lock function for fixing the output image.

For an overview of the image output, see page 67.

Moving the output image (reposition function)
Use the following procedure.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF1 
‘Reposition.’

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00
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The Reposition menu appears. In this menu, you can also enable the V/K 
mode (see page 300).

2 In the status area, select the FM output. (See page 300.)

3 In the <Reposition> group, select the movement mode (see page 67).

Normal: Move in normal mode.
Black&White: Move in black & white mode.

4 With the knobs, adjust the parameters to move the image.

a) See page 54.

The surroundings of the moved image on the screen are filled with black.

5 To return the image moved by the reposition function to the center 
position, in the <Reposition> group press [Center].

Note
It is not possible to write the image moved by the reposition function 
directly to frame memory.

Fixing the output image selection (lock function)
Use the following procedure.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF2 
‘Lock.’

The Lock menu appears.

2 In the status area, select the FM output. (See page 300.)

3 Press [Lock], turning it on.

This fixes the currently selected frame memory output image.
To release the lock, set [Lock] to off.

Knob Parameter Adjustment Setting values

1 Position H Move in horizontal direction –200.00 to +200.00 a)

2 Position V Move in vertical direction –200.00 to +200.00 a)
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Image Data Management

You can carry out the following operations on the files in which images are 
saved.
• Delete
• Rename
• Restore

For an overview of file management, see page 68.

Deleting Files

Deleting files using the thumbnail display
Use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Delete 
Thumbnail.’

The Delete Thumbnail menu appears. In the status area, whether pair mode 
is on or off, all of the saved files appear as thumbnails.

2 Using the arrow keys or turning the knob, scroll the thumbnail display.

3 Press the thumbnail of the file you want to delete, to select it. To select all 
of the files, press [Select All], turning it on.
To deselect, press once again.

4 Press [Delete].

A message for confirming the deletion appears.

5 To confirm the deletion press [Yes], and to cancel press [No].

Deleting files using the list display
Use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF2 ‘Delete List.’

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display scrolling 1 to ...
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The Delete List menu appears. In the status area, whether pair mode is on 
or off, all of the saved files appear in a list.

2 Using any of the following methods, select the file to be deleted.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the selection.

To select all of the files for deletion, press [Select All], turning it on.

3 To delete the main file in the selected list, press [Main] in the <Select> 
group. Similarly, to delete the sub file, press [Sub].

4 Press [Delete].

A message for confirming the deletion appears.

5 To confirm the deletion press [Yes], and to cancel press [No].

Renaming Files

Renaming a file using the thumbnails
Use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF3 ‘Rename 
Thumbnail.’

The Rename Thumbnail menu appears. In the status area, whether pair 
mode is on or off, all of the saved files appear as thumbnails.

2 Using the arrow keys or turning the knob, scroll the thumbnail display.

3 Press the thumbnail of the file you want to rename, to select it.
When pair mode is enabled, pressing either of main and sub 

Knob Parameter Adjustment Setting values

1 No Memory file selection 1 to ...

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display scrolling 1 to ...
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simultaneously selects both files.
To deselect, press once again.

4 Press [Rename].

A keyboard window appears.

5 Enter the new name, then press the [Enter] button in the keyboard window.

This renames the file.

Renaming files using the list display
Use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF4 ‘Rename List.’

The Rename List menu appears. In the status area, whether pair mode is on 
or off, all of the saved files appear in a list.

2 Using any of the following methods, select the file to be renamed. The 
main and sub files scroll simultaneously.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the selection.

3 Press [Rename].

The keyboard window appears.

4 Enter the new name, then press the [Enter] button in the keyboard window.

This renames the file.

Restoring Files

Restoring a file that has been deleted
To restore a still image file in memory that has been deleted, for example by 
turning the power off, use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF5 ‘Restore.’ 

Knob Parameter Adjustment Setting values

1 No Memory file selection 1 to ...
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The Restore menu appears.

2 Press [Restore].

This restores the file.
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Color Background Setting Operations

You carry out color background settings in the Color Bkgd menu. This section 
describes the settings menu for color background 1 as an example.

For an overview of the color background, see page 70.

Color Background Settings Menu

Accessing the Color Bkgd1 menu
Use either of the following operations.
• In the menu control block, select the top menu selection button [COLOR 

BKGD], and press VF1 ‘Color Bkgd1.’
• Press a cross-point button assigned to color background 1 twice in rapid 

succession.
The above operation displays the Color Bkgd1 menu.

Basic Color Background Setting Operations

Making a single-color matte (Flat Color)
If you are not using the “color mix” function to combine two colors, use the 
following procedure.

1 In the <Matte> group of the Color Bkgd 1 menu, press [Flat Color], turning 
it on.

You can now adjust color 1.

2 Set the following parameters.

Making a color combination (color mix)
To combine color 1 and color 2, use the following procedure.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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1 In the <Matte> group of the Color Bkgd1 menu, press [Mix Color], turning 

it on.

2 Set the following parameters as required.

a) The patterns are the same as for a standard wipe. See the appendix “Wipe Pattern List” 
(Volume 2).

You can also carry out the pattern selection by pressing the [Mix Ptn 
Select] button, to display the Mix Ptn Select menu. Select any pattern 
appearing in the Mix Ptn Select menu (standard wipe patterns 1 to 24), and 
you can then adjust the following parameters.

3 To adjust color 1, set [Color1] on, and to adjust color 2 set [Color2] on, 
then adjust the parameters.

4 If required, set the pattern modifiers.

• When turning [Position] on and setting the pattern position

a) See page 54.

• When turning [Multi] on and using replications of the same pattern 

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softening of edge 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position −200.00 to +200.00 a)

2 Position V Vertical position −200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63
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a) See page 57.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 56.

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 54.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 55.

• When selecting H (horizontal) or V (vertical) in the <Modulation> 
group and applying waviness to the pattern
(The modulation is always a sine wave.)

Note
When using 1080PsF mode in an HD system, the modulation function is 
not available.

a) See page 58.

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern −100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves −100.00 to +100.00 a)
Color Background Setting Operations



  C
hapter 8 

C
olor B

ackgrounds

5 To interchange color 1 and color 2, press the [Color Invert] button, turning 

it on.
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Basic Copy and Swap Operations

Copy and Swap Menu Operations

You can carry out copy and swap operations by using the menus. Key data 
copying can also be done using buttons.

Accessing the Copy/Swap menu
In the menu operation section top menu selection buttons, press the [Copy/
Swap] button. The Copy/Swap menu appears.
Here a copy/swap operation on wipe data is described by way of example, 
using the Copy/Swap>Wipe menu, but the same general procedure applies to 
all of the following menus.
• M/E: Copying and swapping M/E data
• Key: Copying and swapping key data
• Wipe: Copying and swapping wipe data
• DME Wipe: Copying and swapping DME wipe data
• Matte: Copying and swapping matte data
• Color: Copying and swapping color data
• DME: Copying and swapping data by DME channels

For an overview of the concepts involved, see “Copy and Swap” (page 71). 

Copying and swapping wipe data
As an example, to copy or swap wipe data, use the following procedure.

1 In the Copy/Swap menu, select HF3 ‘Wipe.’

The Copy/Swap>Wipe menu appears.
The status area shows lists for the copy/swap source on the left, and the 
copy/swap destination on the right.

2 In the <Data Select> group, select any of the following.

Wipe: The operation applies to wipes in the transition control block.
Key Wipe: The operation applies to wipes in the independent key 

transition control block.

3 Using any of the following methods, select the data to be copied or 
swapped.

• Press directly on the list appearing in the status area.
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• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs to make the setting.

a) Transition control block wipe data
b) Independent key transition control block wipe data

For details of the data affected, see “Copy and Swap” (page 71).

4 To copy, press [Copy], and to swap, press [Swap].

This carries out the copy or swap.

To undo a copy or swap 
Press [Undo], to return to the state before the copy or swap was carried out.

Copy by Button Operation

You can copy key data by a simple button operation.

For an overview of the copy function, see “Copy and Swap” (page 71).

Basic button operation
The basic button operation is to hold down the copy source button, then press 
the destination button.
You can undo the last operation using [Undo] in the menu (see page 323).

Keyer copy button operation
Use the key delegation buttons in the respective banks.

To copy from M/E-1 key 1 to P/P downstream key 2
Hold down the M/E-1 key delegation button [KEY1] and press the P/P key 
delegation button [DSK2].

Knob Parameter Adjustment Setting values

1 Left No Select data for copy/swap 
source

1 to 4 a)

1 to 16 b)

2 Right No Select data for copy/swap 
destination

1 to 4 a)

1 to 16 b)
323Basic Copy and Swap Operations
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Misc Menu Operations

In the Misc menu, you can carry out the following operations.
• Enable (on) or disable (off) control from external devices for each port of the 

switcher and DME.
• Switch the safe title function on or off for each output.

Enabling or disabling control from an external device
Use the following procedure.

1 In the menu control block, press the top menu selection button [Misc], then 
select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc>Enable>Port Enable menu appears with the status area showing 
the settings of the following ports.
• Switcher Remote 1 to Remote 4 ports (RS-422A, D-sub 9-pin)
• Switcher GPI port (parallel, 25-pin) 
• DME1/DME2 Editor ports (RS-422A, D-sub 9-pin)
• DME1/DME2 GPI ports (parallel, 25-pin)

2 In the <Switcher> or <DME> group, press on the name of the port for 
which you want to disable control from an external device, turning it off. 
To re-enable control for the port, press on its name once more.

Note
For the AUX bus operation from the Remote 1 to Remote 4 ports of the 
switcher, the setting (Enable/Disable/Manual) in the Setup menu takes 
precedence. Only when the setting is “Manual,” the settings made in the 
Port Enable menu apply.

For details, see “Interfacing With External Devices (Device Interface 
Menu)” under “Setup Relating to Switcher Processor” in Chapter 16 
(Volume 2).

Switching the safe title function on or off
Use the following procedure.

1 In the menu control block, press the top menu selection button [Misc] and 
select VF2 ‘Safe Title.’

The Misc>Safe Title menu appears.
Misc Menu Operations
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2 Using any of the following methods, select the signal to which the settings 
apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

Note
It is not possible to change the setting for the output for which the safe title 
is set off in the Setup menu. (See “Making safe title settings” in Chapter 
16 (Volume 2).)

3 Press [Safe Title] to set it on or off.

Knob Parameter Adjustment Setting values

1 Output Signal to which the settings 
apply

1 to 48
327Misc Menu Operations
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AUX Menu Operations

AUX Bus Settings

Making video process settings for an AUX bus
Make the settings as follows.

1 In the Aux/Mon>Aux Bus menu, using any of the following methods, 
select the AUX bus to which the settings apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults
Press [Unity].

Knob Parameter Adjustment Setting values

6 AUX Bus AUX bus selection 1 to 48

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain −200.00 to +200.00

2 Y Gain Luminance signal gain −200.00 to +200.00

3 C Gain Chrominance signal gain −200.00 to +200.00

4 Hue Delay Hue delay −180.00 to +180.00

5 Black Level Black level −7.30 to +109.58
AUX Menu Operations
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Video Process Settings

This section describes operations on the M/E-1 and PGM/PST background A 
and B buses, and utility buses 1 and 2.
For these operations, use the Misc>Video Process menu in the respective 
operating bank.

For video process settings on other buses, see the following.
• Settings for a particular input signal: “Signal input settings” in Chapter 16 

(Volume 2)
• Key fill bus settings: “Video Processing” (page 241)
• Settings for frame memory source buses 1 and 2: “Setting video processing” 

(page 301)
• Settings for Aux 1 to 48 buses: “Making video process settings for an AUX 

bus” (page 328)
• Overview of video process: “Video Process” (page 75)

This section describes an example on the background A bus of the M/E-1 bank. 
For the background B bus or utility bus 1 or 2, make the adjustment with a 
similar procedure.

Making video process settings for each bus
Use the following procedure.

1 In the menu control block, press the top menu selection button [M/E1] and 
select VF7 ‘Misc’ and HF2 ‘Video Process.’

2 In the <Bkgd-A> group, press [Video Process], turning it on.

3 Adjust the following parameters.

To return the parameter settings to the defaults
Press [Unity] in the <Bkgd-A> group.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain −200.00 to +200.00

2 Y Gain Luminance signal gain −200.00 to +200.00

3 C Gain Chrominance signal gain −200.00 to +200.00

4 Hue Delay Hue delay −180.00 to +180.00

5 Black Level Black level −7.30 to +109.58
329Video Process Settings
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Additive mix   40
Alarm   140
Angle   54
Aspect ratio   56, 271, 279
Attributes   129
Auto

chroma key adjustments   
222

transition   36, 129, 208
AUTO DELEG button   168
AUTO TRANS button   152
Auto/manual transition combi-

nation   209
AUX
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delegation buttons   161
menu operations   328

Auxiliary bus control block   
161

Axis location   84

B
Background   102

A/B row   149
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mask   46

Bank selection buttons   162, 
173

Basic menu operations   176
Beveled edge   90
Blind   95
Blink   47

function   240
Blur   90
Border   44, 89

parameters   249
Brick   107
Brightness adjustments   140
Broken glass   94
BS button   186

Bus fixed mode   37
fader operation   210
wipe direction   211

Bus selection   22
Button

assignment settings   139
numbers   24

C
Caps Lock button   186
Channel ID   86
Character trail   100
Chroma key   40

adjustments   222
composition   221
shadow   42
shadow adjustment   226
window   41

Circle   97
Clean mode   40
Clear button   185, 187
Close button   185, 186
Color

combination   70, 316
matte settings   200
vector key   39

Color background   70
selection   70
setting operations   316
settings menu   316

Color cancel   41
adjustments   223

Color data
copy   73
swap   73

Color mix   70, 316
for edge fill matte   267
for key fill   228

Combiner   104
Contrast   91
Control panel   148

configuration   148

Coordinate axes   86
Copy   71, 322
Crop   89
Cross-point

button numbers   150
button settings   138
buttons   149
control block   149
hold   129

Custom mode   135
Cut   36
CUT button   152
Cylinder   98

D
Dead zone   293
Defocus   89
Del button   187
Delay setting   121
Delegation buttons   165
Detents   81
Device

management   136
DEVICE connector   164
Device control block

joystick   154
trackball   169

Device Interface   143
Digital multi effects   77
Direction   52, 265, 277, 283
Display   160, 167
DME   77, 152

applying to a key   239, 
254

channel selection buttons   
167

setup   143
special effects   88

DME channel
copy   74
swap   74

DME patterns
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user programmable   290
DME wipe pattern   61

edge modification   284
groups   61
selection   282

DME wipe settings   282
for independent key transi-

tions   288
DME wipes   61, 281

copy   72, 73
direction   283
modifiers   283
position   285, 289
swap   72, 73

Downstream key control block   
174

Drop border   44
parameters   250

Duration
effect   118
keyframe   118
modes   117
setting buttons   157

Dust mix   51, 263

E
Edge   53

fill   46
modifiers   43

EDIT ENBL button   156
Edit point specification but-

tons   156
Editing buttons   157
EFF LOOP button   158
Effect   115

attributes   116
dissolve   116, 129
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editing   116
execution   126
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Effect execution direction se-
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Emboss   45
Enter button   185, 187
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External

key   67
processed key   255

External devices   109
connections   139
GPI device control   111
P-BUS device control   110
shared control functions   

109

F
Fader lever   152, 175
Files   146

operations   146
Flag   93
Flip-flop mode   37
Flying bar   94
Frame

display mode   202
input mode   202

Frame memory
feed   240, 255
overview   65
settings   142

Frame memory operations   
296

capturing an image   300
input image selection   298
menu display   296
preparations   296
selecting frame memory   

299
selecting outputs   299

Freeze   66, 91, 300
Fringe   59
FULL LINK   52
Function

button area   182
selection buttons   160

G
Global

coordinate space   78
effects   103

GPI Device control   111
GPI output   129
Graphics display   86

Grid   87

H
HF buttons   182

I
Image

capturing   66
data management   68, 310
data transfer   68
output   67
processing   67
recalling   67
saving   67

Image file
deletion   310
renaming   311

Independent key transition   
29, 213

DME wipe settings   288
type   214
type selection buttons   174
wipe modifiers   277
wipe settings   276

Independent key transition ex-
ecution section   153, 175

Independent key transition rate   
214

setting by a menu opera-
tion   215

setting in the numeric key-
pad control block   214

Input
signal settings   141, 143
string   186
value   185

Installation   136
Interpolation   102
Invert   102
Item display   185, 186

J
Joystick   154
Index
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K
Kaleidoscope   96
Key   39

control block   165
default   48
delegation buttons   174
deleting   27
density adjustment   103
disable   129
edge modifications   229, 

249
inserting   27
mask   46
memory   47
modifier buttons   166
modifiers   43
modify clear   48
output destination   240
output status display   196
row   149
settings   142
signal adjustments   224
source selection   103
status display   153

Key active   41
adjustment   223

KEY button   162
Key fill

selection   227
selection buttons   166

Key priority   193
display   196
selecting   28
setting by a menu opera-

tion   195
setting in the transition 

control block   193
Key row delegation buttons   

150
Key setting

using menus   218
with the cross-point con-

trol block   243
with the key control block   

245
Key snapshot   257

buttons   175

recalling   258
saving   258
setting buttons   175

Key source
name display   175
selection   227
selection buttons   166

Key type
selection buttons   166
setting   219

Keyboard window   186
Keyer

copy   71
swap   71

Keyframe   115
control block   156
duration   118
effect registers   113
status   182
strobe   101

KF button   153
Knob   163, 167

parameter buttons   182

L
Left button   187
Lens   97
Lighting   100
Line feed button   187
Linear key   39
Local coordinate space   78
Location

size   84
XYZ   82

Lock function   309
Luminance key   39

M
M/E

copy   71
swap   71

Magnitude   55
Main mask   46

using   235, 253
Main/sub modifier link   52
Maintenance   136

Manual transition   36, 208
Masks   46, 235, 253
Master

region   113
snapshot registers   114
timeline registers   114
timelines   127

Matte data
copy   73
swap   73

Max./min. value indication   
185

Melt   100
Memory

card access indicator   164
card slot   164
initialization   135

Memory card/USB adaptor 
block   164

Memory recall
buttons   173

Menu
accessing   176, 181
control block   163
display   163
operations   183
organization   176
page number button   182
screen   182
title button   182

MENU button   155, 171
Minus button   185
Mirror   96
Misc menu operations   326
MIX   67, 152
Mix   33, 50
MKS-8031   169
MKS-8032   174
MKS-8033   173
MKS-8035   165
Mode selection buttons   159
Modulation   58, 273
Mono   90
MORE button   167
Morphing   50
Mosaic   91

glass   92
Motion decay   101
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Multi   56, 272, 280
mirror   96
move   90

N
NAM   34, 67, 152
Nega   91
Negative NAM   50
Network configuration   133
Next transition   26

selecting   26
selection buttons   151

Non-additive mix   34, 152
Nonlinear effects   92
Non-Sync state   209
Normal
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Numeric keypad   160
control block   159
window   185

O
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One-stroke mode   34
One-time mode   34
Operating buttons   154
Operation

buttons   170
modes   66
settings   139

Outline   45
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Output
destination specification 

buttons   168
signal settings   141

OVERRIDE button   168

P
Page turn   98
Pair mode   65
Pairing   57, 273
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Parameter group button   182
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buttons   153
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205
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control   110
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Previous page button   182
PRIOR SET button   153
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R
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selection buttons   159
Registers   113
Related manuals   17
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Resume mode   135
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Ripple   93
Roll   98
Rotation   54, 83, 270, 279
Router interface setup   144
RUN CTRL button   158

S
Screen saver   140
SEMI LINK   52
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Setup   133
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overview   133
panel   138
router interface   144
switcher   140
system   133

Setup data saving/recalling   
137

Shadow   44, 107
parameters   250

SHIFT button   150
Shift button   186
Shotbox   132
SHOW KEY button   167
Show key function   256
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assignment to buttons   23
name display   25
selection   21
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Snapshot   128

attributes   128
registers   114

Soft edge   45, 277
Softening

edge   252
wipe pattern edge   277
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Source
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name displays   150
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Speed   55
Sphere   99
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Spring   59, 274
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using   238, 253
SUPER MIX   152
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settings   199
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Switcher setup   140
System

configuration   133
features   18
reset   135
setup   133

T
Tally interface setup   144
Target coordinate space   77
TC button   185
Temporary attributes   116, 

130
Three-dimensional

coordinate space   77
parameter display   88
parameters   78
transformations   77

Time offset execution   31
Timecode

display mode   202
input mode   202

Top menu selection buttons   
163

TRACE button   168
Trail   101
TRANS PVW button   153
Transformation operation 

modes   82
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auto   36
control block   151, 213
execution   36, 201
indicator   175
manual   36
mode   118
next   26
operating procedure   190

preview   37, 212
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function   201
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setting by a menu opera-
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setting in the numeric key-

pad control block   203
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selection buttons   152
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User programmable DME
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ation   291

patterns   290
transition mode   290
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Utility/shotbox control block   
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V
V/K mode   66
VF buttons   182
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processing   20, 241
signal adjustment   42
switching   142
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memory   76
settings   329

W
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Window adjustment   42, 225
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copy   72
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Wipe direction   265, 277
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